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SAFETY INSTRUCTIONS

This chapter contains important safety
instructions that you must follow during
operation and storage. Read the following before
any operation to ensure your safety and to keep
the instrument in the best possible condition.

Safety Symbols

These safety symbols may appear in this manual or on the
instrument.

& Warning: Identifies conditions or practices that
WARNING  oy1d result in injury or loss of life.

& Caution: Identifies conditions or practices that
CAUTION  could result in damage to the instrument or to

other properties.

DANGER High Voltage
Attention Refer to the Manual

Earth (ground) Terminal
Frame or Chassis Terminal

Do not dispose electronic equipment as unsorted
municipal waste. Please use a separate collection
facility or contact the supplier from which this
instrument was purchased.

I ¥ 0 = B
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Safety Guidelines

General *Do not place any heavy object on the instrument.

Guideline *Avoid severe impact or rough handling that leads

& to damaging the instrument.

CAUTION . . N
*Do not discharge static electricity to the
instrument.

+*Use only mating connectors, not bare wires, for
the terminals.

*Ensure signals to the RF input do not exceed
+30dBm.

+Ensure reverse power to the TG output terminal
does not exceed +30dBm.

*Do not supply any input signals to the TG output.

*Do not block the cooling fan opening.

*Do not disassemble the instrument unless you are
qualified.

(Measurement categories) EN 61010-1:2010 specifies the
measurement categories and their requirements as follows. The
instrument falls under category II.

*Measurement category IV is for measurement performed at the
source of low-voltage installation.

*Measurement category Il is for measurement performed in the
building installation.

*Measurement category |l is for measurement performed on the
circuits directly connected to the low voltage installation.

*Measurement category | is for measurements performed on
circuits not directly connected to Mains.

Power Supply *AC Input voltage range: 100V~240V

A *Frequency: 50/60Hz
WARNING
*To avoid electrical shock connect the protective

grounding conductor of the AC power cord to an
earth ground.
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Battery *Rating: 10.8V, 6 cell Li-ion battery

& *Turn off the power and remove the power cord
CAUTION  pefore installing or removing the battery.

Cleaning *Disconnect the power cord before cleaning.

+Use a soft cloth dampened in a solution of mild
detergent and water. Do not spray any liquid.

*Do not use chemicals containing harsh material
such as benzene, toluene, xylene, and acetone.

Operation xLocation: Indoor, no direct sunlight, dust free,
Environment almost non-conductive pollution (Note below)

*Temperature: 5°C to 45°C
+*Humidity: <90%

(Pollution Degree) EN 61010-1:2010 specifies the pollution degrees
and their requirements as follows. The instrument falls under
degree 2.

Pollution refers to “addition of foreign matter, solid, liquid, or
gaseous (ionized gases), that may produce a reduction of dielectric
strength or surface resistivity”.

*Pollution degree 1: No pollution or only dry, non-conductive
pollution occurs. The pollution has no influence.

*Pollution degree 2: Normally only non-conductive pollution occurs.
Occasionally, however, a temporary conductivity caused by
condensation must be expected.

*Pollution degree 3: Conductive pollution occurs, or dry, non-
conductive pollution occurs which becomes conductive due to
condensation which is expected. In such conditions, equipment is
normally protected against exposure to direct sunlight,
precipitation, and full wind pressure, but neither temperature nor
humidity is controlled.

Storage +Location: Indoor
environment *Temperature: -20°C to 70°C

+*Humidity: <90%
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Disposal Do not dispose this instrument as unsorted
municipal waste. Please use a separate collection

ﬁ facility or contact the supplier from which this

— instrument was purchased. Please make sure

discarded electrical waste is properly recycled to
reduce environmental impact.
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Power cord for the United Kingdom

When using the instrument in the United Kingdom, make sure the
power cord meets the following safety instructions.

NOTE: This lead/appliance must only be wired by competent persons

&WARNING: THIS APPLIANCE MUST BE EARTHED
IMPORTANT: The wires in this lead are coloured in accordance with the
following code:

Green/ Yellow: Earth (25
Blue: Neutral .,_/5’
Brown: Live (Phase)

As the colours of the wires in main leads may not correspond with
the coloured marking identified in your plug/appliance, proceed
as follows:

The wire which is coloured Green & Yellow must be connected to
the Earth terminal marked with either the letter E, the earth symbol
‘=) or coloured Green/Green & Yellow.

The wire which is coloured Blue must be connected to the terminal
which is marked with the letter N or coloured Blue or Black.

The wire which is coloured Brown must be connected to the
terminal marked with the letter L or P or coloured Brown or Red.

If in doubt, consult the instructions provided with the equipment
or contact the supplier.

This cable/appliance should be protected by a suitably rated and
approved HBC mains fuse: refer to the rating information on the
equipment and/or user instructions for details. As a guide, a cable
of 0.75mm? should be protected by a 3A or 5A fuse. Larger
conductors would normally require 13A types, depending on the
connection method used.

Any exposed wiring from a cable, plug or connection that is
engaged in a live socket is extremely hazardous. If a cable or plug is
deemed hazardous, turn off the mains power and remove the cable,
any fuses and fuse assemblies. All hazardous wiring must be
immediately destroyed and replaced in accordance to the above
standard.
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G ETTING STARTED

This chapter provides a brief overview of the
GSP-9330, the package contents, instructions for
first time use and an introduction to the front
panel, rear panel and GUIL

GSP-9330 INtroduction ...cuvueeeieieinieiiiiniienenienenceeeneneeeenens 9
MAIN FEATULES ..ottt ettt sttt e sat et e e e sae et e sesatenbessesnsensesns 9
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GSP-9330 Introduction

The GSP-9330 builds on the strong feature set of the GSP-9300 and
significantly increases performance in almost every aspect; making
this the most comprehensive and feature-rich spectrum analyzer
GW Instek has released.

Like the GSP-9300, the GSP-9330 features a split window display to
view data in spectrum, topographic or spectrographic views. There
are also a number of additional test functions such as 2FSK, 1PdB
and new dedicated EMC pretest functions for EMI and EMS testing.
Lastly, the GSP-9330 significantly reduces the sweep time.

Main Features

Performance x9kHz~3.25GHz bandwidth
+*]1Hz resolution

*Nominal RBW accuracy of #5% <1MHz,
+8% =1MHz

*Video bandwidth 1THz~1MHz (1-3-10 steps)

+*Amplitude measurement range: DANL~30dBm
(frequency dependent)

«Input attenuation: 0 ~ 50dB, 1dB steps
*Phase noise: < -88dBc/Hz@1GHz, 10kHz, typical

Features ¥1-3-10 step increments for RBW bandwidth

*Three display modes: Spectrum, Topographic and
Spectrographic

«Split window display
*Built-in EMI filter
+*Auto Wake-up
+Built-in preamplifier
+Gate sweep

*Marker Frequency counter
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*Two operating modes: Spectrum and Power
Meter mode

*EMI Pretest functions

*SEM measurement

*ACPR measurement

*OCBW measurement

#*2FSK measurement

*Phase jitter measurement
*Harmonics measurement
#*P1dB measurement

+*Channel power measurement
*Demodulation analyzer

«Diverse marker functions and features with Peak
Table

*Sequence function to automatically perform pre-
programmed sequential operations

*EMI quasi-peak and average detector

*Optional battery operation

10
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Interface 8.4 color LCD (800x600)
*On-screen menu icons
*DVI-1 video output
*RS-232 with RTS/CTS hardware flow control
*USB 2.0 with support for USB TMC
*LAN TCP/IP with LXI support
*Optional GPIB/IEEE488 interface
+*Optional 3G USB adapter for WLAN
*Optional power meter adapter
+[F output @ 886MHz
+*Headphone output
*REF (reference clock) input/output BNC ports
+*Alarm/Open collector output BNC port
*Trigger/Gate input BNC ports
*RF N-type input port
*Tracking generator output
+*DC +7V /500mA output SMB port

L
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Accessories

Standard
Accessories

Options

Optional
Accessories

12

Part number

Region dependant
N/A

N/A

N/A

Option number
Optl.

Opt2.

Opt3.

Part number
ADB-002
ADB-006
ADB-008

GSC-009
GRA-415

Description

Power cord

User manual CD:
Includes: User manual,
Programming manual,
SpectrumShot quick start
guide, SpectrumShot
software, IVI driver

Quick start guide
Certificate of calibration
Description

Tracking generator

Battery (11.1V/5200mAH
Li-ion battery)

GPIB interface (IEEE 488
bus)

Description

DC BLOCK BNC 50R
10MHz-2.2GHz

DC BLOCK N TYPE 50R
10MHz-6GHz

DC BLOCK SMA 50R
0.1TMHz-8GHz

Soft Carrying Case
6U Rack mount kit
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Software Downloads

PC Software for Windows System (SpectrumShot quick
start guide, SpectrumShot software)

IVI Driver Supports LabView & LabWindows/CVI
Programming

Android System (“GSP-9330 Remote Control”, available
on Google play.)

13
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Appearance

GSP-9330 Front Panel

LCD Function Main  Control  File keys

dlsplay keys st keys / Power key

GUINgTEK smesa - ™ Marker keys
\ N
Preset/Local 7O Auxiliary kevs
and Quick \f ¥ K€Y
Save keys -0 Scroll wheel
=0
=0
1o Arrow keys
RF input
terminal
USB A, Tracking Numeric, DC power
Micro SD generator Enter and supply

port output BK SP keys

LCD display 800x600 color LCD display. The display shows the
soft keys for the current function, frequency,
amplitude and marker information.

Function keys @ N The F1 to F7 function keys directly
correspond to the soft keys on the
right-hand side of display.

Main keys Sets the center frequency, start

frequency, stop frequency, center
frequency step and frequency
offset values.

14
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Span Sets the span, with options for full
span, zero span and last span.
Sets the amplitude reference level,
attenuation, pre-amplifier
controls, scale and other options
for attenuation and scale.

Amplitude

Automatically searches the peak
signal with maximum amplitude
and displays it with appropriate
horizontal and vertical scales.

Autoset

Sets the resolution bandwidth,
video bandwidth, average type
and turns the EMI filter on/ off.

Control keys BWI/Avg

Sweep Sets the sweep time and gate time.

Sweep Toggles the Sweep Control
Moo between Fast and Normal mode.

Accesses measurement options
such as ACPR, OCBW,
demodulation measurements,
SEM, TOJ, 2FSK, phase jitter and
other advanced measurements.

Measure

EMC Dedicated EMI testing and setup
Pretest menu.

Sets traces and trace related
functions.

Trace

Limit Sets and tests Pass/Fail limit lines.
Line

15
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The Display key configures the
windowing mode and basic
display properties.

Sets the triggering modes.

File File utilities options

Save the trace, state etc., and save
options.

Recall the. trace, state etc., and
recall options.

Marker Turns the Markers on/ off and
configures the markers.

The Marker B key positions the
markers on the trace.

Finds each maximum and

Search minimum peak. Used with the
Marker function.
Auxiliary Access, set and edit program
sequences.
The Option Control key allows you
Control

to setup optional accessories such
as the Tracking Generator, Power
Meter or Demo Kit.

The System key shows system
information, settings and other
system related functions.

System

16
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Preset / Local key

Preset

LOCAL

The Preset key will restore the
spectrum analyzer to the Factory
or User Preset settings.

The Preset key will also return the
instrument back to local control
after it has been in remote control
mode.

The Quick Save utility allows you
to save either the state, trace,
display screen, limit line,
correction or sequence with only a
single press.

Power key Turns the instrument on/off. On =
yellow, off = blue.
Scroll wheel Edit values, select listed items.

Arrow keys @

Increment/decrement values (in
steps), select listed items.

RF input terminal

RF INPUT 500

DC +50V - MAX.
+30dBm MAX.

RF input port. Accepts RF inputs.
*Maximum input: +30dBm
«Input impedance: 50Q
*Maximum DC voltage: 50V
*N-type: female

17
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DC power supply SMB port supplies power for

optional accessories.
500mA MAX.
DC+7V

+*500mA Max.

1©

The numeric
keypad is used to
enter values and
parameters. It is
often used in
conjunction with
the arrow keys and
scroll wheel.

Numeric keypad 7=

—/

o

OJOXORO
OOOO
®OO

&

=

TG output port The Tracking Generator (TG)

output source.

TG OUTPUT 500 *N-typet female
DC £50V -~ MAX.
*Input impedance: 50Q
*Output power: -50dBm to 0dBm

*Maximum reversed power:
+30dBm

USB A, MicroSD o= L2 USB A port, Micro SD port for
= €=> saving/recalling settings/files.

18
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Rear Panel

IF OUT DVI-I USB-B, Fan Power

port LAN port / socket

RS232 port L

TRIG IN/GATE
IN port i

ALARM OUT/
open 7] }
COLLECTOR
/
REF OUT REF IN GPIB port Battery cover/
(optional) Optional
battery pack
RS232 Aoze RS232 9 pin DSUB port.
IF OUT ot SMA IF Out port.
DVI-I -t DVI video out port. Supports SVGA
oI« o (800X600) @ 60Hz.
Fan

Power Socket:
100~240V, 50/ 60Hz.

Power Socket

19
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Battery pack

REF IN

REF OUT

Security Lock

ALARM OUT

TRIG IN/GATE IN

Phone

USB B

LAN

20

OPEN
COLLECTOR

TRIG IN

GATE IN

Voltage: 10.8V
Capacity: 5200mAH

BNC female reference input.

BNC female reference output:
10MHz, 50Q impedance

BNC female open collector Alarm
output.

BNC female 3.3V CMOS trigger
input/gated sweep input.

3.5mm stereo headphone jack
(wired for mono operation)

USB B Device port. USB1.1/2.0

RJ-45 10Base-T/100Base-Tx
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Display
Attenuation Date Marker Function
level and time information Xl icon menu
Scale and Sweep
Reference Cosmmeors settings
level
. Trace/
Detection
Traces and settings
waveforms
Unassigned
settin
Sweep . &
icons
progress R S
bar i S o 5 e " Sweep,
/ | Trigger,
Entry / Frequency/Bandwidth  Status icons Pre-amp
Message settings and USB
area settings
Scale

Reference level

Attenuation

Date/Time

Marker
information

Displays the vertical scale of the vertical grid. For
details, see page 50.

Displays the reference level. For details, see page
48.

Displays the vertical scale (attenuation) of the
input signal. For details, see page 49.

Displays the date and time. See page 118 for
details.

Displays marker information. For details see page
94.

21
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LXI icon This icon indicates the status of the LXI connection.
For details, see page 270.

Function menu  Soft menu keys associated with the F1 to F7
function keys to the right of the display.

Sweep Mode This icon displays the sweep mode,

as set by the Sweep Mode key. See

page 79.

Sweep settings Sweep icon that shows the sweep

status. See page 72 for details.

Trace and
detection settings

Trace icon that shows the trace type
and the detection mode used for
each trace. See from page 81 for
details.

Blank Unassigned setting icons.

Trigger settings Trigger icon that shows the trigger

status. See page 89 details.

Pre-amp settings Pre-amplifier icon that shows the

Pre-amplifier status. See from page

62 for details.

USB settings Displays the status of the USB A
port.

Status lcons Displays the interface status, power source status

and alarm status, etc. See the Status Icon Overview
on page 24 for a list of the status icons.

22
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Frequency/ Displays the Start, Center and Stop frequencies,
Bandwidth RBW, VBW, Span and Sweep settings.
settings

Entry/Message  This area is used to show system messages, errors

area and input values/parameters.

Trace and Main display showing the input signals, traces

waveforms (page 81), limit lines (223) and marker positions
(94).

Sweep progress  The sweep progress bar shows the progress of
bar slow sweeps (greater than 2 seconds).

23



GUYINSTEK GSP-9330 User Manual

Status Icon Overview

3G Adapter Indicates that the 3G adapter is

installed and turned on.

Demo Kit H Indicates that the demo kit is

installed and turned on.

PreAmp Indicates that the pre amplifier is
. on.

AC E Shown when running on AC
power.

AC Charge E Shown when the AC power is
charging the battery.

Alarm Off Alarm buzzer output is currently
off.

Alarm On Alarm buzzer output is currently

on.

Amplitude Offset Indicates that the amplitude-shift is
active. This icon appears when
amplitude-related functions are
used:

Reference level offset
Amplitude Correction
Input Z =75Q and Input Z cal >0

Battery indicator =0 50N [ndicates the battery charge.
g =B y charg

Bandwidth w Indicates that the RBW or VBW
Indicator settings are in manual mode.

24



GYINSTEK

GETTING STARTED

Average

External Lock

External Trigger

Math

Sequence
Indicator

Sweep Indicator
Tracking
generator

TG Normalization

Wake-up clock

USB

Micro SD

Indicates that the Average function
is active.

Indicates that the system is now
locked and refers to the external

reference input signal

External trigger signal is being
used.

Trace math is being used.

Shown when a sequence is running.

Indicates that the sweep time is
manually set.

Indicates that the tracking generator
is turned on.

Indicates that the tracking generator
has been normalized.

Indicates that the wake-up clock is
turned on.

Indicates that a USB flash drive is
inserted into the front panel and is
recognized.

Indicates that a micro SD card is

inserted into the front panel and is
recognized.

25
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First Use Instructions

Use the procedures below when first using the GSP-9330 to tilt the
stand, insert the battery pack, power up the instrument, set the
internal clock, set the wake-up clock, update the firmware and to
restore the default settings. Lastly, the Conventions sections will
introduce you to the basic operating conventions used throughout
the user manual.

Tilting the Stand

Description The GSP-9330 has two adjustable rubber feet
that can used to position the instrument into
two preset orientations.

Upright Position Tuck the feet under
the bottom of the
instrument to stand
the instrument
upright.

Leaning Position Pull the feet back to
have the instrument
leaning back.

26
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Inserting the Battery Pack

Description

Steps

Display Icon

Insertion Diagram

The GSP-9330 has an optional battery pack.
The battery should be inserted before power is
connected to the AC power socket and before
the unit is turned on.

. Ensure the power is off and the AC power is

disconnected.

. Remove the battery cover.

. Insert the battery as shown in the diagram

below.

. Replace the battery cover.

EEWN  The battery icon is displayed when GSP-
9330 is running on battery power.

27
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Power UP

Steps 1. Insert the AC power cord into the power
socket.

2. The power button exterior will be lit blue to
indicate that the GSP-9330 is in standby mode.

@

3. Press the power button for a few seconds to
turn the GSP-9330 on.

4. The power button will turn orange and the
GSP-9330 will start to boot up.

-

A It takes a little less than 1 minute for the GSP-9330
Note to fully startup.

28
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Power Down

Description The GSP-9330 has two methods to power
down: Normal and Forced Power Down.

The normal power down method will save the
system state and end any running processes.
The state is saved for the next time the
instrument is turned back on.

The forced power down method only does a
minimum state save.

Normal Power Press the power button. The system will
Down automatically handle the power down
procedure in the following order:
*The system state is saved.

*Outstanding processes are closed in
sequence.

*The LCD backlight is turned off.

*The system enters standby mode (the
power key changes from orange to

blue).
& The process takes ~10 seconds.
Note
Forced Power Press and hold the power button for ~4
Down seconds until the system turns off and the

power button turns blue.
& N The forced power down mode might cause the
ote

GSP-9330 to perform a longer system check the
next time it is powered up.

29
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Setting the Date, Time and Wake-Up Clock

Description The GSP-9330 can be setup to power-up
automatically using the Wakeup Clock
function. This feature is useful to wake-up the
instrument early and eliminate settling time.

System Date Example: Set the System Date to July 1, 2016

1. Press >Dute/Time[F4]>Set
Date[F1]>Year[F1].

2. Press 2016>Enter[F1].
3. Press Month[F2]>7>Enter[F1].
4. Press Day[F3]>1>Enter[F1].

5. Press Return[F7].

A The System Date will be shown at the top of the
Note display.
System Time Example: Set the System Time to 9.00 AM

1. Press >D11te/I’ime[F4]>Set
Time[F2]>Hour[F1].

2. Press 9>Enter[F1].
3. Press Minute[F2]>0>Enter[F1].
4. Press Second[F3]>0>Enter[F1].

5. Press Return[F7].

30
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& The System Time will be shown at the top of the
Note display.

System Wake-Up Example: Set the GSP-9330 to wake up at 9.00
Clock AM

1. Press (9%n)>Date/Time[F4]>Wake-Up
Clock[F3]>Select Clock[F1].

2. Press Clock 1[F1] ~ Clock 7[F7] to choose a clock
1~7).

3. Press State[F2] to turn the wake up clock
on/ off.

4. Press Hour[F3]>9>Enter[F1].

5. Press Minute[F4]>0>Enter[F1].

6. Press [F5] and choose Rept. (Repeat) or Single.
7. Press Select Date[F6] and select a day.

8. Press Return[F7] to save the Wake-Up Clock
settings.

& The system time is kept with the CR2032 clock

Note battery. If the system time/ wake up clock can no
longer be set, please replace the clock battery. See
page 285.

31
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Firmware Update

Description

The GSP-9330 allows the firmware to be
updated by end-users. Before using the GSP-
9330, please check the GW Instek website or
ask your local distributor for the latest
firmware.

System version

32

Before updating the firmware, please check the
firmware version.

Press >System Information[F1].

The firmware will be listed on the display.

Press any other main/control/file/ marker
/auxiliary key to exit out of the System
Information screen.

To upgrade the firmware, insert the new
firmware onto a USB flash drive or Micro SD
card and put the drive/card into the
appropriate front panel port. The firmware
files should be located in a directory named
“gsp932”.
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5. Press >More 1/2[F7]>Upgrade[F2].

6. The spectrum analyzer will automatically find
the firmware on the USB flash drive and start
to update the firmware. When finished, the
message “Upgrade is finished” will be shown
at the bottom of the screen followed by
“Rebooting”.

Rebooting "

7. The system will automatically restart after the
rebooting message.

& The upgrade process may take a few minutes.
Note

Restoring Default Settings

Description The factory default settings or user presets can
be easily restored using the Preset key on the
front panel. By default, the factory default
settings are restored with the Preset key.

For details on how to configure the preset
settings, please see page 121.

Steps 1. Press .

2. The spectrum analyzer will load the preset
settings.

33
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Conventions

The following conventions are used throughout the user manual.
Read the conventions below for a basic grasp of how to operate the
GSP-9330 menu system and front panel keys.

Soft Menu keys The F1 to F7 function keys on the right side of
the display correspond directly to the soft-
menu keys on their left.

F1 ~ F7 function keys

Soft-menu keys

[ cwinsrek csessso - \ a

0000000~

Input Parameter
Values

Selecting this type of menu key will allow you
to enter a new value with the numeric keypad
or increment/decrement the value using the
scroll wheel.

Toggle State

Pressing this menu key will toggle the state.

34
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Toggle State &
Input Parameter

Pressing this menu key will allow you to toggle
the state of the function between Auto and
Man(ual) state. When in the Man state, the
parameter value can be manually edited. Use
the numeric keypad to enter the new value or
use the scroll wheel to increment/decrement
the current value.

Sub Menu

Date/Time>

Pressing this menu key will enter a submenu.

Sub Menu to
select parameter

Pressing this menu key will enter a submenu to
select a parameter.

Active Function

Pressing this type of menu key will activate
that function. The menu key will be
highlighted to show it is the active function.
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Parameter input

Using the numeric
keypad

Back Space

36

Numerical keypad

Scroll wheel

0000
oJoJolo

(
(

Directional arrow keys

Backspace, Enter keys

Parameter values can be entered using the
numeric keypad, the scroll wheel and
occasionally with the arrow keys.

When prompted to enter a parameter, use the
number keys (0~9), the decimal key (.) and the
sign key (+/-) to enter a value. After a value
has been entered, the soft-menu keys can be
used to select the units.

The value of the parameter is shown at the
bottom of the screen as it is edited. Values can
include decimal points for non-integer values
or for entering dot-decimal notation for IP
addresses.

tart 20 D0OMHz
W 30kHz

Edited parameter

ntor 25
BW-30kHz 1

Use the backspace key to delete the last
character or number entered.
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Using the scroll Use the scroll wheel to alter the current value.
wheel Clockwise increases the value, anti-clockwise
decreases the value.

Directional arrows Use the directional arrows to select discrete
parameters or to alter values by a coarser
resolution than the scroll wheel. Left decreases
the value, right increases the value.
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BASIC OPERATION
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Frequency Settings

Center Frequency

Description The center frequency function sets the center
frequency and centers the display to the center
frequency.

Operation 1. Press (a=)>Center[F1] and enter the
frequency and unit.

Range: 0kHz~3.25GHz
Resolution: 1Hz
Default 1.625GHz

Display Center frequency

p 15 000MHz
woep 1.80s

00MHz
10.000MHz

Set Center Frequency
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Start and Stop Frequency

Description The start/stop frequency function will set the
start and stop frequency of the span.

Operation 1. To set the start frequency, press (Few)> Sart
Freq[F2] and enter the frequency and unit.

2. To set the stop frequency, press > Stop
Freq[F3] and enter the frequency and unit.

Range: 0kHz~3.25GHz
Resolution: 1Hz

Default Start frequency: 0Hz

Default Stop frequency: 3. 25GHz

Display Start Frequency Stop Frequency

04:46:00  2014.07-01

At 27 00 dB

©10.000MHz
pan: 10.000MHz

Start Frequency Stop Frequency

A The start and stop frequency can change when the
Note span settings are used.

The stop frequency must be set higher than the
start frequency (for spans # 0), otherwise the span
will be automatically set to T00Hz.
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Center Frequency Step

Description The CF Step function sets the step size of the
center frequency when using the arrow keys or
scroll wheel.

When the scroll wheel or arrow keys or are
used to alter the center frequency, each
turn/press will move the center frequency by
the step size specified by the CF Step function.

In auto mode, the center frequency step size is
equal to 10% (1 division) of the span.

Operation 1. Press > CF Step[F4] and set the CF Step to
Auto or Man.

2. If Man was selected, set the frequency and unit
of the center frequency step size.

Manual Range: 0Hz~3.25GHz
Auto range: 1/10 of span frequency

3 2014-07-01

Display

® CF Step size
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Frequency Offset

Description

The Freq Offset function allows you to add an
offset to the Center, Start and Stop frequencies
as well as the marker frequencies. The offset
value does not affect displaying the trace on the
display.

Operation 1.

Display

Press >Freq Offset[F5] and set the offset

value.

The Center, Start, Stop and Marker frequencies
are updated accordingly.

Offset Range: 0Hz~100GHz

StartFraq

h Frequency
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Span Settings

Span

Description The Span function will set the frequency range
of the sweep. The sweep will be centered
around the center frequency.

Setting the span will alter the start and stop
frequencies.

Operation 1. Press > Span[F1] and enter the span
frequency range and unit.

Range: 0kHz~3.25GHz

Resolution: 1Hz
Default Span: 3.25GHz

Display Span

GWINSTEK 1 39 2011-09-08

3.0900 GHz - 10.83 dBm
-B0.0MHz 109 dB

Wit
| 10MoaBm At 20 0048 Akt

Set Span
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Full Span

Description The Full Span function will set the span to the
full frequency range.

This function will set the start and stop
frequencies to 0Hz and 3.25GHz respectively.

Operation 1. Press > Full Span[F2].

Zero Span

Description The Zero Span function will set the frequency
range of the sweep to 0Hz and fixes the start
and stop frequencies to the center frequency.
The Zero Span function measures the time
domain characteristics of the input signal at the
center frequency. The horizontal axis is
displayed in the time domain.

Operation 1. Press > Zero Span[F3].

The span changes accordingly.
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Display

& Note

Time domain

Stop 10.000MHz
Sweep:81.9ms

OHz Span
Example: Amplitude modulation

The measurement functions such as TOI, SEM,
CNR, CTB, CSO, ACPR, OCBW, phase, Jitter,
Harmonics, NdB, P1dB and other measurement
functions are not available with the zero span
setting:

Last Span

Description The last span function returns the spectrum
analyzer to the previous span settings.

Operation 1. Press (== )> Last Span[F4].
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Amplitude Settings

The vertical display scale is defined by the reference level
amplitude, attenuation, scale and external gain/loss.

Reference Level

Description The reference level defines the absolute level of
the amplitude on the top graticule in voltage or
power.

Operation 1. Press > Ref Level[F1] and enter the
reference level amplitude and unit.

Range: -120dBm ~ 30dBm
Units: dBm, -dBm, W, V, dBV
Resolution: 1dBm

Display Ref Level reading Reference Level

tart 5.000MHz

enter 10.000MHz top 15.000MHz
RBW 1.0kHz BW 1.0kHz pan :10.000MHz woop 1.80s

Ref 17 00dBm
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Attenuation

Description The attenuation of the input signal level can be
set to automatic (Auto) or manual (Man). When
the attenuation is set to Man, the input
attenuator can be changed manually in 1dB
steps.

Operation 1. Press > Attenuation[F2] and select Auto
or Man.

2. If Man was selected, enter the attenuation level

and unit.
Range: 0dBm ~ 50dBm
Units: dBm
Resolution: 1dB

Display Attenuation level

47 2014.07-01
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Scale/Div
Description Sets the logarithmic units for the vertical
divisions when the scale is set to Log.
Operation 1. Press > Scale/Div[F3] repeatedly to select
the vertical division units.
Unit Range: 10,5,2,1
Display
A The Scale/Div function is only selectable when the
Note scale is set to Log (logarithmic).
Auto Scale
Description The Auto Scale function will automatically set
the Scale/Div, Reference level and Attenuation
(if set to Auto) to best display the spectrum.
Operation 1. Press > Auto Scale[F4] to turn the Auto
Scale function on.
A This function is applicable to both the linear and
Note

logarithmic scales.
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Scale Type

Description Sets the vertical scale in linear or logarithmic
units.
By default the linear scale is set to volts and the
logarithmic scale is set to dBm.

Operation 1. Press (Amwse)> More[F7] > Scale Type[F2] and set
the vertical scale to Log or Lin.

& If the unit scale is changed (i.e. dBm — volts), the

Note displayed vertical scale type will remain in the set

linear or logarithmic setting.

View Scale

Description The Scale function turns the vertical scale
on/off. The value of each graticule division is
displayed with the same units that are used for
the Ref Level settings.

Operation 1. Press (amws)> Scale[F5] to toggle the Scale on or

off.

2. Press Scale Pos.[F6] to toggle the position of the
scale when on.

Scale position: Left, Center, Right
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Display

Scale
Left

The vertical scale is displayed on the left-hand side
by default.
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Vertical Scale Units

Description Change the vertical units for both linear or
logarithmic scales.
Operation . Press > More[F7]>Y Axis[F1] and then

choose the desired units.

2. The units are changed accordingly.

Units: dBm, dBmV, dBuV,
Watts, Volts

Reference Level Offset

Description

The Reference Level Offset function sets an
offset value to the reference level to compensate
for any loss or gain from an external network or
device.

The offset value does not affect the input
attenuation or the on-screen trace.

This setting will change the reference level
readout, the scale readout and the marker
readout.

Operation

Display Icon

. Press > More[F7]>RefLvlOffset[F4] and set

the offset level and unit.

. To remove the offset level, set the reference

offset to 0 dB.
Range: 0dB ~ 50dB

AW The AMP icon is displayed at the bottom
of the screen.
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Example: Ref: 0dBm

Before reference level offset(offset: 0d B)

Reference level
Ref: 10dBm offset: 10dB

0 2014-07-01

After reference level offset (offset: 10d B)

Amplitude Correction

Description Amplitude correction adjusts the frequency
response of the spectrum analyzer by altering
the amplitudes at specified frequencies. This
allows the spectrum analyzer to compensate for
loss or gain from an external network or device
at certain frequencies.

Range Correction Sets: 5 sets of 30 points
Amplitude: -40dB to +40dB
Amplitude Resolution: 0.1dB
Frequency: 9kHz to 3.25GHz

Frequency Resolution: 1Hz
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Display Correction points

(lee(melmadsealioal

Corrected
output

Original waveform

Example: The diagram above shows how amplitude
correction is used to compensate for any losses or
gains at specific frequencies.

Create a Correction Set

Description The GSP-9330 can create and edit up to 5 sets of
correction points. The correction points and
associated values are all tabulated for ease of
use.

Operation 1. Press > More[F7]>Correction[F3]> Select
Correction[F1] and choose a correction set to
edit/create.

Correction set: 1~5
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2. Press Edit[F3].

The GSP-9330 will split into two screens. The
top screen will show the waveform and the
bottom screen will provide an overview of the
correction points.

Frequency of

Spectrum display selected point

201609 2|+
1048/ MK1
17.00dBm _ At 27.0048

10.00 MHz 7.58  dBm

11 5 000MHzZ enter 10 O0OMHZ
W 3 0kHz BW 3 0kHz 10.000MHz

Frag 15.000000 MHz

Correction points

3. Press Point Num[F1] and choose a point number
to edit. Point numbers can only be created in
order. For example Point Num 2 can only be
selected after Point Num 1 is created, and point
Num 3 can only be selected after Point Num 2
is created and so on.

Point Num: 1~20

4. Press Frequency[F2] and choose the frequency of
the selected point.

5. Press Gain Offset[F3] and choose the amplitude

of the selected point. The units will be the same
as those used for the vertical scale.
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The frequency of the point values are displayed
in the correction table on the bottom display.

Correction Table

6. Repeat steps 3 to 5 for any other correction

points.

. To delete the selected point, press Delete

Point[F6].

. Press Return[F7]>Save Correction[F5] to save the

correction set.

& Note

Note that the correction points are automatically
sorted by frequency (low — high).

The correction set must be saved before it can be
turned on.

The frequency values displayed in the correction
table are rounded down for display purposes only.
The actual frequency for each point can be seen in
the Frequency soft-key.

Amplitude Correction On/Off

Description Any one of the 5 correction sets can be turned
on.

Activate . Press > More[F7]>Correction[F3]>

Correction

Correction Set[F1] and choose a correction set.

Correction Set: 1~5
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2. Press Correction[F2] and toggle correction on.

Deactivate 1. Press > More[F7]>Correction[F3]>
Correction Correction[F2] to turn correction back off.

Delete Correction Set

Operation 1. Press > More[F7]>Correction[F3]>
Correction Set[F1] and choose the correction set
to delete.

Correction Set: 1~5

2. Press Delete Correction[F6].
The selected correction set will be deleted.

Save Correction Set to Memory

Operation 1. Press (s )> Save To[F1] and choose the save
location.
Location: Register, Local, USB, SD

2. Press Type[F2]> Correction[F5].
3. Press Data Source[F3] and choose a correction.

Correction Set: Correction 1~5

4. To name the file, press Name[F5].
Name the selected file using the
F1~F7 keys, as shown below or use
the numeric keypad to enter
numbers.

OOOO
WOOO

OOOO
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Limitations:
*No spaces
«*Only 1~9, A~Z, a~z characters allowed

[ Name>

5. The filename appears on the bottom of the
screen as it is created.

a5 000MHz 10.000MHz
LQW:3.0kHz  Span:10.000MHz

Filename

Press to confirm the filename.

& If the file name is not user-defined, a file name will
Note be automatically created in the following format:

File name: type_data source_file number.file
extension

Example: Correction1_0.cor

The file number parameter is incremented each
time the same file type is created.
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6. Press Save Now[F7].
7. The correction set will be saved to the selected

location. For more information on Save and
Recall, please see page 261.

Recall Correction Set From Memory

Operation 1. Press > Recall[F1] and choose the recall
location:
Location: Register, Local, USB, SD

2. Press Type[F2]> Correction[F5].

3. Use the scroll wheel to select a previously saved
correction set from the file directory.

4. Press Destination[F3] and choose a correction
set.

Correction Set: Correction 1~5

5. Press Recall Now][F4].
6. The current correction set will be recalled from

the selected location. For more information on
Save and Recall, please see page 261.
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Input Impedance

Description Sets the input impedance to 75Q or 50Q.
Operation 1. Press > More[F7]> More[F7] > Input Z[F1]

to toggle the input impedance.

Range: 75Q, 50Q

Input Impedance Calibration

Description When an external impedance converter module
(optional accessory ADP-101) is used to convert
the impedance of a device from 50Q to 75Q,
some external loss can be induced. The Input Z
Cal function can be used to compensate for
these losses with an offset value.

& The Input Z Cal function is only functional when
Note the input impedance is set to 75Q.

Operation 1. Press (amie)> More[F7]>More[F7]>Input Z
Cal[F2] and set the impedance offset.

Range: 0dB to +10dB
Resolution: 1dB

Display Icon AM The AMP icon is displayed at the bottom
of the screen when Input Z Cal#0dB and
Input Z is = 75Q.
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Using the Built-in Pre-Amplifier

Description The built-in pre-amplifier boosts weak input
signals, such as EMI testing signals, to levels
that are easy to handle, over the entire
frequency range. The built-in pre-amplifier on
the GSP-9330 has a nominal gain of 20dB.

In the Auto setting, the pre-amplifier will be
automatically turned on when the reference
level is less than -30dBm. When the reference
level is greater than -30dBm, the pre-amplifier
is turned off. The bypass setting turns the pre-
amplifier off.

Operation 1. Press > More[F7]>Preamp[F5] to toggle
the Preamp state.
Range: Auto, Bypass
Display Icon The Pr-amp icon indicates that the pre
amplifier is on.
Example: I -

Att 0.0dB

tor 10.000MHz top 15.000MHz

o 0.00
BW-3.0kHz pan 10.000MHz wovp 442ms

Pr-amp icon
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& Note

When the pre-amplifier is on, the attenuator
becomes fixed at 0dB (i.e. Attenuation = 0dB).
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Autoset

The Autoset function searches the peak signals in two stages (full
span & OHz - 100MHz limited span), picks the signal peak with the
maximum amplitude, and then shows it in the display.

Using Autoset

Operation 1. Press > Autoset[F1].

Autoset Range Amplitude: -80dBm ~ +20dBm
Span: OHz ~ 3.25GHz
Example: oy %000 20tbon0r

0.00dBm A1 10.0d8

‘ln

b,

.

N
.

INRAUAC

P 3.000GHz
Sweep: 348ms

Before Autoset, preset state

33:51  2014.07-01
1048/ K 10.000 MHz 8.10  dBm
st 10.000Bm __ Att

After Autoset
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& RBW, VBW and sweep settings are reset to Auto
Note when the Autoset function is used.

Limiting the Autoset Vertical Search Range

Description You can set the amplitude floor so that the
signals lower than the setting will be ignored
by the Autoset search.

Operation 1. Press (Aumsd)> Amp.Floor[F2] and switch the

range from Auto to Man.

2. Enter the amplitude limit and unit for the
Autoset search.

Range: —-60 to +20dBm

& See page 50 for setting the amplitude units.
Note

Limiting the Autoset Horizontal Search Range

Description You can change the frequency span limit in the
display to get a better view of the Autoset
result. By default, the frequency span after
Autoset is set at SMHz.

Operation 1. Press > Span[F3] and switch the range
from Auto to Man.

2. Enter the span frequency for the Autoset
search.

Manual Range:  100Hz to 3.25GHz
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Bandwidth/Average Settings

BW/AVG key sets the resolution bandwidth (RBW), video
bandwidth (VBW) and averaging functions. The resolution, sweep
time, and averaging are in a trade-off relationship, so configuration
should be done with care.

Resolution Bandwidth Setting (RBW)

Description RBW (Resolution Bandwidth) defines the width
of the IF (intermediate frequency) filter that is
used to separate signal peaks from one another.
The narrower the RBW, the greater the
capability to separate signals at close
frequencies. But it also makes the sweep time
longer under specific frequency spans (the
display is updated less frequently).

SPAN-RBW Auto When the RBW is set to Auto, the RBW is
relationship determined by the frequency span. This is
shown in the table below.

SPAN-RBW Span (Hz) < RBW (Hz) Span (Hz) <RBW (Hz)
relationship in 200 1 650k 3000
Auto mode.
650 3 2M 10000
2k 10 6.5M 30000
6.5k 30 20M 100000
20k 100 65M 300000
200k 1000 200M 1000000
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Operation 1. Press (=wa )> RBW[F1] and set the RBW to
Auto or Man.

2. Set the resolution bandwidth and unit for Man
mode.

Mode: Auto, Man
Frequency Range(3dB): 1THz~1MHz (1-3-10 step)

Frequency Range(6dB): 200Hz, 9kHz, 120kHz,
1MHz

& If the setting is in Auto mode, using the scroll
Note wheel or arrow keys will automatically set the RBW
to manual mode.

Display lcon E The BW icon is displayed at the bottom of
the screen when the RBW is in Man mode.

& If the RBW settings have an asterisk (¥), it
Note indicates that the -6dB filters are used.
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Video Bandwidth Settings (VBW)

Description VBW (Video Bandwidth) defines the
smoothness of the trace on the display.
Combined with RBW, VBW defines the ability
to sort out the target signal from surrounding
noise or adjacent peaks.

Operation 1. Press (=wa)> VBW[F2] and set the VBW to
Auto or Man.

2. Set the video bandwidth and unit for Man
mode.

Mode: Auto, Man
Frequency Range(3dB): 1THz~1MHz (1-3-10 step)

Display Icon The BW icon is displayed at the bottom of
- the screen when the VBW is in Man mode.

VBW/RBW Ratio

Description The VBW/RBW function is used to view the
ratio between the video bandwidth and the
resolution bandwidth.

The VBW/RBW ratio is altered by setting the
RBW and or VBW settings, see page 66 & 68
respectively.

View VBW/RBW 1. Press ‘

ratio

2. The ratio is displayed on the VBIA/RBW[F3] soft
key.
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Display
VBW/RBW
Ratio
Tip Signals that are masked by the noise floor level
should have a ratio of less than 1 to smooth the

noise out.

Signals with strong frequency components should
use a ratio equal to or greater than 1.

Average Trace

Description The Average function averages the trace for a
user-defined number of times before it is
displayed. This feature smoothes the noise
level, but has the drawback of slowing down
the display update rate.

Operation 1. Press > Average[F4] and toggle Average
on or off.

2. Set the number of averages.

Range: 4 ~200
Default: 20
Display Icon The AVG icon is displayed at the bottom of
the screen when the Average function is
on.
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23.16:23  2014.07-01
10.000 MHz 8.24  dBm

Example:

1o 1048/
1 10.00dBm __ Att 20.00d8

10.000MHz p11.500MHz
1°3.000MHz weep:25.2

Average:Off

Number of traces that
have been averaged

2809 2014.07-01 0] BW/Avg
10,000 MHz 8.24  dBm

1048/ Avg: 20
10.00dBm _Att 20 0048

10.000MHz
v 30kH: VEW:30KkHz pan:3.000MH;

Average 20

Average: On (20x)
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Average Type

Description The Average Type function determines how the
GSP-9330 determines the average value.

LOG Average: Averages the trace points on a
logarithmic scale.

Volt Average: Averages the amplitudes of the
trace points on a linear voltage scale.

Power Average: Averages the trace points on a
logarithmic scale in watts.

Operation 1. Press > Average Type[F5] and choose the
average type.

Range: LOG Power, Volt

Average, Power Average
Default: LOG Power

n
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EMI Filter

Description The built-in EMI filter is used for specific
measurement situations such as EMI average
detection, where a higher level of sensitivity is
required compared to the standard
configuration. When turned on, the RBW is set
to -6dB, indicated by an asterisk (*).

When any measurement functions are turned
on (see page 123 for details), the EMI filter is
automatically disabled. Conversely if the EMI
filter is turned on, any measurement functions
are turned off.

Operation 1. Press (®¥~)> EMI Filter[F6] and toggle EMI
filter on or off.

A See the specifications for details on the EMI filter,
Note page 333.
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Sweep

The GSP-9330 has a number of sweep options including setting the
sweep time, the sweep run mode (continuous, single) and sweep
mode (fast, slow). The GSP-9330 also has gated sweep modes.

Sweep Time

Description Sweep time defines the length of time the
system takes to "sweep” the current frequency
span. Note, however, that sweep time and
RBW/VBW are in a trade-off. Faster sweep
times update the display more frequently but
make RBW and VBW wider, reducing the
capability to separate signals at close
frequencies.

Operation 1. Press > Sweep Time[F1] and toggle the
Sweep time to Auto or Man.

2. Set the sweep time for the Man mode.

Mode: Auto, Man

Range: 1.14ms ~ 1000s (span=100Hz,
RBW=3kHz)

Resolution: 46.6us ~ 1000s (span=0Hz,
RBW= 1MHz)

Display Icon The SWT icon will be displayed at the

bottom of the screen when the sweep is in
manual mode.
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Single Sweep

Description The single sweep function is used to perform a
single sweep. When Sweep Single is pressed the
GSP-9330 will perform a single sweep and then
stop.

Operation 1. Press (sws )> Sweep Single[F2] to put the
spectrum analyzer into single sweep mode.

2. Press Sweep Single[F2] again to perform a single
sweep.

+*When a single sweep has been performed, you
can still perform frequency, span, amplitude and
other functions on the “frozen” trace.
Display Icon dess The Sweep Single icon is displayed on the
right-hand side of the screen when the
sweep is in single mode.

A You must wait for the single sweep to finish before
Note pressing the Single Sweep key again.

If a setting is changed whilst the spectrum analyzer

is still sweeping, the single sweep will immediately
start over.
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Continuous Sweep

Description The GSP-9330 has two main sweeping run
modes: single and continuous. Use the
continuous mode to have the sweep constantly
updated.

Operation 1. Press ((swe )> Sweep Cont[F3] to put the
spectrum analyzer into continuous sweep
mode.

ELE=  The Sweep Cont icon is displayed on the
Ml right-hand side of the screen when the
sweep is in continuous mode.

Display lcon

& The GSP-9330 will now continuously sweep unless
Note the mode is changed to single sweep mode or if
the system is waiting for a trigger condition.

Gated Sweep Overview

Description The Gated Sweep mode allows a trigger signal
to dictate when the spectrum analyzer can
sweep. This mode is useful for characterizing
signals that are pulsed on and off, such as RF
burst transmissions or for measuring spurious
noise levels between transmission bursts.

Overview 1. The trigger signal must be synchronized to the
period of the input signal (shown as RF burst
below).

2. The start of the gate time is produced from the

positive or negative edge of the trigger signal +
the delay time.
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. The end of the gate time is determined by the

set gate length.

. The gated sweep should not be positioned at

either end of the transmission.

period
RF Burst
Trigger |_|
Gate B B
— k—Delay —i  k—Length

Example: The diagram above demonstrates the
relationship between the input trigger, the input
signal and the position of the gated sweep relative
to the input signal.

& Note

76
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Using the Gated Sweep Mode

Connection 1. Connect a trigger signal (3.3v CMOS) to the
GATE IN port on the rear panel.

TRIG IN

GATE IN

& RBW must be equal to or greater than 10kHz for
Note the gated sweep mode function to be available.

Operation 1. Press > GateDelay[F5] and set the gate
delay time.

2. Press > Gated Length[F6] and set the gate
time length.

3. Press > Gated Sweep[F4] and turn the

mode on.
Gate Delay: 0s ~1000s
Gate Length: 58us ~ 1000s

Sleas The Sweep Gated icon is displayed when
SN Gated Sweep is turned on.

Cate

Display lcon
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The example below shows the spectrum of an FSK
modulated signal when gated sweep mode is off.
i 3

38.00  2014-06-17 D

The example below shows the same signal with the
gated sweep timed to sweep when only the desired
frequency is output.

1048/
51 0.00d8m At 10.0d8

p 1.501GHz
woep 10.0ms

1.500GHz
pan 1.000MHz

A Note

78
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Sweep Control / Sweep Mode

Description The Sweep Control function and the Sweep
Mode key toggles the Sweep Mode from
Normal to Fast.

The Fast setting speeds up the signal processing
and the display update rate to increase the
overall sweep time. This mode is especially
useful when the span is greater than 1IMHz.

When set to Normal, signal processing and
update rate is set to normal levels.

Operation 1. Press > Sweep Control [F7] to toggle the
Sweep Mode between Norm. and Fast.

OR

2. Press and toggle the Sweep Mode
between Norm. and Fust.

Display lcon

Sweep Times Center Frequency = 1.625GHz Sweep Mode
Span(Hz) RBW (Hz) AUTO Norm.  Fast
3.25G ™ 169ms  84.8ms
2G ™ 104ms  52.2ms
1G ™ 52ms 31.1ms
500M ™ 3Tms 16.8ms
200M ™ 13.4ms  6.72ms
100M ™ 6.7ms 3.36ms
50M 300k 10.7ms  716us
20M 100k 23.4ms  573us
10M 100k 11.7ms  286us
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5M 30k 28.9ms  655us
2M 10k 10Tms  1.96ms
™ 10k 50.9ms 1.31ms
500k 3k 6.88ms  6.88ms
200k 1k 22.9ms 22.9ms
100k 1k 9.83ms 9.83ms
50k 300 76.4ms  76.4ms
20k 100 219ms  219ms
10k 100 109ms  109ms
5k 30 710ms  710ms
2k 10 1.98s 1.98s
1k 10 994ms  994ms
500 3 2.65s 2.65s
200 1 2.65s 2.65s
100 1 2.65s 2.65s
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Trace

The GSP-9330 is able to set the parameters of up to 4 different
traces on the display at once. Each trace is represented by a
different color and is updated with each sweep.

Selecting a Trace

Description Each trace (1, 2, 3, 4) is represented by a
different color. When activated, an icon for each
trace color and function is shown to the left of
the display. When a trace is selected,
parameters can be set/edited from the trace

menu.
Trace Color: 1: Yellow
2: Pink
3: Blue
4: Orange
Trace Type The type of trace used determines how the trace

data is stored or manipulated before being
displayed. The analyzer updates each trace
according to the type of trace used.

Clear and The GSP-9330 continuously
Write updates the display with each
sweep.
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Display Icon
Example

Hold Max/
Hold Min

View

Blank

Trace 1
Trace 2

Trace 3

Trace 4

The maximum or minimum
points are maintained for the
selected trace. The trace points
are updated each sweep if new
maximum or minimum points
are found. The Hold Max
setting also has a threshold
setting. This setting will ensure
only those values above the
threshold are kept.

View will hold the selected
trace and stop updating the
trace data for the selected trace.
Pressing View[F5] will display
the trace data that was cleared
using the Blank[F6] key.

Clears the selected trace from
the display and stores trace

data. The trace can be restored
by pressing View[F5].

-
.— View
r = Hold Max
E_ View

Blank

Operation

82

number.

Trace:
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Clear & Write[F2]
Max Hold[F3]
Min Hold|F4]

View[F5]
Blank[F6]

level.

. Select the trace type:

. If Max Hold[F3] was selected, set the threshold

& Note

Trace Math

Traces, 2, 3 and 4 are set to Blank by default.

Description

Performs trace math from two traces (TR1, TR2)
and stores the result in the currently selected
trace. It also performs trace shift.

Math functions

Power Diff

Log Diff

Subtracts the TR1 amplitude
data from the TR2 amplitude
data. The TR1 data TR2 data
are converted to watts. The
result is converted back to
dBm.

Subtracts the TR1 amplitude
data from the TR2 amplitude
data and then adds a
logarithmic reference. Both the
TR1 and TR2 data is in dBm.
The resultant trace of the
subtraction is in dB. When the
result is added to a logarithmic
reference the resulting data is
in dBm.
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LOG Offset Adds a reference to the TR1
trace

Operation 1. Press (= )> More[F1]>Trace Math[F1].
2. Press TR1[F1] and select the first trace source:
TR1: Trace 1,2, 3, 4*

3. Press TR2[F2] and select the second trace

source:
TR2: Trace 1, 2, 3, 4*
& *You cannot select the current trace as the TR1 or
Note

TR2 trace sources. The current trace is designated

by pressing > Select Trace>[F]].

4. Select the trace math function:
PowerDifffF3]
LogDifflF4]
LogOffset(F5]

5. If LogDiff was selected, set the reference level
and unit.

LogDiff ref range: -120dBm ~ 30dBm
LogDiff ref units: dBm, W

6. If LogOffset was selected, set the offset level
and unit.

LogOffset range: -50dB~+50dB

7. To turn trace math off, press the OFF[F6].
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The Math icon is displayed when trace
matbh is turned on.

Display Icon

Trace Detection Mode

Description Each time the spectrum analyzer samples data
for each point on the trace, a number of samples
are usually taken for each point, known as a
sample bucket. The actual value of each point is
determined by the detector from the samples in
each bucket.

Each selected trace, (1, 2, 3, 4), can use a
different detection mode.

Detection modes Auto Automatically chooses an
appropriate mode based on the
values of all the samples.

Normal While the signal level is
constantly increasing or
decreasing, the positive peaks
are detected. Otherwise, the
detection mode switches
between positive peak and
negative peaks. Useful for
picking up burst phenomenon
while avoiding excessive noise.

Peak+ Detects positive peak signals
by selecting the maximum peak
value for each point from each
bucket. This mode is useful for
sinusoidal signals.
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Peak-

Sample

RMS
Average

EMI>
Quasi-peak

EMI>
Average

Detects negative peak signals
by selecting the lowest peak
value for each point from each
bucket. This mode is not
recommended for amplitude
measurement.

Randomly selects a value from
the bucket sample. Useful for
noise signals.

Calculates the RMS average
power of all the samples in the
sample bucket.

The quasi-peak detector is a
peak detector that is weighted
by the duration and repetition
rate of the signal, as specified
by the CISPR 16-1-1 standard.
Quasi-peak detection is
characterized by a fast charge
time and slow decay time.

Calculates the average power
of all the samples in the sample
bucket.
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Auto Detector Below is a flow chart diagram showing the
Selection Method Detector selection for the Auto mode.

Detector
(Auto mode)
Y
Are any windows Y,
set to Topographic?
N
Y

l Is Phase Jitter Y.
measurement on?
Is (trace)
on

-l
Rl

Average
?

A

Are any traces set | v,
to Max Hold?

N

A\

Are any traces set | v,

to Min Hold?
N

A

(Normal )

Operation 1. Press (== )> More[F7]>Detection[F2].

2. Select the trace detection mode for the selected
trace:

AutofFT]

NormallF2]

Peak+[F3]

Peak-[F4]

Sample[F5]

RMS Average[F6]
EMI[F7]>Quasi peak[F1]
EMI[F7]>Average[FZ]
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3. The display will return to the Trace menu.

Display Icon Normal Peak+ icon
Peak- icon Sample icon
RMS Average Quasi-peak
icon icon

RIS

Average icon
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Trigger

The Trigger function sets the signal conditions upon which the
spectrum analyzer triggers captured waveforms, including
frequency, amplitude, and delay. An external trigger signal, instead
of the default internal signal, may be used as required for special
conditions.

The sections below can be used to skip to the relevant section:

+Free Run Mode — from page 89
*Activate Video Trigger — from page 89
*Activate External Trigger — from page 91
«Selecting Trigger Mode — from page 92
«Set the Trigger Delay Time — page 93

Selecting a Trigger Type

Free Run Mode

Description In free run mode all signals are captured and
the trigger conditions are not used.

Free Run Mode 1. Press (™ )> Free Run[F1] to run in free mode.

Activate Video Trigger

Description Sets the video trigger level for video signals.
When the video signal voltage level exceeds*
the video trigger level, a trigger signal will be
generated.

*for positive video edge
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Parameters Video Edge: Determines the polarity of the
video trigger.
Positive: The signal voltage
exceeds the video level at the
trigger frequency.
Negative: The signal voltage is
lower than the video level at
the trigger frequency.
Video Level: The trigger voltage level.
Trigger Sets the frequency to start
Frequency: triggering
Operation . Press >Trigger Condition[F2]>Video[F1]
. Press Video Edge[F1] and choose the edge.
Range: Positive, Negative
. Press Video Level[F2] and set the video voltage
trigger level.
Trigger level: (-120dBm to +30dBm)
+Ref Level Offset
. Press Trigger Freg[F3] and choose the frequency
at which the spectrum analyzer will check the
triggering conditions.
Frequency: 0-3.25GHz+frequency
offset
Display Icon WEEEER The Video Level trigger icon is displayed

90
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& Set the trigger back to Free Run to disable the
Note video trigger.

Activate External Trigger

Description The external trigger is used when an external
trigger signal is input into the rear panel TRIG
IN port. The external trigger signal can be
configured as positive or negative edge.

Trigger: 3.3V, CMOS

Operation 1. Press >Trigger Condition[F2]>Ext.Edge[F2]
and select the trigger edge:

Pos: Positive edge
Neg: Negative edge

2. Connect the external trigger signal to the rear
panel TRIG IN port.
TRIG IN

GATE IN

3. Press Action Now[F5] to activate the external
trigger.

4. The system will now wait for the trigger
conditions to be matched before starting a
sweep.
Display Icon S8l The EXT Trigger icon is displayed when the
EESN external trigger is activated.

EXT
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& Note

The trigger will revert back to the Free Run mode if
any parameter settings are changed, such as the
span or amplitude settings.

Selecting the Trigger Mode

Description In free run mode all signals are captured and

the trigger conditions are not used.

Modes Normal: The spectrum analyzer captures
every signal that meets the trigger
conditions.

Single: The spectrum analyzer captures
the first signal that meets the
trigger conditions.

Continuous: The spectrum analyzer captures
the first signal that meets the
trigger conditions then switches to
free run mode thereafter.

Operation . Press > Trigger Mode[F3] to toggle the

trigger mode:

Nor.: Normal
Sgl.: Single
Cont.: Continuous

. Press Action Now[F5] to manually start

triggering.

Display lcons
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Set the Trigger Delay Time

Description Sets the delay time between when the analyzer
triggers and when the analyzer begins to
capture the signal.

Delay time range: 1ns to 1ks

Operation 1. Press >Trigger Delay[F4] and set the
trigger delay time.

Delay range: 0~1000s
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Marker

A Marker shows the frequency and amplitude of a waveform point.
The GSP-9330 can activate up to 6 markers or marker pairs
simultaneously as well as up to 10 peak markers in the marker table.

The marker table helps editing and viewing multiple markers in a
single display.

A delta marker shows the frequency and amplitude difference from
a reference marker.

The GSP-9330 can automatically move a marker to various
locations including the peak signal, center frequency, and
start/stop frequency. Other marker operations regarding signal
peaks are available in the Peak Search function.

*Activating a Marker — from page 95

*Move Marker Manually — from page 96

*Move Marker to Preset Locations — from page 96
*Activate Delta Marker — from page 97

*Move Delta Marker(s)Manually — from page 98
*Marker Functions — from page 99

*Move Marker to Trace — from page 101

*Show Markers in Table — from page 102

*Peak Search — from page 103

*Peak Configuration — from page 105

*Peak Table — from page 106
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Activating a Marker

There are two basic marker types, normal markers and delta
markers. Normal markers are used to measure the frequency/time
or amplitude of a point on the trace. Delta markers are used to
measure the difference between a reference point and a selected
point on the trace.

Activate a Normal Marker

Operation 1. Press (" )> Select Marker[F1] and select a
marker number.

Marker: 1~6
2. Press [F2] to turn the selected marker on.

3. Press Normal[F3] to set the selected marker to
the Normal type.

4. The display will show the marker on the trace
(centered by default) with the marker

measurement at the top of the display.

Maker 1D, Frequency, Amplitude

[EED

ale 1048/
30.00dBm 40.00

Marker

::::::::

10.000MHz
an: 3. 000MHz

Fraq 10.000000 MHz
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Move Marker Manually

Operation 1. Press > Select Marker[F1] and select a
marker number.

2. Use the left/right arrow keys to @
move the marker one grid division. @%@

3. Use the scroll wheel to move the
marker in fine increments.

4. Alternatively, the numeric keypad
in combination with the F1~ F7
keys can be used to directly enter
the frequency of the marker
position.

Move Marker to Preset Locations

Description The key is used to move the selected
marker to a number of preset positions.

Functions Mkr>Center:  Move to center frequency.
Mkr>Start: Move to start frequency.
Mkr>Stop: Move to stop frequency.
Mkr>CF Step: Move to step frequency.
Mkr>Ref Lvl:  Move to reference level
amplitude.

A Not When the key is used, the span and other
ote

settings may be automatically changed.
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Operation 1. Press > Select Marker[F1] and select a
marker number.

2. Press and select a marker position:

Mkr>Center[FT]
Mkr>Start [F2]
Mkr>Stop[F3]
Mkr>CF Step[F4]
Mhkr>Ref Lvi[F5]

Activate Delta Marker

Description Delta markers are marker pairs that measure
the difference in frequency/time and amplitude
between a reference marker and a delta marker.

When delta markers are activated, the reference
and delta marker appear at the position of the
selected marker, or in the center of the display
if the selected marker has not yet be activated.

The marker measurement is located at the top
of the display, under the “normal marker”

measurement.
Delta Markers Ref: Reference marker, designated as é.
Delta: Delta marker, designated as Avl.
Operation 1. Press > Select Marker[F1] and select a

marker number.
2. Press [F2] to turn the selected marker on.

3. Press Delta[F4]>Delta[F1] to set the selected
marker to the Delta type.
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Move Delta Marker(s)Manually

Move Delta or 1.

Reference Marker

Press > Delta[F4]> MoveRef[F2] to move

the reference marker.

. Press > Delta[F4]> MoveDelta[F3] to move
the Delta marker.

Move the selected marker in the same fashion
as a normal marker, see page 96

Move Both 1.

reference and
delta marker

Press either Move Pair Span[F4] or Move Pair
Center[F5] to move both markers at the same

time.

Move Pair Span:

Move Pair Center:

Sets the frequency span
between both markers.
The span can be positive
or negative:

1 Al
o&tspan> ©

Al 1
< &-span—2>©

Moves both markers at
the same time, keeping
the span between both
markers even
throughout.

2. Move both markers in the same fashion as a
normal marker, see page 96.
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Marker Functions

Marker Noise

Description The noise marker function calculates the
average noise level over a bandwidth of 1Hz,
referenced from the marker position.

Operation 1. Press (" )> Select Marker[F1] and select a
marker number.

2. Press [F2] to turn the selected marker on.

3. Press Normal[F3] and then position the marker
to the desired location.

4. Press Function[F5]>Marker Noise and turn
Marker Noise on.

5. The display will show the noise level
measurement at the top of the screen in

dBm/Hz.

Marker ID, Frequency, dBm/Hz

Marker

tart 5.000MHz 10.000MHz  15.000MHz
W 3 0kHz W:3.0kHz  Span:10.000MHz weop 442ms
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Frequency Counter

Description The frequency counter function is used to make
accurate frequency measurements.

Operation 1. Press > Select Marker[F1] and select a
marker number.

2. Press [F2] to turn the selected marker on.

3. Press Normal[F3] and then position the marker
to the desired location.

4. Press Function[F5]>Frequency Counter[F1] and
turn the counter function on.

5. Press Resolution[F2] and set the resolution:

Auto: Automatically chooses
the best resolution.

Man: Allows the resolution to
be manually set.

Man Range: 1Hz, 10Hz, 100Hz, 1kHz

6. The display will show the frequency
measurement at the top of the screen at the
selected resolution.

Frequency

21:57.37  2014.07,
e 1048/ MKCt 1 10.000 MHz 7.78 ) JdBm
of 17.000Bm __ Att 27.00dB
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Move Marker to Trace

Description The Marker Trace function moves the selected
marker to any of the currently active traces.

Operation 1. Press > Select Marker[F1] and select a
marker number.

2. Press [F2] to turn the selected marker on.

3. Press More[F7]>Marker Trace[F1] and choose a
trace to move the current marker to. Only active
traces can be selected.

AutofF1]

Tracel[F2Z]
TraceZ[F3]
Trace3[F4]
Trace4[F5]

4. In the example below, marker 1 is set to Tracel
and marker 2 is set to Trace2.

Marker 1, Trace 1

b.07:53  2014-.07-06 DX Marker
Wk 8.00 MHz - 43 45 dBm

1t 5.000MHz 10.000MHz P 15 000MHz
Sweep 17.91

W 100kHz w]pokiz  span:10.000MHz 7.9ms

Marker 2, Trace 2
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Show Markers in Table

Description The GSP-9330 has a Marker Table function to
show all the active markers and measurements
at once.

Operation 1. Press > More[F7]>Marker Table[F2] and

turn the marker table on.

2. The display will split into two screens. The
bottom half will show the Marker Table with
the marker ID(normal, reference or delta), trace,
x-axis position (frequency/time) and the
amplitude of the marker.

22:11:52  2014.07-06
Mk2

1048/ 8.00 MHz - 91.95 dBm/Hz

17.00dBm __ At 27.0048

T s 00N

00MHzZ

Marker Table
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Peak Search

Move Marker to Peak

Description The key is used to find trace peaks.
Operation 1. Press (™ )> Select Marker[F1] and select a

marker number.

2. Press >Peak Search[F1]. The marker will
move to the highest signal peak.

3. To continually search for the peak on each

sweep, press, >M0re [F7]>Peak Track[F1]
and set Peak Track to on.

Move Marker and Peak to Center

Description The Center function moves the marker to the
highest signal peak and moves the center
frequency to that peak. This function can be
used with the Next Peak, Next Peak Right, Next
Peak Left and Min Search peak functions, see the
Search for Peaks section on page 104 for details.

Operation 1. Press > Select Marker[F1] and select a
marker number.

2. Press >Mkr>Center[F2].

& The span will not be changed.
Note
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Search for Peaks

Description The key can be used to search for a
number of different peaks.

Peak Search Next Peak: Searches for next highest
peak visible on the display.

Next Peak Right:  Searches for the next peak to
the right of the marker.

Next Peak Left: Searches for the next peak to
the left of the marker.

Min Search: Searches for the lowest peak.
Operation 1. Press (" )> Select Marker[F1] and select a

marker number.

2. Press and select the type of peak you
wish to find.

Example:
Next Peak
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@]  Paak Search

Example: —_— T8 00 e 1668
Next Peak Right

Example:
Next Peak Left

tor - 10.000MHz Stop
Span-1.000MHz

v 10Hz

Peak Configuration

Description There are two peak search configuration
options: Peak Excursion and Peak Threshold.

Peak Excursion:  Peak Excursion sets the
minimum value above the
peak threshold for which
peaks will be detected.
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Peak Threshold:  Peak threshold sets the
minimum threshold level for
the analyzer to detect peaks.
Any value above the Peak
Threshold + Peak Excursion
will be detected as a peak.

Peak
Peak $ Excursion

Threshold

Operation

Peak Table

. Press >More [F7].

. Press Peak Excursion[F2] to set the excursion

level.

. Press Peak Threshold[F3] to set the peak

threshold.

Peak Excursion: 0~100dB

Peak Threshold: -120dB~+30dB

Description

The Peak Table function will display all peaks
(up to 10) that meet the peak configuration
settings. The amplitude and frequency for each
peak is listed.

Operation

106
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2. Press Peak Sort[F2] and set the sorting type:

Freq: Sort by frequency in
ascending order.
Amp: Sort by amplitude in

ascending order.
3. Press Peak Table[F1] to turn the peak table on.
4. The display splits in two. The bottom screen
shows the peak table with the peak marker ID,

X-axis position and amplitude.

Peak markers

81 Poak Search

000 Mz 18.70 dBm

706 000MHzZ
pan 1 000MHZ

Peak Table

& Note all that the markers for the Peak Table

Note function are all marked with “P” and are colored
purple so they can be distinguished from the other
markers.
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Display

The Display key configures the basic display settings as well as
setting up the display mode (spectrum, spectrographic,
topographic) and the split screen modes.

Adjusting the LCD Brightness

Description The LCD brightness levels can be adjusted to
three pre-set levels.

Operation 1. Press > LCD Brightness[F2] to toggle the
display brightness:
Hi: High brightness
Mid: Medium brightness
Lo: Low brightness

Turning the LCD Backlight Off

Description The LCD backlight can be turned off to
preserve power or to prolong the lifetime of the
LCD display when not in use.

Operation 1. Press > LCD Backlight[F3] and turn the
LCD backlight off.

2. When the backlight is off, press any function
key to turn the LCD backlight back on.
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Setting a Display Line (Reference Level Line)

Description The Display Line function is used to super-
impose a reference level line over the traces.

Operation 1. Press > Display Line[F4] to turn the
display line on.

2. Set the display line level and unit.

Examp|e‘ 23.27:01  2014.07-06

At 37.0048

Display line

10.000MHz p 15 000MHz
W:300Hz  Span:10.000MHz woop4.33s

DisplayLine:- 23.00 dBm

Display line set at -50dBm

Using the Video Out Port

Description The GSP-9330 has a dedicated DVI terminal to
output the display to an external monitor. The
video output is always on.

Output resolution 800 x 600 (fixed)

Operation 1. Connect an external monitor to the rear panel
DVI terminal.
Dbvi-1

00000000 opo
00000000 Sl
© Doooooog Bie ©
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Setting the Display Mode

Description The GSP-9330 has three different display modes
for viewing: spectrum, spectrograph and
topographic. It is also possible to view the
spectrum with the spectrographic or
topographic views using a split screen.

Spectrum Default display mode.

Spectrogram Useful for viewing
frequency or power in
the time domain.

Topographic Useful for observing the
frequency of events with
a trace.

Operation 1. Press >Window Setup[F1] and select the

display mode:

Spectrumf(Fl]:

Spectrogram(F3]:

Topographic[F4):

Spectrogram+SpectrumfF5]:
Topographic+Spectrum/[Fé]:

A The same trace is used on the top and bottom for
Note the Spectrogram+Spectrum and
Topographic+Spectrum modes.
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Example:
Spectrogram

The Spectrogram view shows signals in both
the frequency and time domain. The X-axis
represents frequency, the Y-axis represents time
and the color of each point represents the
amplitude at a particular frequency & time
(Red = high >dark blue = low).

Each new trace is shown at the bottom of the
display and older traces are pushed up toward
the top of the display until they are removed
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13:42119  2014-05-28

Topographic ool o :

0.00dBm At 10.048

1:79.100MHz enter 79, 595MHz Stop 80 090MHz
BW 10kHz W 10kHz pan 990.000kHz p.63.2ms Return

The topographic view shows the frequency of
events. The topographic view is useful for
observing smaller signals that have been
overpowered by stronger signals or to easily
observe intermittent events. Color is used to
represent the frequency of an event. Red
represents a high frequency of occurrence,
while blue represents events that occur rarely.

04.04:55 2014-03-2.

Spectrogram
+Spectrum

10dB/
-20.00dBm _Att

tart 999 950MHz
REW 1.0kHz

ter 1.000GHz top 1.000GHz
W 1.0kHz pan 100.000kHz eep-9.83ms

Displays both spectrographic and spectrum
views of the signal.

112



GYINSTEK BASIC OPERATION

13:44.00 2014-05-28

Topographic
+Spectrum

tart 79 100MHz
IW 10kHz

enter 79.595MHz top B0.090MHz
W 10kHz in 990.000kHz weep 63 2ms

Displays both topographic and spectrum views
of the signal.

Spectrogram and Topographic Markers

Description The Spectrogram and Topographic display
view can also use markers and delta markers to
mark the frequency and amplitude of points of
interest. This function is particularly useful as it
allows you to make delta measurements both in
the frequency and time domain.
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Operation
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1. When in the Topographic view (single or split

screen), press Topographic Marker and turn on.

. When in the Spectrographic view (single or

split screen), press Spectrogram Marker and turn
on.

. To set the reference marker, press Ref. [F2]>X

Axis[F1] and set x-axis position (frequency).

. Press Y Axis[F2] and the set the y-axis position

(amplitude).

*The frequency and amplitude information will be
displayed on the remaining function keys:

Frequency[F3] Marker frequency
Amplitude[F4] Marker Amplitude.
Time[F4] Time relative to the start

of the sweep.

. To set the delta marker, press Return[F7]

>Delta[F3]>X Axis[F1] and set the x-axis
position of the delta marker (frequency).

. Press Y Axis[F2] to set the y-axis position of the

delta marker (amplitude).

*The frequency and amplitude delta will be
displayed on the remaining function keys:

AFrequency[F3] Position of the delta
marker.

AAmplitude[F4] Amplitude of the delta
marker.

ATime[F4] Time delta

1/ATime[F5] Frequency delta
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Example Reference Marker

Ref. marker and Delta marker
positions/measurements

Spectrogram view is shown as an example.

Split Spectrum View

Description The split spectrum view is able to view two
different sweep ranges on the display at the
same time using a split screen view. The top
and bottom view can have independent sweep
ranges, amplitudes, spans and other settings.
However only one split screen (top or bottom)
can be swept each time.

Operation 1. Press (o= )>Window Setup[F1]>Split
Spectrum[F2]>Active Win[F1] to activate the
upper split screen.

2. Pressing Active Win.[F1] will toggle the sweep
between the upper and lower screen.

3. Press Alternate Sweep[F2] for the analyzer to
alternate the sweep between the upper and
lower screen at the end of each sweep.
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& No operations can be performed in alternate
Note sweep mode.

After exiting the split spectrum view, the analyzer
will use the settings from the active window. The
settings for the inactive screen will be retained for
the next time that split spectrum view is used.

. 234430  2014-07-06 T
Example: s ‘ R I ey

0.00dBm __At1 10.048

5 000MHz
100kHz

10.000MHz
100kHz 10.000!
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System Settings

System Information

Description The System Information displays the following:
Serial Number Installed Options
Version: Calibration Date:
Software LOI
Firmware RF
File sys TG
RF DNS Hostname
TG MAC Address
DSP LX| Password
Wordlist
Core
Operation . Press >System Information[F1] to bring up

Error Messages

a list of the system information.

Description

You can view error messages that are in the
error queue by message number, description
and time. All errors from the system error
queue are logged when operating the analyzer.
For a list of the error messages, please see the
programming manual.

Operation

. Press >Error message[F2] to bring up the

error message table.

. Press Prev Page[F2] and Next Page[F3] to

navigate through each page of the error list.

1z
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3. Press Clear Error Queue[F6] to clear the error
messages from the list.

Set the System Language

Description The GSP-9330 supports a number of languages.
The system language sets the soft menu keys to
the selected language.

Operation 1. Press >Language[F3] and choose the
system language.

Set the Date and Time

Operation 1. Press (9=m)>Date/Time[F4].

2. Press Set Date[F1] to set the date:

Year[F1] Sets the year.
Month[F2] Sets the month.
Day[F3] Sets the day.

3. Press Set Time[F2] to set the system time:

Hour[FT] Sets the hour (24hr).
Minute[F2] Sets the minute.
Second][F3] Sets the second.

4. The system time and date will be shown at the
top of the display.

Time, Date
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Display the Date and Time on the Screen

Description Enables or disables the date and time on the
screen.
Operation 1. Press >Date/T ime[F4]>Clock[F4] and turn

the clock display on or off.

Using the Wake-Up Clock

Description The GSP-9330 has a wake-up clock to allow the
spectrum analyzer to automatically turn on at a
set time.

Operation 1. Press >Date/T ime[F4]>Wake-Up Clock[F3]
and set the following parameters:

Select ClockfF1] Choose a wake-up clock
(1~7).

State[F2] Turns the selected clock
on/ off.

HourfF3] Set the wake-up hour

Minute[F4] Set the wake-up minute.

Repeat Single[F5] Set the wake-up clock to
repeat or single.

& Only single days can be configured for the wake-up

Note clock.
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Alarm Output

Description Allows the pass/fail output to be output via the
ALARM OUT port.

Output: Open collector
+V

B
Alarm Out

BNC

Vo

Operation 1. Press >Alarm Output[F6] and toggle the
ALARM OUT port on or off.
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Preset

The Preset function loads either factory default states or the user-
defined states - depending on the Preset configuration settings.

+Using the Preset Key — from page 121
*Save the User Preset Settings— from page 121
*Preset Type Settings— from page 122

+*Power on Preset Settings — from page 122

Using the Preset Key

Description The key loads the factory default state or
user-defined preset settings. See the Preset
Type Settings on page 121 to set the type of
preset settings that are loaded.

Factory Preset The factory default settings are listed on page
288.
Operation Press to load the preset settings.

Save the User Preset Settings

Description The user-defined preset settings can be created
by saving the current state as the user-defined
preset settings.

Operation Press >Pwr Ony/Preset[F5]>Save User
Preset[F3] to save the current state as the User
Preset settings.
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Preset Type Settings

Description Each time the key is pressed, a set of
preset configuration settings are loaded. The
preset configuration settings can be either the
factory default settings or the user-defined
settings.

Operation 1. Press >Pwr On/Preset[F5]>Preset Type[2]
and choose the preset type:

User Preset[F1]
Factory Preset[F2]

Power on Preset Settings

Description When the spectrum analyzer is turned on,
either the preset configuration settings are
loaded (default) or the configuration settings
that were used before the instrument was
turned off.

Operation 1. Press >Pwr On/Preset[F5]>Power On[F1]
and choose the power on settings:

Power On: Last, Preset

A See Preset Type Settings on page 288 for details on
Note the diti
preset conditions.

The last preset conditions cannot be loaded if the
instrument was not powered down correctly the
last time it was used. Please see page 29 for
details.
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ADVANCED OPERATION

AM/EM ANALYSIS cevrveeerieieeeireieiieeiseise et ssseese et ss sttt saseen
AM Analysis .....ccocvenee
AM Pass Fail Testing...
FM Analysis.....cccocceueenee
FM Pass Fail TSN ....ccuvvuurieciriiriciricisiiriisieseiesiesssessseessessees
AM/TM DemMOAUIATION «.evrvreeeeeeeeeeeeeeeeeeeeeeeeeee et eeeeeeeeeeeeeeeeeseeens
ASK Measurement
ASK Pass Fail TeSting ..o
FSK MEASUIEMENL «.cuuviuiiiiiiiiiiiiii i
FSK Pass Fail Testing..
2FSK Measurement...................
2FSK Pass Fail Testing ...
Phase Jitter MEaSULEMENT ....c.cucuevieiieiiieiceeireieiee et
Spectrum Emission Mask OVEIVIEW ...
Spectrum Emission Mask Testing
Third Order Intermodulation Distortion (TOI)
CNR/CSO/CTB MEASULCINCNL «.evieeeeeieteeeeeeeeerererererereeessssssssssssssssssssesesesesens
Carrier to Noise Ratio (CNR)........
Composite Second Order (CSO)..
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Harmonic MeasULEMENLS. ....c.cuvuuiueuiemiieiieeiieieie et sseaeseas
N dB BandWidth ....ccccueiiiiiiieieeccrcircieeeee e eesessesessenenns
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EMS TEST vuevuerureerrerunrserieesessenstie s sasese s i sa s ssssase s ssss e ssesassssesssssnessessosen 221
Limit Line Testing ......ccoveviiiiiniiiiiniiiiiniin e 223
Creating a Limit (Point by Point) ... 223
Creating a Limit (from Trace Data) ..o 225
Creating a Limit (from marker data) ........c.ccovveiiiiiicniniins 226

Delete Limit Line
Pass Fail Testing

SEQUENCE ...ttt ee st sa st sa st saaees 230
Editing @ SEQUENCE .....cucuuienieicicicirci e 230
Running a SEqUeNnCe ... 234
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Measurement

This section describes how to use the automatic measurement
modes. The GSP-9330 includes the following measurements:

*ACPR — from page 127

*OCBW — from page 130

*AM Analysis— from page 132

*FM Analysis — from page 138

*AM/FM Demodulation — from page 143
*ASK Measurement — from page 144
+*FSK Measurement — from page 151
+*2FSK Measurement — from page 159
*Phase Jitter— page 163

*SEM measurement — from page 165

*TOI measurement — from page 184
*CNR/CSO/CTB measurement — from page 186
+*Harmonic Measurement — from page 193
*N dB measurement — from page 196

*P1dB Measurement — from page 198

Channel Analysis Overview

Description Channel analysis measurement includes ACPR
(adjacent channel power) and OCBW (occupied
bandwidth) measurements.
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Parameters

126

Channel bandwidth

Channel Space

Adjacent channel
bandwidth 1 & 2

Adjacent channel offset
1~3

OCBW%

The frequency
bandwidth the target
channel occupies.
Range:

Between 0Hz~3.25GHz
(OHz excepted)

The frequency distance
between each main
channel.

Range:

Between 0Hz~3.25GHz

The frequency
bandwidth the adjacent
channels occupy.
Range:

Between 0Hz~3.25GHz
(OHz excepted)

The frequency distance
between the adjacent
channels and main
channel.

Range: 1

Between 0Hz~3.25GHz
(OHz excepted)

The ratio of occupied
bandwidth to the
amount of power
consumed.

Range: 0% to 100%, 0.1%
resolution.
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ACPR

Description Adjacent channel power refers to the amount of
power leaked to the adjacent channel from the
main channel. This measurement is a ratio of
the main channel power to power in the
adjacent channel.

Example

AD) ADJ AD)
CH3 CH2 CH1 [ CHBW | CH1 CH2 CH3

Offset 1Tk— |
Offset 2k——i
Offset 3
Channel spacing

To next main
channel

Operation: 1. Press > Channel Analysis[F1]>ACPR[F2]
Setting up the and turn ACPR on.

main channel *Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
screen shows the main channel, adjacent
channels and their corresponding limits. The
bottom screen shows the ACPR measurement
results in real time.
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Main CH

ADJCHI1
ADJCH2
ADJCH3

Channel power
results

. Press > Channel Analysis[F1]>ACPR

Setup[F1]> and set the following;

Main CHBW[FI1]
Main CH H Limit[FZ]
Main CH Limit{F3]

CH SPCIF4]

Set the bandwidth of the
main channel.

Set the low limit for the
main channel.

Set the high limit for the
main channel

Specify the channel
spacing

Operation:
Setting up the
adjacent
channel(s)

128

channels:
Select AdjCh[F1]
[F2]

ADJCHBW]F3]

. Press ADJCH Setup[F5] to setup the adjacent

Choose an adjacent
channel number: 1, 2, 3
Toggle the selected
channel on/ off.

Choose the bandwidth of
the selected channel.
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ADJCH Offset{F4] Set the adjacent channel

offset.

ADJCH HLimit[F5] Set the adjacent channel
high limit.

ADJCH LLimit[F5] Set the adjacent channel
low limit.

2. Repeat the above steps for the other adjacent
channels, if needed.

Move Channels 1. Press (M)> Channel Analysis[F1] and press
Up/Down the following to move to another channel:

Channel Move Up[F5] Next main channel.
Channel Move Previous main channel.
Down[F6]

& The channel space (CH SPC) parameter
Note determines where the next main channel is
located.

Remove 1. Press > Channel Analysis[F1]>ACPR
Definitions Help Setup[F1]>Def. Help to toggle the Definitions
Help on or off.
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OCBW
Description Occupied bandwidth measurements are used to
measure the power of the occupied channel as a
percentage to the power of the channel.
Example
CBW,
CHBW
Operation: 1. Press > Channel Analysis[F1]>OCBW[F4]
Setting up the and turn OCBW on.
main channel *Any other measurement mode will automatically be

disabled.

2. The display splits into two screens. The top
shows the channel bandwidth. The bottom
screen shows the OCBW measurement results
in real time.
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77T 6. 000MHz
W 1 0kHz

Channel power and total
power results

3. Press OCBW Setup[F3] to enter the OCBW

setup:

CHBWJFI] Set the channel
bandwidth.

CH SPCIFZ] Set the channel space
between main channels.

OCBW%[F3] Set the % of the OCBW
to CHBW.

Move Channels 1. Press > Channel Analysis[F1] and select:
Up/Down

Channel Move Up[F5] Next main channel.

Channel Move Previous main channel.
Down[F6]

& The channel space (CH SPC) parameter
Note determines where the next main channel is
located.

The CH SPC parameters from the ACPR and
OCBW setups are independent.
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AM/FM Analysis

AM Analysis

Description When amplitude modulation is turned on, the
input signal is centered on the center frequency
and the span is automatically set to zero-span.

Measurement AM Depth: Current, Min, Cent, Max

items Mod. Rate: Current, Min, Cent, Max
Carrier Pwr: Current, Min, Cent, Max
Carrier Freq Offset: Current, Min, Cent, Max
SINAD: Current, Min, Cent, Max

Operation: 1. Set the center frequency to the carrier frequency

configuration (page 41).

2. Press (M= )> Demod[F2]>AM Analysis[F1]>AM
Analysis[F1] and turn AM analysis on.
*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the AM waveform in the time domain.
The bottom screen shows the AM
measurement.
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AM waveform

AM modulation
measurements

4. Press Setup[F2]>IF Bandwidth[F1] and set the
Intermediate frequency bandwidth.
+Set with adequate bandwidth to accommodate
spectrum contained in the carrier.

5. Press LPF[F2] to set the low pass filter
frequency, alternatively the frequency can be
set to bypass:

/AM Signal Frequency (Hz)

Selectable bandwidth of LPF (Hz)
>78,125 156,250 78,125 52,083 39,063 31,250
>39,063 78,125 39,063 26,042 19,531 15,625
>19,531 39,063 19,531 13,021 9,766 7,813
>7,813 15,625 7,813 5208 3,906 3,125
>3906 7,813 3,906 2,604 1,953 1,563
>1,953 3,906 1,953 1,302 977 781
>781 1,563 781 521 391 313
>391 781 391 260 195 156
>195 391 195 130 98 78
>78 156 78 52 39 31
>39 78 39 26 20 16
>20 39 20 13 10 8

>8 16 8 5 4 3
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6. Press Time Axis [F3] to set horizontal axis

parameters:
Ref Value[F1]

Ref. Pos[F2]

Scale/Div[F3]

Auto Scale[F4]

Sets the starting time on
the time axis.

Shifts the waveform X
number of grid
subdivisions.

Sets the grid division
scale when Auto Scale is
Off.

Toggles auto-scaling
on/ off.

7. Press Depth Axis[F4] to set depth (vertical)

parameters:

Ref Value[F1]

Ref Pos[F2]

Scale/Div[F3]

Auto Scale[F4]

Offsets the reference
position as a percentage
of the vertical scale/div.
Sets the reference
position of the waveform
on a vertical grid
subdivision (1:10).

Sets the vertical grid
division scale when
Auto Scale is Off.
Toggles auto-scaling
execution.

Press Squelch[F6] to set carrier squelch level.

The squelch setting will suppress unwanted

noise of a certain level.
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Operation: 9. Press AF Trigger[F5]>Trigger Setup[F2] to set the
trigger triggering conditions:
configuration
Edge Slope[FT] Sets the trigger to rising
or falling edge.
Trigger Mode[FZ] Sets the triggering mode:

Nor.: Normal trigger
Sgl.: Single trigger
Cont.: Continuously
trigger

Trigger Level[F3] Sets the trigger level as a
percentage of the depth.
(The displayed level will
only remain for a few
moments)

Trigger Delay[F4] Sets the trigger delay
time:
0 to 1ks

10. Press Return[F7] to return to the AF Trigger
menu and to set the remaining trigger options:

FreeRunfF1] Disables the trigger, this
is the default setting.
Start Time[F3] Sets the start time for the

x-axis for the AM
waveform in the top-half
of the screen.

Stop Time[F4] Sets the stop time for the
x-axis for the AM
waveform in the top-half
of the screen.

Action Now[F5] Turns FreeRun mode off
and uses the user-
defined trigger settings.
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A The MAX and MIN measurements are held until
Note higher or lower values are found. To reset the MAX

and MIN measurements, press >

Demod[F2]>AM Analysis[F1]>Min/Max Reset[F3].

AM Pass Fail Testing

Description The Limit Edit function puts a pass limit on the
AM depth, carrier offset and carrier power.

Measurement AM Depth: 5% ~95%
Range Carr. Offset: 1Hz ~ 400kHz

Carrier Power: -120dBm ~ 30dBm
Operation: 1. Press > Demod[F2]>AM Analysis[F1]>
configuration Limit Edit[F5] and set the limits.

AM Depth[Fi] If the measured depth is
above this limit, it will be
judged as Fail.

Carr. OffsetfF2] If the measured carrier
offset is above this limit,
it will be judged as Fail.

Carr. Power[F3] If the measured carrier
power is above this limit,
it will be judged as Fail.

2. Press Pass/Fail Test and turn Pass/Fail on.
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3. The AM Measurement area in the bottom half
of the screen will now include Pass/Fail
indicators for the AM depth, carrier offset and
carrier power.

Pass: @' Fail: ﬁ

EXampIe X 10:23:46  2016-01-14

315 000MHz

Pass/Fail
judgments
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FM Analysis

Description When frequency modulation is turned on, the
input signal is centered on the carrier frequency
and the span is automatically set to zero-span.

Measurement Freq. Deviation: Current, Min, Cent, Max

items Mod. Rate: Current, Min, Cent, Max
Carrier Pwr: Current, Min, Cent, Max
Carrier Freq Offset: Current, Min, Cent, Max
SINAD: Current, Min, Cent, Max

Operation: 1. Set the center frequency to the carrier frequency

configuration (page 41).

2. Press (M )> Demod[F2]>FM Analysis[F2]>FM
Analysis[F1] and turn FM analysis on.

*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the FM waveform in the time domain.
The bottom screen shows the FM measurement.

FM waveform

FM modulation
measurements
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4. Press Setup[F2]>IF Bandwidth[F1] and set the
Intermediate frequency bandwidth. (10kHz,
30kHz, 100kHz, 300kHz, 1MHz, )

«Set with adequate bandwidth to accommodate

spectrum contained in the carrier.

5. Press LPF[F2] to set the low pass filter
frequency, alternatively the frequency can be
set to bypass:

FM Signal Frequency (Hz)

Selectable bandwidth of LPF (Hz)
>78,125 156,250 78,125 52,083 39,063 31,250
>39,063 78,125 39,063 26,042 19,531 15,625
>19,531 39,063 19,531 13,021 9,766 7,813
>7,813 15,625 7,813 5208 3,906 3,125
>3906 7,813 3,906 2,604 1,953 1,563
>1,953 3,906 1,953 1,302 977 781
>781 1,563 781 521 391 313
>391 781 391 260 195 156
>195 391 195 130 98 78
>78 156 78 52 39 31
>39 78 39 26 20 16
>20 39 20 13 10 8

>8 16 8 5 4 3

6. Press Time Axis[F3] to set horizontal axis

parameters:

Ref. Value[F1] Sets the starting time on
the time axis.

Ref. Pos[F2] Shifts the waveform X
number of grid
subdivisions.

Scale/Div[F3] Sets the grid division
scale when Auto Scale is
Off.
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Auto Scale[F4] Toggles auto-scaling
on/ off.

7. Press Deviation Axis[F4] to set deviation
(vertical) parameters:

Ref Value[F1] Offsets the reference
position (in frequency).
Ref.Pos[F2] Sets the reference

position of the waveform
on a vertical grid
subdivision (1:10).

Scale/Div[F3] Sets the vertical grid
division scale.
Auto Scale[F4] Toggles auto-scaling
execution.
Operation: 8. Press AF Trigger[F5]>Trigger Setup[F2] to set the
trigger triggering conditions:
configuration Edge Slope[F1] Sets the trigger to rising
or falling edge.
Trigger Mode[F2] Sets the triggering mode:

Norm.: Normal trigger
Sgl.: Single trigger
Cont.: Continuously
trigger

Trigger Level[F3] Sets the trigger level as a
frequency. (The
displayed level will only
remain for a few
moments)

Trigger Delay[F4] Sets the trigger delay
time:
0 to 1ks

9. Press Return[F7] to return to the AF Trigger
menu and set the remaining triggering options:
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FreeRunfFi1]

Start Time[F3]

Stop Time[F4]

Action NowfF5]

ADVANCED OPERATION

Disables the trigger, this
is the default setting.
Sets the start time for the
x-axis for the FM
waveform in the top-half
of the screen.

Sets the stop time for the
x-axis for the FM
waveform in the top-half
of the screen.

Turns FreeRun mode off
and uses the user-
defined trigger settings.

& Note

The MAX and MIN measurements are held until
higher or lower values are found. To reset the MAX
and MIN measurements, press >
Demod]F2]>FM Analysis[F1]>Min/Max Reset{F3].

FM Pass Fail Testing

Description The Limit Edit function puts a pass limit on the

FM deviation, carrier offset and carrier power.
Measurement Frequency Deviation:  40Hz ~ 400kHz, 1Hz
Range measurable

Carr. Offset: 1Hz ~ 400kHz

Carrier Power: -120dBm ~ 30dBm
Operation: . Press (Mes=ve)> Demod[F2]>FM

configuration

Analysis[F2]>Limit Edit[F5] and set the limits.

FM Deviation[FT]

If the measured
deviation is above this
limit, it will be judged as
Fail.
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Carr. Offset{F2] If the measured carrier
offset is above this limit,
it will be judged as Fail.

Carr. Power[F3] If the measured carrier
power is above this limit,
it will be judged as Fail.

2. Press Pass/Fail Test[F6] and turn Pass/Fail on.

3. The FM Measurement area in the bottom half of
the screen will now include Pass/Fail indicators
for the FM deviaton, carrier offset and carrier
power.

Pass: @ Fail: ﬁ

10:23:34  2016-01-14

Example

Al 10.08

e 315 000MHZ

Pass/Fail
judgments
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AM/FM Demodulation

Description The GSP-9330 has a convenient AM/FM
demodulation function to tune into AM or FM
broadcast signals and listen to the demodulated
baseband signals using the ear phone out

socket.
Operation: 1. Set the center frequency to the desired FM/AM
Setup carrier frequency. See page 41 for details.

2. Set the span to zero. See page 46 for details.
3. Set the Preamp to Auto. See page 62.

4. Connect an antenna to the RF input.

Connection Connect headphones or a speaker
to the phone output port.

Operation 1. Press > Demod[F2]>Sound[F3]>Ear Phone
Out[F1] and turn the ear phone out on.

2. Press Volume[F2] to set the volume output:
Volume: 0~15, default 7

3. Press Digital Gain Control[F3] to change the
gain:

Gain: 0~18dB, 6dB step

4. Press Demod Type[F4] to choose AM or FM
demodulation.
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ASK Measurement

Description The ASK function can be used to analyze ASK
signals. It can either display the demodulated
waveform or the symbols encoded in the signal.
Manchester or Miller line codes can also be

decoded.
Measurement AM Depth: Current, Min, Cent, Max
items Mod. Rate: Current, Min, Cent, Max
Carrier Pwr: Current, Min, Cent, Max
Carrier Freq Offset: Current, Min, Cent, Max
SINAD: Current, Min, Cent, Max
Operation: 1. Set the center frequency to the carrier frequency
configuration (page 41).

2. Press (wwe)> Demod[F2]>ASK[F4]>ASK
Analysis[F1] and turn ASK Analysis on.

*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the ASK waveform in the wave view
(time domain waveform) or the symbol view.
The bottom screen shows the ASK
measurements and Pass/Fail test results.
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Wave view

102316

. A:10.0d8

Tar 315 000MHzZ

ASK measurements

4. Press Bit Rate[F2] and set the Bit rate of the ASK
signal.

Display View 5. To toggle the top half of the screen between the
Symbol view or Wave view, press
More[F6]>View[1]>Symbol[F1] or
More[F6]>View[1]>Waveform[F2].

6. If the View is set to Waveform, press
Axis[F4]>Time Axis [F1] to set the horizontal
axis parameters:

Ref. Value[F1] Sets the starting time on
the time axis.

Ref. Pos[F2] Shifts the waveform X
number of grid
subdivisions.

Scale/DivfF3] Sets the grid division
scale when Auto Scale is
Off.
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7. Press Depth Axis[F2] to set depth (vertical)
parameters:

Ref Value[F1] Offsets the reference
position as a percentage
of the vertical scale/div.

Ref.Pos[F2] Sets the reference
position of the waveform
on a vertical grid
subdivision (1:10).

Scale/Div[F3] Sets the vertical grid
division scale when
Auto Scale is Off.

Auto Scale[F4] Toggles auto-scaling
execution.

Configuration: 8. Press Preamble/Sync[F5] if any preamble or sync
Preamble/Sync bits or words are configured:

Preamble/Sync[FT] Toggle to On to activate

the preamble/sync
function.
Preamble Bits[F2] Enter the number of
preamble bits as integer:
0to 16
Sync Bits[F3] Enter the number of sync
bits as integer: 0 to 16
Sync Words[F4] Enter the sync word in
hexadecimal: 0000 to
FFFF
Operation: 9. Press More[F6]>Trigger[F2]> to set the
AF trigger AF(ASK/FSK) triggering conditions:
configuration
Free RunfFT] Disables the trigger, this

is the default setting.
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Trigger Condition{F2]>
RF Trigger[FI]

Trigger Condition[F2]>
Ext Edge[F2]

Trigger Condition{F2]>
Video Edge[F3]

Trigger Mode[F3]

Trigger Delay[F4]>

Action Now[F5]

Trigger Setup[F6]

Trigger Setup[F6]>Start
Bits

Sets the RF trigger level:
-80 to +16dBm

Sets the external trigger
slope:
Pos, Neg.

Sets the video trigger
slope:
Off, Pos, Neg.

Sets the triggering mode:
Norm.: Normal trigger
Sgl.: Single trigger

Cont.: Continuously
trigger

Sets the trigger delay
time:
0 to 1ks

Turns FreeRun mode off
and uses the user-
defined AF Trigger
settings.

Press Action Now[F5] to
manually trigger.

When the Single trigger
mode succeeds, this
menu will be available.

Enter the position of the
start bit as integer: 0 to
400.

Trigger Setup[F6]> Stop Enter the position of the

Bits

stop bit as integer: 0 to
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400.
A The trigger icon will be replaced with
Note the AF trigger when the AF trigger is

used:

Symbol setup 10. Press View[F1]>Symbol Setup[F3]>Decoding[F1]
to set the line decoding method. The decoded
data can be seen when in the Symbol or
Waveform View:

None[FT] No line decoding of
data.

Miller[F2] Miller decoding (aka.
Delayed Encoding).

Manchester Manchester encoding

Encoding[F3] (aka. Phase Encoding).

D_Manchester D_Manchester encoding

EncodingfF4] (aka. Phase Encoding).

Bi-Phase[F5] Bi-Phase Encoding (aka.
Phase Encoding)

A Miller Encoding Definition:
Note

Miller encoding will encode a “1” as a phase
transition in the middle of a data period. A “0” is
encoded the same as the previous bit. This means
that only a “1” causes the data to transition from

high or low.
Example: Data period
1 <>
Original data
0
Miller H
encoded data L |_J
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Manchester Encoding Definition:

Manchester encoding encodes a “1” or “0” on
each transition in a data period. The Manchester
definition used for the GSP-9330 uses a low to high
transition to indicate “0”, and a high to low
transition to indicate “1”.

Example: Data period

Original data

Manchester H
encoded data L

11. Press View[F1]>Symbol Setup[F3]>Decode
invert[F2] to invert decode of decoding.

12. Press View[F1]>Symbol Setup[F3]>Format[F3] to
set the format for the decoded data (Binary or
Hexadecimal).

ASK Pass Fail Testing

Description The Limit function puts a pass limit on the AM
depth, carrier offset and carrier power.

Measurement AM Depth: 5% ~95%
Range Carr. Offset: 1Hz ~ 400kHz
Carrier Power: -120dBm ~ 30dBm
Operation: 1. Press (Meswe)>Demod[F2]>ASK[F4]>
configuration More[F6]>Limit Edit[F4] and set the limits.
AM Depth[F1] If the measured depth is
above this limit, it will be
judged as Fail.
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Carr. OffsetfF2] If the measured carrier
offset is above this limit,
it will be judged as Fail.

Carr. Power[F3] If the measured carrier
power is above this limit,
it will be judged as Fail.

Compare ValuesfF4] ~ Compare the input value

Compare NumberfF5] Number of consecutive
comparison

2. Press Return[F7] to return to the previous
menu.

3. Press Pass/Fail Test[F5] to toggle the pass/fail
testing on.

4. The ASK Measurement area in the bottom half
of the screen will now include Pass/Fail
indicators for the AM depth, carrier offset and
carrier power.

Pass: @ Fail: ﬁ

10.19:09  2016-01-14

Example

Alt 10.0d8

315 000MHz

Pass/Fail
judgments
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FSK Measurement

Description

The FSK function can be used to analyze FSK
signals. It can either display the demodulated
waveform or the symbols encoded in the signal.

Manchester or Miller line codes can also be
decoded.

Measurement
items

Freq Deviation: Current, Min, Cent, Max
Mod. Rate: Current, Min, Cent, Max
Carrier Pwr: Current, Min, Cent, Max
Carrier Freq Offset: Current, Min, Cent, Max
SINAD: Current, Min, Cent, Max

Operation:
configuration

1. Set the center frequency to the carrier frequency
(page 41).

2. Press (Mesue)> Demod[F2]>FSK[F5]>FSK
Analysis[F1] and turn FSK analysis on.

*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the demodulated FSK waveform in the
wave view (time domain waveform) or the
symbol view. The bottom screen shows the
FSK-specific measurements and pass/fail
results.
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Wave view

Tor 315.000MHz

FSK demodulation
measurements

4. Press Bit Rate[F2] and set the Bit rate of the FSK
signal.

IF Bandwidth 5. Press IF Bandwidth[F3] to set the frequency
deviation band for the FSK signal:

IF Bandwidth{FT] 10kHz, 30kHz, 100kHz,
300kHz, IMHz.

Display View 6. To toggle the top half of the screen between the
Symbol view or Wave view, press
More[F6]>View[F1]>Symbol[F1] or
More[F6]>View[F1]>Waveform[F2].
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7. If the View is set to Waveform, press
Axis[F4]>Time Axis[F1] to set the horizontal axis

parameters:

Ref Value[F1] Sets the starting time on
the time axis.

Ref. Pos[F2] Shifts the waveform X
number of grid
subdivisions.

Scale/DivfF3] Sets the grid division
scale when Auto Scale is
Off.

8. Press Deviation Axis[F2] to set deviation
(vertical) parameters:

Ref Value[F1] Offsets the reference
position (in frequency).
Ref Pos[F2] Sets the reference

position of the waveform
on a vertical grid
subdivision (1:10).

Scale/Div[F3] Sets the vertical grid
division scale when
Auto Scale is Off.

Auto Scale[F4] Toggles auto-scaling
execution.

Configuration: 9. Press Preamble/Sync[F5] if any preamble or sync
Preamble/Sync bits or words are configured:

Preamble/Sync[F1] Toggle to On to activate
the preamble/sync
function.

Preamble Bits[F2] Enter the number of
preamble bits as integer:
Oto16
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Sync Bits[F3] Enter the number of sync
bits as integer: 0 to 16
Sync Words[F4] Enter the sync word in
hexadecimal: 0000 to
FFFF
Operation: 10. Press More[F6]>Trigger[F2] to set the AF
AF trigger (ASK/FSK) triggering conditions:
configuration
Free RunfFT] Disables the trigger, this

is the default setting.

Trigger Condiition[F2]> Sets the RF trigger level:
RF Trigger(F1] -80 to +16dBm

Trigger Condiition[F2]> Sets the external trigger

Ext. Edge[F2] slope:
Pos, Neg.
Trigger Condition{FZ]> Sets the video trigger
Video Edge[F3] slope:
Off, Pos, Neg.
Trigger Mode[F3] Sets the triggering mode:

Norm.: Normal trigger
Sgl.: Single trigger
Cont.: Continuously
trigger

Trigger Delay[F4] Sets the trigger delay
time:
0 to 1ks

Action NowfF5] Turns FreeRun mode off
and uses the user-
defined AF trigger
settings.
Press Action Now[F5] to
manually trigger.

Trigger Setup[F6] When the Single trigger
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& Note

mode succeeds, this
menu will be available.

Trigger Setup[F6]>Start Enter the position of the
Bits start bit as integer: 0 to
400.

Trigger Setup[F6]> Stop Enter the position of the
Bits stop bit as integer: 0 to
400.

Trigger

The trigger icon will be replaced with =
the AF trigger when the AF trigger is |Gl
used: AF

Symbol setup 11.

Press View[F1]>Symbol Setup[F3]>Decoding[F1]
to set the line decoding method. The decoded
data can be seen when in the Symbol or
Waveform View:

None[F1] No line decoding of
data.
MillerfF2] Miller decoding (aka.
Delayed Encoding).
Manchester Manchester encoding
Encoding[F3] (aka. Phase Encoding).
D_Manchester D_Manchester encoding
Encoding[F4] (aka. Phase Encoding).
Bi-Phase[F5] Bi-Phase Encoding (aka.
Phase Encoding)

& Note

Miller Encoding Definition:

Miller encoding will encode a “1” as a phase
transition in the middle of a data period. A “0” is
encoded the same as the previous bit. This means
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that only a “1” causes the data to transition from

high or low.
Example: Data period
1 d |
Original data
0
Miller H
encoded data L

Manchester Encoding Definition:

Manchester encoding encodes a “1” or “0” on
each transition in a data period. The Manchester
definition used for the GSP-9330 uses a low to high
transition to indicate “0”, and a high to low
transition to indicate “1”.

Example: Data period
< | ‘ ‘

1
Original data
0

Manchester H
encoded data L

12. Press View[F1]>Symbol Setup[F3]>Decode
invert[F2] to invert decode of decoding.

13. Press View[F1]>Symbol Setup[F3]>Format[F3] to
set the format for the decoded data (Binary or
Hexadecimal).

FSK Pass Fail Testing

Description The Limit Edit function puts a pass limit on the
FSK frequency deviation, carrier offset and
carrier power.

Measurement Freq. Deviation: 40Hz ~ 400kHz, 1Hz
Range measurable
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Carr. Offset:
Carrier Power:

1Hz ~ 400kHz
-120dBm ~ 30dBm

Operation:
configuration

. Press (Weswe)> Demod[F2]>FSK[F5]>More[F6]>

Limit Edit[F4] and set the limits.

Freq. Deviation[F1]

Carr. OffsetfF2]

Carr. Power[F3]

Compare Values[F4]

Compare Number[F5]

menu.

testing on.

If the measured
deviation is above this
limit, it will be judged as
Fail.

If the measured carrier
offset is above this limit,
it will be judged as Fail.
If the measured carrier
power is above this limit,
it will be judged as Fail.

Compare the input value

Number of consecutive
comparison

. Press Return[F7] to return to the previous

. Press Pass/Fail Test[F5] to toggle the pass/fail
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4. The FSK Measurement area in the bottom half
of the screen will now include Pass/Fail
indicators for the frequency deviation, carrier
offset and carrier power.

Pass: @ Fail: ﬁ

Examp|e = 10:52.38  2016-01-14

5.00kHz A1 10.048

315.000MHz

Pass/Fail indicators
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2FSK Measurement

Description

2FSK is a binary FSK (frequency shift keying)
form of modulation. 2FSK is commonly used to
transmit data where an FSK modulated signal
is composed of two different frequencies, one
frequency represents the “1” data and the other
frequency represents the “0” data.

For 2FSK measurement 2 traces will be created,
one trace will show the 2FSK spectrum (trace 1,
yellow) and the other trace (trace 2, purple) will
show a MAX HOLD trace type with peak

markers at the FSK carrier and hop frequencies.

Measurement
items

Peak 1, Peak 2: frequency, amplitude
Frequency Deviation:  hertz

Carrier Offset: frequency

Carrier Freq Offset: frequency

Peak Threshold: dBm

Max Hold: dBm

Example

Peak threshold limit

Max Hold limit
Max Hold trace
2FSK trace

Freq.1  Freq.2

Operation

2.

Set the frequency span to cover the 2FSK carrier
and hop frequency. See page 41 for details.

Press (Messue )> 2FSK[F3]>2FSK[F1] and turn
2FSK on.

*Any other measurement mode will automatically be
disabled.
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3. The display splits into two screens. The top
shows the trace with peak markers for the first
and second FSK frequencies (carrier and hop
frequency). The bottom screen shows the 2FSK
measurement results in real time.

Peak 1, Peak 2

Start 8 000MHZ Ston 11 000MHz
W 30kHz Sweep 1.63ms

et 8. 500MHz
BW 10kHZ  Span 3.000MHZ

2FSK measurement

4. To set the peak threshold line, press Peak
Threshold:

Threshold range: -120dBm ~ 30.0 dBm
5. To set max hold limit, press Max Hold:

Max Hold range: -130dBm ~ 30.0 dBm

A For more information about Peak Threshold and
Note Max Hold parameters, please see the Trace chapter
on page &1.
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Description The Limit Edit function puts a pass limit on the
frequency deviation and carrier power and a
high/low limit on the amplitude of each peak.

Measurement Freq. Deviation: 1Hz ~ 400kHz

Range Carr. Offset: 1Hz ~ 400kHz
High Limit: -120dBm ~ 30dBm
Low Limit: -120dBm ~ 30dBm

Operation: . Press (Wesw)> OFSK[F3]>Limit Edit[F5] and set

configuration

the limits.

Freq. Deviation[F1]

Carr. Offset{F2]

High Limit[F4]

Low Limit[F5]

If the measured
deviation is above this
limit, it will be judged as
Fail.

If the measured carrier
offset is above this limit,
it will be judged as Fail.
If the amplitude for one
of the peaks is above the
high limit, it will be
judged as Fail.

If the amplitude for one
of the peaks is below the
low limit, it will be
judged as Fail.

2. Press Pass/Fail Test[F6] and turn Pass/Fail on.
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3. The 2FSK area in the bottom half of the screen
will now include Pass/Fail indicators for the
frequency depth, carrier offset, high limit and
low limit.

Pass: Q Fail: ﬁ

Example 15:34:29  2014-08-29

ale 10dB/
e ams00e 2 %

Savel 1 450 dBm

Pass/Fail
judgments

162



GYINSTEK

ADVANCED OPERATION

Phase )itter Measurement

Description Phase Jitter refers to the amount of phase
fluctuation and can be used to evaluate stability
of a signal in the time domain.

Parameters Start Offset: The start frequency with
respect to the center
frequency.

Stop Offset: The stop frequency with
respect to the center
frequency.

Measurement Carrier Power: dBm

items Jitter in phase: rad
Jitter in time: ns

Example

Start Offset>
Stop Offset&——>
Operation: 1. Press > Phase [itter[F4]>Phase [itter[F1]

Setting up the
main channel

and turn Phase Jitter on.

+Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows the trace with the start and stop offsets.
The bottom screen shows the phase jitter
measurements.

163



GUYINSTEK GSP-9330 User Manual

Start Stop
offset offset

5 000MHz.
W 1MHz W

Phase jitter measurements

3. Press Start Offset[F2] to set the start offset:
Offset: (OHz ~ %2 span freq)
4. Press Stop Offset[F3] to set the stop offset:

Offset: (OHz ~ %2 span freq)

A The phase jitter measurements are strongly tied to
Note the RBW and VBW.
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Spectrum Emission Mask Overview

Description SEM measurements are used to measure the
out-of-channel emissions relative to the in-
channel power. SEM measurements are usually
calculated for specified power bands at a
number of different offsets to the carrier
frequency. SEM measurements are often carried
out for a number of different wireless
standards.

For 3GPP, the GSP-9330 supports BS (base
station) and UE (user equipment) testing
standards for both FDD (frequency-division
duplexing) and TDD (time-division duplexing)
modes.

The GSP-9330 also supports SEM testing for
802.11b, 802.11g, 802.11n and 802.16 as well as
user defined emission mask testing

Example e

Relative maskj’_’/
Absolute mask Chan

an

Channel integrated BW
Offset1 — &
Offset 2 - &
Offset 3 — K

Parameters ChanlintegBW: Channel Integration
Bandwidth. The
ChanlntegBW is used to
measure the in-channel
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power.

Chan Span:

Used to define the span of
the main channel when
measuring the channel
power.

RBW:

Sets the resolution
bandwidth for the main
channel when measuring the
in-channel power.

Total Pwr Ref:

The total power of the carrier
that is used as the reference
for calculating the offset
power.

PSD Ref:

The mean power spectral
density of the carrier that is
used as the reference for
calculating the offset power.

Select Offset:

Selects the offset pairs (1 ~ 5)
used for configuration.

Start Freq:

Sets the start frequency offset
for the selected offset
number.

Stop Freq:

Sets the stop frequency offset
for the selected offset
number.

RBW:

Sets the resolution
bandwidth of the selected
offset number.

Abs Start:

Sets the absolute level limit
at the Start Freq for selected
offset number.

Abs Stop:

Sets the absolute level limit
at the Stop Freq for the
selected offset number. The
Abs Stop level limit can be
set to Couple or Man. Man
allows Abs Stop to be user-
defined, while Couple will
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lock Abs Stop to the Abs
Start level limit.

Rel Start:

Sets the relative level limit at
the Start Freq for the selected
offset number.

Rel Stop:

Sets the relative level limit at
the Stop Freq for the selected
offset number. Rel Stop can
be set to Couple or Man.
Man allows Rel Stop to be
user-defined, while Couple
will lock Rel Stop to the Rel
Start level limit.

Fail Mask:

Sets the fail conditions for
measurement with regards to
the level limits: Absolute,
Relative, Absolute &
Relative, Absolute or
Relative.

Measurement
items Bandwidth:

Main Channel

Unit: Hz

Total Power:

Unit: dBm

PSD (Power
Spectral Density):

Unit: dBm/Hz

Offset 1~5:

Lower dBm, Upper dBm

3GPP Operating Bands*

Operating UL Frequencies

DL Frequencies

Band UE transmit, Node B receive  UE receive, Node B transmit

| 1920~1980MHz
I 1850~1910MHz
I 1710~1785MHz

2110~2170MHz
1930~1990 MHz
1805~1880MHz

v 1710~1755MHz 2110~2155MHz
\% 824~849MHz 869~894MHz
\ 830~840MHz 875~885MHz
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Vil
Vi

Xl
Xl
Xl
XV
XV
XVI
XVII
XVIII
XIX
XX
XXI
XXV

2500~2570MHz
880~915MHz
1749.9~1784.9MHz
1710~1770MHz
1427.9~1452.9MHz
698~716MHz
777~787MHz
788~796MHz
Reserved

Reserved

Reserved

Reserved
830~845MHz
832~862MHz
1447.9~1462.9MHz
1850~1915MHz

2620~2690MHz
925~960MHz
1844.9~1879.9MHz
2110~2170MHz
1475.9~1500.9MHz
728~746MHz
746~756MHz
758~768MHz
Reserved

Reserved

Reserved

Reserved
875~890MHz
791~821TMHz
1495.9~1510.9MHz
1930~1995MHz

*for FDD, referenced from ETSI:

3GPP TS 25.101 version 10.2.0 Release 10
3GPP TS 25.104 version 10.2.0 Release 10

168



GYINSTEK

ADVANCED OPERATION

3GPP-FDD BS

For the FDD configuration, different limits can by
chosen based on the total channel power, P.

The default value for Afmax is 12.5MHz. Afmax can be

user-defined.

The channel span is set to 5SMHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.

Unit: MHz Absl'] RBW
P>43

2.5 <A<2.7 -14dBm 30kHz

2.7<B<3.5 -14 ~ -26dBm 30kHz

3.5<C<Afmax -13dBm 1MHz

Unit: MHz Absl1] RBW
39<P<43

2.5 <A<2.7 -15dBm 30kHz

2.7<B<3.5 -14 ~ -26dBm 30kHz

3.5<C<7.5 -13dBm TMHz

7.5<D<Afmax P-56dB TMHz

Unit: MHz Absl] RBW
31<P<39

2.5 <A<2.7 P-53dB 30kHz

2.7<B<3.5 P-53dB~ 30kHz

P-56dB

3.5<C<7.5 P-52dB TMHz

7.5<D<Afmax P-56dB 1MHz

Unit: MHz Absl] RBW
P<31

2.5 <A<2.7 -22dBm 30kHz

2.7<B<3.5 -22 ~-34dBm 30kHz

3.5<C<7.5 -21dBM TMHz

7.5<D<Afmax -25dBm TMHz
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For P<31, two additional power limits (shown below)
can be selected via the Additional Max Out. Pwr
option for Home BS applications:

(The default value for Afmax is 14.5 MHz. Afmax can
be user-defined)

Unit: MHz Absll RBW
6<P<20

12.5 <E< Afmax P- 56dB 1TMHz

Unit: MHz Absll RBW
P<6

12.5 <E< Afmax -50dBm 1TMHz

3GPP-FDD BS
Additional
Requirements

For operation in bands 11, IV, V, X, XII, X1, XIV and
XXV, additional requirements (listed below) apply in
addition to the minimum requirements listed above.

Unit: MHz Additionall! RBW
Bands:

3.5<B<Afmax -13dBm TMHz

Unit: MHz Additionall! RBW
Bands: V

2.5 <A<3.5 -15dBm 30kHz

3.5<B< Afmax -13dBm 100kHz

Unit: MHz Additionall RBW
Bands:

3.5<B< Afmax -13dBm 100kHz

3GPP-FDD UE

170

The channel span is set to 5SMHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.

Rel Absl RBW
Unit: MHz
2.5<A<3.5 -35~-50dBc -71.1dBm 30kHz
3.5<B<7.5 -35~-39dBc -55.8dBm TMHz
7.5<C<8.5 -39~-49dBc -55.8dBm TMHz
8.5 <D<12.5 -49~-49dBc -55.8dBm TMHz
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3GPP-FDD UE
Additional
Requirements

Additional requirements for 3GPP-FDD UE.

Unit: MHz AdditionalPl RBW
Bands

3.5<B<12.5 -15dBm 1MHz

Unit: MHz AdditionalPl RBW
Band V

2.5 <A<3.5 -15dBm 30kHz

3.5<B<12.5 -13dBm 100kHz

Unit: MHz Additional! RBW
Bands

3.5<B<12.5 -13dBm 100kHz

3GPP-TDD BS
3.84Mcps*

For the TDD configuration, different limits can by
chosen based on the total channel power,

The channel span:
3.84Mcps: 5MHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.

Unit: MHz Absl] RBW
P>43

2.5 <A<2.7 -14dBm 30kHz

2.7<B<3.5 -14 ~ -26dBm 30kHz

3.5<C<12 -13dBm TMHz

Unit: MHz Absl] RBW
39<pP<43

2.5 <A<2.7 -14dBm 30kHz

2.7<B<3.5 -14 ~ -26dBm 30kHz

3.5<C<7.5 -13dBm TMHz

7.5<D<12 P-56dB TMHz
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Unit: MHz Absl RBW
31<P<39
2.5 <A<2.7 P-53dBm 30kHz
2.7<B<3.5 P-53~P-65dBm 30kHz
3.5<C<7.5 P-52dBm TMHz
7.5<C<12 P-56dBm 1MHz
Unit: MHz Absl] RBW
P<31
2.5 <A<2.7 -22dBm 30kHz
2.7<B<3.5 -22 ~-34dBm 30kHz
3.5<C<7.5 -21dBm TMHz
7.5<D<12 -25dBm TMHz

*referenced from ETSI:
3GPP TS 25.102 version 10.2.0 Release 10
3GPP TS 25.105 version 10.3.0 Release 10

3GPP-TDD BS The channel span:

1.28Mcps 1.28Mcps: 1.6MHz.
Unit: MHz Absll RBW
P>34
0.8 <A<1 -20dBm 30kHz
1<B<1.8 -20 ~-28dBm 30kHz
1.8<C<3.5 -13dBm TMHz
Unit: MHz Absl RBW
26<P<34
0.8 <A<1 P-54dB 30kHz
1<B<1.8 P-54~P-62dB  30kHz
1.8<C<3.5 P-47dB TMHz
Unit: MHz Absl RBW
P<26
0.8 <A<1 -28dBm 30kHz
1<B<1.8 -28~-36dBm  30kHz
1.8<C<3.5 -21dBm TMHz
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3GPP-TDD BS
7.68 Mcps

The channel span:
7.68Mcps: TOMHz.

Unit: MHz Absll RBW
P>43
5<A<5.2 -17dBm 30kHz
5.2<B<6 -17 ~-29dBm 30kHz
6<C<24.5 -16dBm TMHz
Unit: MHz Absl'] RBW
39<P<43
5<A<5.2 -17dBm 30kHz
5.2<B<6 -17 ~-29dBm 30kHz
6<C<15 -16dBm TMHz
15<D<24.5 P-59dB TMHz
Unit: MHz Absl] RBW
31<P<39
5<A<5.2 P-56dB 30kHz
5.2<B<6 P-56~P-68dB  30kHz
6<C<15 P-55dB TMHz
15<D<24.5 P-59dB TMHz
Unit: MHz Absl1] RBW
P<31
5<A<5.2 -25dBm 30kHz
5.2<B<6 -25~-37dBm  30kHz
6<C<15 -24dBm TMHz
15<D<24.5 -28dBm TMHz
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3GPP-TDD UE  The channel span:
3.84Mcps: 5SMHz.
1.28Mcps: 1.6MHz.
7.68Mcps: T0OMHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.

Unit: MHz Rell? RBW
3.84Mcps
2.5<A<3.5 -35~-50dBc 30kHz
3.5<B<7.5 -35~-39dBc  1MHz
7.5<C<8.5 -39~-49dBc  1MHz
8.5<D<12.5 -49dBc TMHz
Unit: MHz Rell? RBW
1.28Mcps
0.8 <A<1.8 -35~-49dBc 30kHz
1.8<B<2.4 -49~-59.2dBc  30kHz
2.4<C<4 -44dBc 1MHz
Unit: MHz Rell? RBW
7.68Mcps
5 <A<5.75 -38~-46dBc 30kHz
5.75<B<7 -46 ~ -53dBc  30kHz
7<C<15 -38~-42dBc 1MHz
15<D<17 -42~-52dBc TMHz
17<E<25 -53dBc 1MHz
802.11b* The channel span: 22MHz

Note: A, B denotes offsets 1 and offset 2.
Here the default value of “f” is 24MHz. This can be
user-defined.

Unit: MHz Rell@ RBW
11<A<22 -30dBc 100kHz
22<B<f -50dBc 100kHz

*reference: |IEEE Std 802.11b-1999
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802.11¢g The channel span:
ERP-OFDM/DSSS-OFDM : 18MHz
ERP-DSSS/ERP-PBCC/ERP-CCK: 22MHz

Note: A, B, C, D denote offsets 1 to 4, respectively.
Here the default value of “f” is 40MHz (ERP-OFDM/
DSSS-OFDM) or 25MHz (ERP-DSSS/ ERP-PBCC/
ERP-CCK). This can be user-defined.

Unit: MHz Rell? RBW
ERP-OFDM/
DSSS' 9 SA<‘| -l 'O~'20d BC 100kHZ
OFDM 11<B<20 -20~-28dBc 100kHz
20<C<30 -28~-40dBc 100kHz
30<D<f -40dBc 100kHz
Unit: MHz RellZ RBW
ERP-DSSS/
ERP-CCK 22<B<f -50dBc 100kHz

*reference: |IEEE Std 802.11a-1999

802.11n The channel span:
CH BW 20MHz: 18MHz
CH BW 40MHz: 38MHz

Note: A, B, C, D denote offsets 1 to 4, respectively.
Here the default value of “f” is 40MHz(CHBW
20MHz) or 70MHz(CHBW 40MHz). This can be user-

defined.
Unit: MHz Rell RBW

CH BW

20M Hz 9 SA<‘| 1 'O~'20d BC '|00kHZ
11<B<20 -20~-28dBc 100kHz
20<C<30 -28~-45dBc 100kHz
30<D«<f -45dBc 100kHz
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Unit: MHz Rell? RBW
CH BW

21<B<40 -20~-28dBc 100kHz

40<C<60 -28~-45dBc 100kHz

60<D<f -45dBc 100kHz

*reference: IEEE Std 802.1n-2009

802.16%

The channel span:
CH BW 20MHz: T9MHz
CH BW 10MHz: 9.5MHz

Note: A, B, C, D denote offsets 1 to 4, respectively.
Here the default value of “f” is 16.75MHz(CHBW
20MHz) or 31.5MHz(CHBW 10MHz). This can be
user-defined.

Unit: MHz Rell RBW
CH BW
10.9<B<19.5 -25~-32dBc 100kHz

19.5<C<29.5 -32~-50dBc 100kHz

29.5<D<f -50dBc 100kHz

Unit: MHz Rell? RBW
CH BW
JOMH,  475<A<5.45 0~25dBc  100kHz

5.45<B<9.75 -25~-32dBc 100kHz

9.75<C<14.75  -32~-50dBc 100kHz

14.75<D<f -50dBc 100kHz

*reference: IEEE Std 802.16-2009

A Note

176

[ Abs: Absolute limit
2] Rel: Relative limit(to the total power or the
power spectral density, depending on the
compliance of the main channel)
B3] Additional: Additional absolute limit
Pass Fail Criteria:

Case 1: When both Abs and Rel are used, the
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highest value (Abs or Rel) is used as the
Pass/Fail judgment. The trace points under
the limit indicate a pass.

Case2: If the additional limit is used, the
higher value from casel is compared to the
additional limit. The lowest one is used as the
pass/fail judgment.

Spectrum Emission Mask Testing

Description For spectrum emission mask testing, the GSP-
9330 has pre-defined testing parameters for
3GPP, 802.11x and 802.16. The GSP-9330 also
allows you to perform user-defined SEM
testing.

Operation: 1. Press > SEM[F5]>SEM[F2] and turn SEM
on.

*Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows the trace with the absolute and or
relative masks. The bottom screen shows the
SEM measurement results.
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Absolute
limit line

Froq Offsetis 0 now!

SEM measurements

User Defined 1. Press Setup[F1]>User Define[F6]to set SEM
Parameters measurement to user defined parameters.

2. Press Meas Type[F1] choose between
TotalPwrRef[F1] or PSDRef[F2].

3. Press Ref. Channel[F2] and set the following;:

ChanlintegBW[FI1] Sets the channel

integration bandwidth.
Chan Span[F2] Sets the channel span
RBWJF3] Sets the resolution
bandwidth.
TotalPwrRef]F4]/ Sets the total
PSDRef]F4] power/PSD reference
level.

4. Press Return[F7] to return to the previous
menu.
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5. Press Offset/Limit[F3] to set the offset

parameters:

SelectOffset(F1] Select which offset to
edit.

[FZ] Toggles the selected
offset on/ off.

StartFreq[F3] Sets the start frequency
of the selected offset.

StopFreq[F4] Sets the Stop Frequency
of the selected offset.

RBWJF5] Sets the RBW of the

selected offset.

6. Press More 1/2[F6] to set absolute and relative
level limits and conditions:

Abs StartfF2] Sets the absolute start
level limit for the
selected offset.

Abs Stop[F3] Sets the absolute stop
level limit for the
selected offset.

Man: Allows a user-
defined Abs Stop level

Couple: Sets the Abs
Stop level to the Abs
Start level.

Rel Start{F4] Sets the relative start
level limit for the
selected offset.
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Rel Stop[F5] Sets the relative stop
level for the selected
offset.

Man: Allows a user-
defined Abs Stop level.

Couple: Sets the Rel Stop

level to the Rel Start
level.

7. Press Fail Mask[F6] to set the Fail Mask

conditions:

Absolute[FT] Sets the fail condition to
the Absolute level limit.

Relative[F2] Sets the fail condition to
the relative level limit.

Abs AND Rel[F3] Sets the fail condition as
both the absolute and
relative level limits.

Abs OR Rel[F4] Sets the fail condition to

either the absolute or
relative level limits.

8. Press Select Offset[F1] and repeat the above
steps for any other offsets.

Offset: 1~5
Pre-Set Test For details on 3GPP SEM test parameters,
Parameters: please see the SEM overview on page 165.

3GPP

1. Press Setup[F1]>3GPP[F1] to choose 3GPP
measurement.
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. Press Ref. Channel[F2] and set the following;:

RBWJF3] Sets the resolution
bandwidth.

. All other reference channel settings are pre-

defined.

. Press Return[F7] to return the previous menu.

. Press Offset/Limit[F3]>Duplexing Mode[F1] and

choose FDD or TDD duplexing:

. For FDD, press FDD Setup[F2] set the FDD

parameters, for TDD, press TDD Setup[F3]:

Transmission[F1] Toggles between BS and
UE testing

Chip Rate[F2] Selects the bandwidth of
the RRC filter that is
used to measure the in-
channel power for TDD
duplexing:
3.84MHz, 1.28MHz,
7.68MHz

Max Out Pwr[F2/F3]  Sets the maximum
output power for BS
tests:
P>=43

39<=P<=43
31<=P<=39

P<31
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Add.limits{F4] Selects the operating
bands for FDD
duplexing:

None

BandlIl

BandIV

BandV

BandX

BandX11

BandXIII

BandXIV
MinOffset/ Allows you to view the
Limit Value[F5] parameters of each of the

offsets, including
start/stop frequency,

RBW, Abs Start/Stop

and Rel Start/Stop.
Pre-Set Test For details on 802.11x and 802.16 SEM test
Parameters: parameters, please see the SEM overview on

802.XX page 165
1. Press Setup[F1]>and choose a 802.XX test:

802.11b[F2]
802.11g[F3]
802.11n[F4]
802.16[F5]

2. Press Ref. Channel[F2] to view the predefined

settings for channel integrated bandwidth,
channel span, RBW and PSD ref.
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3. Press Offset/Limit[F3] to view the parameter
values of each of the offsets, including Start and
Stop Frequency, RBW, Rel Start and Stop
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Third Order Intermodulation Distortion (TOI)

Description Third order intermodulation distortion
measurement is used to calculate the TOI
products caused by two signals that are close
together in frequency in a non-linear system.
Both the upper and lower third order intercept
points (IP3) are calculated. Markers are placed
at the frequencies of the TOI products and their
respective base signals.

Limits can be placed on the upper and lower
TOI products for limit testing.

Parameters Reference Lower  Sets the reference level to
lowest base signal
Reference Upper  Set the reference level to the
highest base signal
Limit Sets the limit in dBm for
pass/fail testing
Pass/Fail Test Enables/disables pass/fail

testing.
Measurement Base Upper Frequency, dBm, dBc
items Base Lower Frequency, dBm, dBc

3rd Order Lower  Frequency, dBm, dBc, limit,
Intercept point

3rd Order Upper  Frequency, dBm, dBc, limit,
Intercept point

N Frequency
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Example A

. f.
Y VAV
34 Order Upper :

Base Lower
Base Upper
3'd Order Lower

Operation: 1. Press (M= )> TOI[F6]>TOI[F1] and turn TOI
on.

*Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows the trace with markers in the upper and
lower base frequencies and the upper and
lower 3t order intermodulation products. The
bottom screen shows the TOI measurements
and pass/fail results.

3 Order Lowerand 3™ Order
lower upper base upper
marker marker

45

TOI measurement and results
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3. Press Reference[F2] to set the reference to the
upper or lower base frequencies.

The (B icon will be displayed next to the

selected upper or lower reference.

4. Press Limit[F3] and set the limit for the upper
and lower 3 order intermodulation product
amplitude.

5. Press Pass/Fail Test[F4] to toggle pass/fail
testing on/ off.

The & pass or € fail icon will be displayed
depending on the limit set above.

CNR/CSO/CTB Measurement

Carrier to Noise Ratio (CNR)

Description Carrier to noise ratio calculates the difference in
amplitude between the carrier signal and the
noise level present in the transmission. CNR
measurements are used for both analog and

digital CATV.

Parameters Noise Marking Sets the position of the delta
marker (A1) using two
options:

MIN:

The delta marker will search
for the minimum between
the carrier frequency and the
carrier frequency + 4MHz.

186



GUWINSTEK ADVANCED OPERATION

AMarker:
User defined delta marker
position.

Measurement Visual Carrier frequency, amplitude
items CNR amplitude difference

Iof frequency difference between
visual carrier and noise
marker.

Example 1

e
z h
;U_ Noise . .'::'.
o < marker 0
Af Color subcarrier,
aural carrier
Channel
spacing To next main channel
Operation: 1. Press (M )>More[F7]>CNR/CSO/CTB[F1]>
Setup[F1]> CNR[F1] to choose CNR
measurement.

2. Press Noise Marking[F1] and toggle the noise
marker type between Min and AMarker.

3. If Min was selected, press Return[F7] to return
to the previous menu.

4. If AMarker was selected, press >
Delta[F4]>Delta[F1] and set the delta marker
position.

xSee page 96 for details on moving markers.

Press > CNR/CSO/CTB[F7] to return to

the previous menu.
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5. Press CNR[F2] and turn CNR on.
*Any other measurement mode will automatically be
disabled.

xEnsure the aural and color subcarriers are disabled
before CNR is turned on.

6. The display splits into two screens. The top
shows the trace with the visual carrier marker
and the noise marker. The bottom screen shows
the CNR measurements.

Visual carrier Noise
marker marker

1T 305.000MHz Tor 315.000MHZ
W 100kHz W 100kHz  Sp MHz

CNR measurements

7. Press CNR CH SP[F2] to set the channel space.

Range: 0~3.25GHz

8. Press Channel Move Down[F4] or Channel Move
Up [F5] to move to the next or previous
channel.

A Ensure the aural and color subcarriers are turned
Note off when making CNR measurements.
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Composite Second Order (CSO)

Description Composite Second Order measurement
calculates the difference in amplitude between
the carrier signal and the composite second

order beat.
Parameters CSO CH SP: The channel space.
Measurement Visual Carrier: frequency, amplitude
items Channel Space: frequency

CSO: amplitude difference

Example
. e Visual carrier marker
O H
o
vs) 8 2 :".‘
< CSO Beat marker ;3
Af i— Color subcarrier,
5 aural carrier
Channel
spacing To next main channel
Operation: 1. Press (Meswe)> More[F7]>CNR/CSO/CTB[F1]>

Setup[F1]> CSO[F2] and choose CSO.

2. Press CSO[F2] and toggle CSO on.

*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the trace with the visual carrier marker
and the CSO beat marker. The bottom screen
shows the CSO measurements.
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Visual carrier CSO beat
marker marker

17:50:27 \\2014-06-04
M 5

Starl 52 250MHz el 55 250MHZ Stor
W 26KkHz BW 30kHz  Span:6.000MHz

CSO measurements

. Press CSO CH SPC[F3] to set the channel space.

Range: 0~3.25GHz

. Press Channel Move Down[F4] or Channel Move

Up [F5] to move to next or previous channel.

Composite Triple Beat (CTB)

Description Composite triple beat measurement calculates
the difference in amplitude between the visual
carrier and the composite triple beat amplitude.

Measurement Visual Carrier: frequency, amplitude

items CTB: amplitude difference from the visual

carrier and the triple beat
Triple Beat: amplitude
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Example 1 )
< Visual carrier marker

e ;
ED __________ <\ CTB Beat marker .":'.
Channel ,
. N
spacing To next main channel
Operation: 1. Press > More[F7]>CNR/CSO/CTB[F1]>

Setup[F1]> CTB[F3]>Return[F7] to choose CTB
measurement and return to the previous menu.

2. Press CTB[F2] and turn CTB on.

*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the trace with the visual carrier marker.
The bottom screen shows the CTB
measurements.

«This will place a marker (é ) on the visual carrier and

record the amplitude.

Visual carrier CTB beat
marker marker

CTB measurements
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4. Turn off the visual carrier signal from the input

and press the key on the front panel.

5. A second trace will appear to mark the CTB
amplitude.

+This will place a marker (é) on the second trace and
calculate the difference (é-é).

6. Press CTB CH SP[F2] to set the channel space.
Range: 0~3.25GHz

7. Press Channel Move Down[F4] or Channel Move
Up [F5] to move to next or previous channel.

A To perform the CTB measurement again, press
Note Setup[F1]>CTB[F3]> Restart[F]].
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Harmonic Measurements

Description The Harmonic function can be used to easily
measure the amplitude of the fundamental
frequency and its harmonic frequencies up to
the 10th harmonic. The function can also
measure the amplitude relative to the
fundamental (dBc) and the total harmonic

distortion (THD).
Measurement Amplitude Amplitude of each harmonic
items (dBm).

dBc Amplitude of each harmonic

relative to the fundamental.

THD The square root of the sum of
the amplitude of each
harmonic frequency squared,
divided by the amplitude of
the fundamental frequency.

THD=( V2% + V2. .+ V4?

\1

Example Fundamental frequency

1st 2nd 3rd 4th,

Harmonic

Operation 1. Press >
More[F7]>Harmonic[F2]>Harmonic[F1] and turn
Harmonic on.
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+Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows a bar graph with fundamental
measurement (1) and the each of the harmonic
frequencies (2~ 10). The bottom screen shows
the amplitude, dBc and THD results.

Fundamental frequency

Nth order harmonics

p-28:14  2011-11-10

Harmonic measurement

3. Press Fundamental Freq.[F2] to set the
fundamental frequency.

4. Press Number of Order[F3] to set the number of
harmonic frequencies to measure.

*The number of harmonic frequencies set will affect the
THD measurement.

5. Press RBWJ[F4] and set the RBW to Auto or
Man.
Set the resolution bandwidth and unit for RBW
Man mode.

*The RBW setting will affect the THD measurement.
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Mode: Auto, Man
Frequency Range(3dB): 10kHz~1MHz (1-3-10
step)
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N dB Bandwidth

Description N dB bandwidth measurements are used to
measure the frequency bandwidth that covers a
specified amplitude (N dB) from the top of the
peak.

Example

Operation 1. Press (M=)> More[F7]>NdB Bandwidth[F3]>
NdB BWJ[F1] and turn N dB BW on.

*Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows the trace with markers for NdB and NdB
BW. The bottom screen shows the N dB
measurement results in real time.
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Q3-23
999 850 MHz - 31 78 dBm
8

300 kHz - 0.002 o

N dB BW Measurement

3. Press NdB[F2] to set the NdB amplitude:

Amplitude: 0.1dB ~ 80.0 dB

& The NdB bandwidth measurements are strongly
Note tied to the RBW and VBW.
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P1dB Measurement

Description The P1dB compression point describes the
point at which the gain of an active DUT is 1dB
less than the ideal linear gain (or small signal
gain) relative to the input.

Example &
o&
N ec)Q
— D
2
£ \V
3/ m
5 response
2
5
(o]
5
ol
5
(@) N
7

Input power (dBm)

P1dB Connection Connect the DUT to the RF input. Connect the

Setup tracking generator output to the DUT input.
The DC output can be used to power the DUT if
necessary.

GSP
TG DCOUT RF IN
OUTPUT
DUT

Operation 1. Press (Weswe)> More[F7]>P1dB[F4]>P1dB[F1] and
turn P1dB on.

*Any other measurement mode will automatically be
disabled.

[t is not necessary to turn the tracking generator on.
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2. The display splits into two screens. After setup

has been completed (see step 3), the top shows
the trace (yellow) with the ideal response in
red. The P1dB measurement is shown in green.
The bottom screen shows the P1dB
measurement results in real time.

1dB

P1dB measurements

The measurement results display a total of 31
points, incremented in 1dB steps from -30dBm
to 0 dBm. In each column the left side shows
the input power and the right side shows the
gain. Gain marked in white is effective gain,
while gain marked in purple is ineffective gain.
The results also list the average gain, the output
power at the P1dB point (Pout, 1dB) and the
input power at the P1dB point.

. Press P1dB Setup[F2] to set the P1dB settings.

. Press Center Freq[F1] to set the center frequency:

Frequency: 0~3.25GHz
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. Press Gain Offset[F2] to set the gain offset of the

ideal linear response.

Gain: -99.00dB ~ 99.00 dB

. To help smooth the actual frequency response

and measure the P1dB compression point more
accurately, press Average[F3] to set the average
number. This is especially useful if Start is set
around -50dB.

Average number: 1~200

. Press Start[F4] to set the “starting” output

power for the P1dB measurement.

Start: -50dB ~ -5dB

. Press Reset[F5] to restart the P1dB measurement

function.

A\X/arning

If the equivalent gain exceeds 30dBm the gridicule
area will be bordered in red to indicate that the
input exceeds specified levels.

01:54:26  2011-10-01

e 5dB/
30.00dBm Al 40.00 dB

A Note

The maximum power the DC output can provide is
7volts/500mA.
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P1dB Normalization

Description

The normalize function is used to compensate
for any loss from a long cable that may cause
inaccurate measurements.

This function relies on the DUT being directly
connected to either the TG or the RF input. The
position of the long cable in relation to the DUT
(input or output) will affect the P1dB
measurement.

If the cable is at the DUT input, then the line
loss of the cable will reduce the output of the
TG before it is input to the DUT. This
configuration (Location = Prev) can affect the
position of the P1dB point if not normalized.

Likewise if the cable is connected to the output
of the DUT, then the gain of the DUT will be
reduced at the RF input by the line loss of the
cable. In this configuration (Location = Post) the
P1dB point will not be affected.

& Note

If a DUT cannot be directly connected to the TG
output or the RG input, try to use the shortest
cable possible to reduce the effect of cable loss.
The line loss from short cables cannot be
measured when using the Normalize function.
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Example 1 Location = Prev
W Normalized
N m response
/ 18
| DUT response with
5 /l\ line loss before
T 55 .
o = DUT input
2 el s ©
5] o =z N
ol S m 23
+— © O [a] E
a Exi 123
5 9 o c
o Z S
Input power (dBm) 4
Example 2 Location = Post
Normalized
A
\L W DUT response
N 1dB \

/ N7

DUT response with line
loss after DUT output

Output power (dBm)

N4

Input power (dBm)

A Note

This function can only be used when the P1dB is
turned on.

Operation

202

. Connect the cable that is to be connected to the

DUT between the TG and the other cable to the
RF input.

¢ GSP
OUTPUT RF IN

| T
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2. Press > More[F7]>P1dB[F4]
>Normalize[F3].

3. Press Execute Norm[F3]. This will normalize the
cable loss. The cable loss will be shown in the
Execute Norm icon.

03:40.20  2011-10-01

4. Next connect the DUT either directly to the TG
or directly to the RF input. The location of the
DUT will determine whether the cable loss is
normalized before or after the DUT.

Connect the RF cable from the DUT to the
either the TG or RF input, depending on where
the DUT was connected.

Location = Prev Location = Post
TG Gsp TG Gsp
OUTPUT RF IN OUTPUT RF IN
Cable to be Cable to be

compensated ~ compensated

5. Set Location[F2] to either PREV or POST,
depending on the location of the DUT, as
shown above.

6. Turn Norm.[F3] on.

7. The cable loss will now be normalized, based
on where the DUT is located.
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EMC Pre-Compliance Testing

The GSP-9330 EMC Pretest function is a comprehensive suite for
performing, debugging or estimating radiated or conducted
emissions as well as the ability to troubleshoot immunity tests.

The EMC Prestest function is divided into 5 main functions: EMI
Test, Field Sensor, Source Contact Probe, AC Voltage Probe and
EMS Test.

The EMI Test function is used to perform radiated or conducted
emissions tests. These tests include inbuilt support for a number of
EN and FCC standards to test against.

The Field Sensor functions allow you to simulate the radiated
emissions at 3 meters and 10 meters for a number of different EN
and FCC standards.

The Source Contact Probe function is used to debug sources of
electromagnetic emissions using the GW Instek Source Contact
probes. This function also allows you test against EN or FCC
radiated emission standards.

The AC Voltage Probe function allows you to estimate the
conducted the emissions from the power lines without having to
perform conducted radiation tests with the increased cost of a LISN
device. It can also be used to debug sources of conducted emissions
on your DUT.

The EMS Test function allows you to debug radiated immunity
(susceptibility) weakness in the DUT by outputting a source signal
from the TG Output with user-defined characteristics.

*EMI Testing for Radiated Emissions — from page 205.
*Near Field Testing: Field Sensor — from page 211.
*Near Field Testing: Source Contact Probe — from page 214.

+*Conducted Emissions Estimation: AC Voltage Probe — from page
218.

*Susceptibility Debugging (EMS Test) — from page 220.
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EMI Test

Description

The EMI Test function is used to greatly
simplify the process of EMI pretesting for
radiated or conductive emissions testing. You
only need to specify the testing frequency,
standard used and any corrective factors.

In addition, the peak table function can be used
and the results can be shown logarithmically.

& Note

Note the following instructions assume that you
are familiar with how to conduct a radiated or
conducted emissions test and are familiar with the
various emissions standards.

EMI Testing
Overview

Generally speaking, EMI testing is split into 4
different tests: radiated emissions, radiated
immunity, conducted emissions and conducted
immunity tests. The EMI test function is primarily
concerned with radiated emissions and to a lesser
extent, conducted emissions.
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Radiated The following is a basic overview of radiated

Emissions Tests tests. There are a number of different standards,
each that have specific test configurations and
methods. Most radiated tests are performed in
an anechoic chamber or in an open area, where
the size of the testing area and the position of
the test apparatus may differ from each
standard.

An example of a possible setup is shown below.

Place the DUT and antenna on a grounding
plane. Arrange the DUT on a raised non-
conducting platform and position the antenna 3
or 10 meters from the DUT. Set the antenna
height as specified in the applicable standard.
Arrange the antenna once in the horizontal
position and once in the vertical position.
Rotate the DUT 45° after each test.

antenna

3m or 10m

A
DUT
T smorom AT oo
i

Ground plane
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Conducted For conducted emissions testing, a LISN (line

Emissions impedance stabilization network) is required. A
LISN is used for two main reasons. Firstly, it is
used to filter any noise from the mains power
that is fed to the DUT. Secondly, it filters RF
noise from the DUT that would normally be
coupled to the mains power and passes it to the
spectrum analyzer.

A limiter is also usually used to attenuate the
signal input to the spectrum analyzer to safe

levels.
Mains power
GSP k Limiter k LISN DUT
Operation 1. Press @3> EMC On[F1]>EMI Test[F2] and

choose a frequency band to test at. The test
frequency that is chosen determines whether
the test is a radiated, conducted test or user
defined, based on what standard you wish to
use.

EMI Test Conducted Tests:  Radiated tests:
Frequency: 9k-150kHz, 150k-  30M-300MHz,
30MHz 300M-1GHz,
30M-1GHz,
1G-3GHz.

Ambient Noise 2. Press Amb.Noise Reject[F2] to turn on ambient

Rejection noise rejection. This function will essentially set
the RBW to 9kHz and lower the noise floor for
bandwidths between 30MHz and 3GHz. This
will allow an open environment to emulate an
anechoic chamber.
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Antenna factor or 3. Press Correction[F3] to apply corrective factors

LISN correction based on the antenna used, the LISN or the
factor settings position of the antenna. The options available
depend on the EMI test frequency selected
previously.
None[F1] No correction is used. Turn the

Correction function off.

Horizontal[F2] For radiated emissions tests. It
is a correction set for when the
antenna is in the horizontal
position. This correction set is
configured for use with GW
Instek antennas only.

Vertical[F3] For radiated emissions tests. It
is a correction set for when the
antenna is in the vertical
position. As with the
Horizontal correction set, this
correction set is configured for
use with GW Instek antennas
only.

Other factor[F4] Load or create a custom
correction set to use with a
third party antenna.

Cor.factor[F2]  Load or create a custom
correction set for use with a
LISN device.

4. If Other factor[F4] or Cor.factor[F2] was chosen
above, select a correction set or edit an existing
correction set and then set Correction[F3] to On.

Press Return[F7] to return to the previous
menu.

xSee page 54 for details on creating or editing correction
sets.
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Recall Limit 5. Press Recall Limit[F4] to add EN55022A /B or
FCC A/B limit lines to the display. The limit
line that is produced is matched to the selected
test frequency range.

None No limit line

EN5502A Euro commercial standard
EN5502B Euro residential standard

FCCA American non-residential standard
FCCB American residential standard

6. Select Average[F1] or Quasi-peak[F2] or Both[F3]
for the detector for the chosen standard. The
availability of these settings depends on the
EMI test frequency selected previously.

Detector: Average, Quasi-peak, Both.
7. When Recall Limit is turned on, pass/fail

testing will be performed on each sweep based
on the standard selected.

Pass: , with green grid border.

Fail: , with red grid border.

The alarm icon is shown at the bottom of
the display whenever Recall Limit is turned
on.

Display Icon
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Example Limit line

Standard

Pass/Fail and alarm indicator

8. Press Peak Table[F5] to turn on the peak table
function.

The peak table function will split the display

and add peak markers to the top ten peaks and
list them at the bottom.

Spectrum display

133425  2([4-06-13

1008/
o1 80.000BuV/mAL0.0dB

730, 000MHz
veop 3.98s

Peak Table
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9. Press Scale Type[F6] to set the frequency scale to
logarithmic or linear. Logarithmic frequency
scaling is often used for compliance testing.

10. If any test fails, use the Field Sensor, Source
Contact Probe or AC Voltage Probe functions to
find the cause(s) of the test failure. Rectify the
causes and then re-test.

Near Field Testing ~ Field Sensor

Description The Field Sensor function can be used to
narrow down sources of strong magnetic fields
before making a radiated compliance test as
this function allows you to simulate the
radiated emissions from 3 or 10 meters when
using any of the GW Instek Field Sensors.

Magnetic field sources are characterized by
high current, low voltage sources, such as PCB
traces with high current.

& The 3m and 10m simulated results are based on

Note the probe factors of the GW Instek Field Sensor
antennas, and as such can only be used with a GW
Instek Field Sensor.
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Example Setup

With the DUT turned on, scan the DUT with the
Field Sensor parallel to the DUT. The response of
the probe from the DUT may fluctuate based on a
number of different factors:

e  The position of the probe
e  The position of the DUT
e The operating state of the DUT

e The size of the probe used

e The testing frequency/bandwidth of the
applied standard

GSP

Operation

Correction Set

212

1.

2.

Press @EE>EMC On[F1]>Field Sensor[F3]>
and choose a frequency band or user define to
test at.

Field Sensor Test 30M-300MHz,
Frequency: 300M-1GHz, 30M-1GHz

Press Correction[F2] and choose whether to
view the near-field test results as is or the
simulated radiated results based on the near-
field test.

None[F1] No correction is used.

3m[F2] Simulated 3m radiated emission
based on the near field emissions.

10m[F3] Simulated 10m radiated emissions.
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Other Create, edit or select a correction set

factor[F4] to use. This option is useful if a third
party M-field antenna is used. See
page 54 for details on creating a
correction set. This option will not
allow you to simulate the 3m or 10m
radiated emissions.

Recall Limit 3. Press one of the limit standards to show the
limit line for a standard and to start pass/fail
testing. These limit lines should only be used
for when the 3m or 10m correction sets are
used.

EN5502A Euro commercial standard (10m)
EN5502B Euro residential standard (3m)

FCCA American non-residential standard
(10m)
FCCB American residential standard (3m)

Pass/fail testing will also be performed on the
simulated emissions after each sweep, based on
the standard selected.

Pass: , with green grid border.

Fail: , with red grid border.

The alarm icon is shown at the bottom of
the display when a standard is selected.

Display Icon
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Example Limit line

40:59  2014.06-12

tart 30.000MHz v 165.000MHz P 300 000MHz
RBW 120kHz* VBW 100kHz  Span 270.000MHz woep 696ms

PAS!

Pass/Fail and alarm indicator

Near Field Testing ~ Source Contact Probe

Description The Source Contact Probe function allows you
to perform near field testing of electric fields (E-
fields) so that you can narrow down sources of
strong electric fields before compliance testing.

These types of fields are usually found on
traces connected to high impedance
components or on un-terminated cables or tri-
state outputs from logic circuits.
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Example Setup With the DUT turned on, touch the Source Contact
probe anywhere on one of the PCB traces, PCB
pins, 1/O cable pins or one of the other exposed

conductors.

________ DC

ee-c Block
'
'
Probe RF In}

GSP

DUT
& ' When using a Source Contact probe, please make
Warning use of a DC block or other limiter to protect the RF

input of the spectrum analyzer.

Operation 1. Press >EMC On[F1]>Source Contact
Probe[F4]> and choose a frequency band or user
define to test at.

Source Contact Test 30M-300MHz,
Frequency: 300M-1GHz

2. Next select the type of e-field source that will be
used with the E-field probe.

PCBtracePin[F2] For use on PCB traces/pins
I/OCablePin[F3] For use onI/O cabling/pins.

Correction Set 3. Press Correction[F1] and choose the length of
the PCB trace/1/O cable. This will help the
software to estimate the radiated emissions that
would emanate from those points.

For PCBtracePIN None[F1] No correction is used.
20cm trace[F2]  For traces of approx. 20cm
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For 1/O Cable PIN

Recall Limit

Display Icon

216

4.

15cm trace[F3]  For traces of approx. 15cm
10cm trace[F4]  For traces of approx. 10cm

6cm trace[F)] For traces of approx. 6cm
4cm trace[F6] For traces of approx. 4cm
None[FT] No correction is used.

2m cable[F2] For cables of approx. 2m
1.5m cable[F3]  For cables of approx. 1.5m
1m cable[F4] For cables of approx. Im
0.5m cable[F5]  For cables of approx. 0.5m

Press one of the limit standards to show the
limit line for a standard and to start pass/fail

testing.

EN5502B Euro residential standard (3m)
FCCB American residential standard (3m)

Pass/fail testing will also be performed on the

simulated emissions after each sweep, based on
the standard selected.

Pass: , with green grid border.

Fail: , with red grid border.

The alarm icon is shown at the bottom of
the display when a standard is selected.
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EXampIe 1431112 2014.07-21

1008/
80.00BuV/m Al1 0.0 dB

Limit line

tart 30.000MHz 185 Hz

65 iz p 300.000MHz
W 100kHz & 0.000MHz Sw 96
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AC Voltage Probe

Description

The AC Voltage Probe function is used to
perform conducted emissions pretesting of a
DUT. The unique advantage of this function is
that the conducted emissions pretest can be
performed without the need of a LISN.

This function is only to be used with the GW
Instek EMI AC Voltage Probe (GW Instek part
number PR-01).

Testing Example

To perform this test, touch the AC Voltage
Probe to the Line, Neutral or Ground lines of
the DUT’s input power. The power must be on
when this test is performed. For safety
purposes a power plug adapter with a pass-

A\X/arning

through should be used.
L RN GSP
)
. v
" ]
' '
) *s._] Transient
Mains power DUT Limiter
When testing the AC

Voltage Probe on a line
input, a power plug
adapter with a pass-
through to the Line,
Neutral or Ground lines
should be used. This 2
adapter will allow you to

safely test the input power
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line. This is not supplied by
GW Instek and should be
user-sourced.

&Warning

The AC Voltage Probe should only be used with
general electric devices connected to mains power
(AC100~240V). When testing, care must be taken
to avoid conditions are not prone to lightning,
flooding or other dangerous conditions.

&Warning

Make sure a transient limiter or pulse limiter is
used between the probe and the RF input to
protect the RF input of the spectrum analyzer.

Operation

Recall Limit

. Press >EMC On[F1]>AC Voltage

Probe[F5]> and choose Pretest or Debug.

Pretest ~ The pretest option is used on a live
AC line. This will estimate the
conducted emissions testing without
the use of a LISN device. This
function is only supported with the
GW Instek AC Voltage Probe.

Debug Spot test potential conducted
emissions on the AC power
components of the DUT. This is
useful to analyze the potential
sources of conducted RF.

. Press Recall Limit[F5] to add EN55022A /B or

FCC A/B limit lines to the display. Then press
one of the limit standards to show the limit line
for a standard and to start pass/fail testing.

EN5502A Euro commercial standard (10m)
EN5502B Euro residential standard (3m)

FCCA American non-residential standard
(10m)
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FCCB American residential standard (3m)
Pass/fail testing will also be performed on the

simulated emissions after each sweep, based on
the standard selected.

Pass: , with green grid border.

Fail: , with red grid border.

The alarm icon is shown at the bottom of
the display when a standard is selected.

Display Icon

Example

220



GYINSTEK

ADVANCED OPERATION

EMS Test

Description

The EMS Test function allows you to debug
immunity (susceptibility) of a DUT using the
GW Instek Field Sensors. The test function is
designed to output a frequency sweep of a user-
defined range with a user-defined signal
strength.

Example Setup

The test setup is simple. Power up the DUT and
scan the DUT with the probe. Observe the DUT
for any abnormal response from the signal
output by the probe.

GSP

Operation

. Press > EMS Test[F6].

. Press 80MHz-300MHz[F3], 300MHz-1GHz[F4]

or 80MHz-1GHz[F5] to select a pre-defined
frequency range and start the sweep. Press
again to stop.

. Alternatively, press User Define[F6] to configure

a user-defined frequency sweep range.

. Press SRC FreqStart[F1] and set the start

frequency of the sweep.

Start Freq. 0Hz - 3.25GHz
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5. Press SRC FreqStop[F2] and set the stop
frequency of the sweep. The stop frequency
must be 100Hz greater than the start frequency.

Stop Freq. 100Hz - 3.25GHz

6. Press Run  Stop[F3] to start the frequency
sweep. Press again to stop.

A Frequencies are swept by 1% increase steps from

Note the lowest to the highest value of the selected
range. When the highest frequency is reached, the
sweep cycle starts again from the lowest value.

7. Press Source Strength[F2] and set the source
output power.

Power: 3V/m,1V/m
Units: V/m

8. Press EMS Source[F1] and turn the source on to
start testing.

9. Check to see that the DUT is operating correctly
when the signal is output from the probe.

Example 10:44:40  2014.06-30

1048/
Fef -27.00dBm _Att 10.0d8

tart 30.000MHz tor 165.000MHz p 300 000MHz
REW 1MHz BW 1MHz Span 270.000MHz weop 31.3ms
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Limit Line Testing

The limit line is used to set the upper or lower amplitude limits
over the entire frequency range. The limit lines can be used to
detect whether the input signal is above, below or within the limit
lines.

The limit lines can be manually or automatically created. The limit
lines can be manually edited by frequency or from the trace data or
marker points.

*Creating a Limit (Point by Point) — from page 223.
*Creating a Limit (from Trace Data) — from page 225.
*Creating a Limit (from marker data) — from page 226.
+Creating a Limit (from marker data) — from page 226
*Delete Limit Line — from page 227

«Pass Fail Testing — from page 228

Creating a Limit (Point by Point)

Description Create a limit manually, point by point. A
maximum of ten points can be used.

Operation 1. Press (_im )> Edit Select Limit[F1]>Limit Line
[F1] and choose a limit line.

Limit line: 1~5
2. Press Point by Point[F2].
The GSP-9330 is split into two screens. The top

screen shows the trace and limit lines and the
bottom screen shows the limit line table.
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Spectrum display

Limit Line Table

. Press Point Num[F1] and choose a point number

to edit with the number pad (must start at #1).

. Press Frequency[F2] and set the frequency of the

point.

. Press Limit[F3] and set the amplitude level of

the point.

All the points will be displayed in a limit line
table at the bottom of the display.

. Repeat steps 3-5 for the remaining points

(maximum of 10points. Points can only be
created in numerical order).

. To delete the selected point, press Delete

Point[F6].

. Press Return[F7]>Save Limit Line[F5] to save the

currently selected limit line.

A Note

224

Note that the limit lines are automatically sorted by
frequency (low — high).
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Creating a Limit (from Trace Data)

Description Trace data can be used to create limit lines. A
10 point limit line is created from the trace data
at each grid division as well as the start and
stop frequencies.

Operation 1. Press (_im )> Edit Select Limit[F1]>Limit Line
[F1] and choose a limit line.

Limit line: 1~5
2. Press Trace Data to Limit Line[F3].
The GSP-9330 is split into two screens. The top

screen shows the trace and limit lines and the
bottom screen shows the limit line table.

Spectrum display

Limit Line Table

3. Press Limit Offset[F2] and set an offset level.
4. Press Create Limit Line Now[F1].

*A limit line will automatically be created based on the
trace and offset level.
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+A limit line can be created any number of times.

5. Press Return[F7]>Save Limit Line[F5] to save the
currently selected limit line.

Creating a Limit (from marker data)

Description Marker data can be used to create limit lines.
Please see the marker chapter on page 94 for
details on markers. A maximum of 10 points
can be created.

Operation 1. Press (_tm )> Edit Select Limit[F1]>Limit Line
[F1] and choose a limit line.

Limit line: 1~5
2. Press Mkr Data to Limit Line[F4].
The GSP-9330 is split into two screens. The top

screen shows the trace and limit lines and the
bottom screen shows the limit line table.

Spectrum display

02:47:59 24 [+-03-09
Mk1 10.00MHz 8.17 dBm

L i e
76 000MHz C MRz 714 000MHz
W 1 0kHz W p 6178

Limit Line Table

3. Press Point Num[F1] and choose a point number
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& Note

Delete Limit Line

4.

to edit (must start at #1).

Press Limit Offset[F3] and set the offset level for
the point.

«This will only create an offset for the currently selected
point, not all the points.

5.

Press Mkr Data to Point[F2].This adds the
currently active marker’s position to the
selected point.

The marker position can be moved at this point
using the scroll wheel. Press the Enter key to set
the position.

Repeat steps 3-6 for any other points (max 10).

Press Return[F7]>Save Limit Line[F5] to save the
currently selected limit line.

Using this function will also change the position of
marker 1 outside of the limit function.

Description Any one of the 5 limit lines can be deleted.
Activate 1. Press (_tm )> Edit Select Limit[F1]>Limit
Correction

Line[F1] and choose a limit line (limit line 1~5)
to delete.

Press Delete Limit Line[F6]. The data from the
chosen limit line will be deleted.
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Pass Fail Testing

Description

Operation

228

Before pass/fail testing can begin, limit lines for
the upper and lower limits must first be saved.
See page 223, 225 & 226 to save limit lines.

. Press m>Pass/Fail Test.

. To set a high limit, press High Limit[F1] and

choose one of the limit lines as the upper (high)
limit.

. To set the low limit, press Low Limit[F2] and

select one of the limit lines as the lower limit.

. Press Pass Criterion[F3] and select the pass

criteria.

Criteria: All-In, Max-In, Min-In

. Press Pass/Fail Mode[F5] to select what the GSP-

9330 will do on a fail judgment. Single will stop
testing after a single fail. Continue will continue
testing after each fail judgment.

Pass/Fail Mode: Single, Continue

. Press Pass/Fail Test[F4] and turn the testing on.

. The test result appears in the bottom of the

display, and the high and low limit lines (if
enabled) appear on the display.

Pass: , with green grid border.

Fail: , with red grid border.
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Display Icon The alarm icon is shown at the bottom of
the display whenever testing is turned on.
Example Limit line
Pass/Fail inidicator
& N At least one limit line (high or low) must be turned
ote

on to enable testing.
If the high limit or low limit is turned off, the
maximum or minimum* display level is set

automatically as the high or low limit, respectively.

* +30dBm+Ref level offset or -150dBm-+Ref level
offset
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Sequence

The Sequence function records and plays back user-defined macros.
There are up to 5 sequences available in repeat or single running
mode, with up to 20 steps each. Delays and pauses can also be
introduced into a sequence to view measurement results during a
sequence. Sequences can also call other sequences to create longer
sequences.

The sections below can be used to skip to the relevant section:

+Edit Sequence — from page 230

*Run Sequence — from page 234

Editing a Sequence

Edit a Sequence 1. Press (Sewere)> Sequence[F1] and choose a
sequence to edit/create.

Sequence: 1~5

2. Press Edit[F2]>Start Edit[F1] to start editing the
selected sequence.

3. The display splits into two screens. The top
screen shows the main screen. The bottom
screen shows the Sequence Editor with the
sequence steps.

«The EMEIETIWSIN icon appears in the sequence

editor window.
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Start Edit/ Sequence

Main display  Stop Edit icon function

menu
I
Sequence Editor window
Add a Step Up to 20 steps can be added to each sequence.

Each panel operation is recorded as a step.
After each panel operation is performed, press

the key to record the step (in some cases
this is not necessary - check if the operation
appears in the sequence editor window).

In the following example the center frequency
and span are added as steps to a sequence:

1. Press >Center Freq[F1]>20MHz>_
2. Press >Zero Span[F3]> )

3. The two operations are added to the Sequence
Editor.

CenterFreq: 20.000MHz

ZeroSpan

4. Press the key again to return to the

sequence function menu.
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A The arrow keys can be used to move the cursor to
Note the desired step when in the Sequence menu.

Add Delay to The delay function adds a delay between steps.
Sequence

1. Press Delay Time[F2]> and enter the delay time.

Range: 100ms ~ 10s

2. Press to add the delay time to the

sequence editor.
+The delay time will be inserted as a step.

CenterFreq: 20.000MHz
ZeroSpan

Delay Time: 500ms

A The arrow keys can be used to move the cursor to
Note the desired step.

Pause Sequence The Wait to Go function is used to pause a
sequence until Continue[F1] is pressed. This is
useful for observing measurements before
moving onto the next step.

1. Press Wait to Go[F3]>.

*Wait to Go will be inserted as a step.

CenterFreq: 20.000MHz
ZeroSpan

Waittogo

2. When a sequence is running, Press Continue[F1]
to resume running the sequence.
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Insert Sequence Inserts another sequence into the current
sequence.

1. Press Do Sequence[F4]> and select a sequence to
insert into the current sequence.
«The selected sequence will be inserted as a step.

CenterFreq: 20.000MHz

Sequence: 2
ZeroSpan

& The current sequence cannot be inserted into
Note itself.
Delete Step Any step in the Sequence Editor can be deleted.

1. Use the arrow keys on the front @
panel to highlight the step you @C%@
wish to delete.

CenterFreq: 20.000MHz

Span: 10.000MHz
RefLevel: 0.00dBm

2. Press Delete Step[F5] > to delete the step.
«The selected step will be removed from the Sequence
editor.

CenterFreq: 20.000MHz

ReflLevel: 0.00dBm

Stop Editing 1. Press Stop Edit[F6].

2. The E=1Es] g Edit icon turns off.

233



GUYINSTEK GSP-9330 User Manual

Save Current After a sequence has been edited (and stopped)
Sequence it can be saved.

1. Press >Save Sequence[F4] > to save the
sequence.

2. The selected sequence will be saved.

Delete Current 1. Press >Delete Sequence [F5] > to delete
Sequence the current sequence.

Running a Sequence

Run Mode 1. Press > Sequence[F1] and choose a
sequence.

2. Press Run Mode[F6] and toggle the run mode:

Single Runs the sequence once only.

Cont. Runs the sequence continually until
Stop Running Sequence[F7] is
pressed (Note: the Stop Running
Sequence[F7] option only appears
when the sequence is running)

Run Sequence 3. Press Run Now[F7] to start running the selected
sequence.

4. Press Stop Running Sequence[F7] to stop the
sequence.
+In single mode the sequence will stop running when all
steps have finished.
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Tracking Generator

The tracking generator is a factory installed option that generates a
sweep signal with its sweep time and frequency range matching
the GSP-9330. The amplitude is maintained at a constant value over
the entire frequency range. This is useful for testing the frequency
response of a DUT.

+Activate the Tracking Generator — from page 235

*Normalize the Tracking Generator — from page 236

Activate Tracking Generator

Operation 1. Press >Tracking Generator[F1]>TG[F1] and
toggle the tracking generator on.
*The TG OUTPUT will be activated.

2. Press TG Level[F2] to set the output level of the
tracking generator.

Range: -50 to 0dBm

3. Press TG Lol Offset[F3] to set the offset level of
the tracking generator to compensate for
system gain/loss.

Range: 0dB to 50dB

4. Press TG Lvl Step[F4] to set the step resolution
of the TG level.

Range: Auto, Man; 0.5 to 50dB,
0.5dB step

5. Press Power Sweep|[F5] to vary the output
power of the TG to the rate of the sweep. At the
beginning of the sweep, the output power is at
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the set TG Level and increases/decreases
linearly to the set Power Sweep level at the end
of the sweep.

Range: -5dB to +5dB

Normalize the Tracking Generator

Background The normalize function subtracts the trace after
each sweep with a reference trace. The resultant
trace is added to a normalized reference level.

Connection When normalizing the TG output, connect the
TG output directly to the RF input.

After normalization, connect the DUT to the
tracking generator and connect the output of

the DUT to the RF input.
GSP
TG RF
OUTPUT INPUT

3y DUT |-

Normalization

Operation 1. Press (i )>Tracking Generator[F1]>TG[F1] and
toggle the tracking generator on.

2. Press Normalize[F6] to enter the Normalization
menu.

3. Press Norm. Ref. Level[F2] to set the vertical level
of the normalized reference.

Range: -100dB~100dB
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4. Press Norm. Ref. Position[F3] offsets the
normalized trace on the screen.

Range: 10~0 grid divisions.
(top to bottom)
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5. Press Norm.[F5] to toggle the normalized data
on/ off.

Alternatively, press Exe. Norm.[F1] to perform
the normalization again.

Trace without
normalization

Trace with
normalization
on and the

" reference
position set to
the 5% grid.

00.000MHz
MHz

06.04.24  2014-03-15

Alt-10.0d8

Response of
the DUT
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& The normalized data will be turned off
Note automatically if any X-axis related parameters are
changed or if the TG output level is changed.

The warning message, “Execute Normalization
again!” will appear under these circumstances.
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Power Meter

When using the optional power meter, the GSP can measure and
log the average signal power level of a DUT from -32dBm ~
+20dBm over an operating frequency range of IMHz to 6.2GHz.

*Activating Power Meter Mode — from page 240

*Data Logging Power Meter Measurements — from page 242

Activating Power Meter Mode

Connection Connect the power sensor to the front panel
USB A port on the GSP-9330.

Connect the RF source to the power meter.

GSP

USB A
PORT

Power Sensor Kk RF SOURCE

Opit

Operation 1. Press (o )> Power Meter[F2]>Power Meter[F1]
and toggle the power meter on.

& The power meter option will not be available if the
Note power meter is not connected properly.

2. The display splits into two screens. The top
screen shows the power measurement in dBm
or W. The bottom screen shows a graph of the
measurements.
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Power meter bar

Power meter measurement

Data log of power measurements

3. Press Power Unit[F2] and choose the unit:
Unit dBm, W

4. Press Frequency[F3] choose measurement
frequency (use the number pad):

Frequency 1MHz~6200MHz
Resolution: 1MHz

5. Press Sensor Mode[F4] to choose measurement
speed (and thus accuracy) of the power meter:

Low Noise: 100ms/sample, typical
Fast: 30ms/sample, typical

6. To create pass fail tests, press Pass/Fail Test[F5]
and set the following parameters:

High Limit[FI} -30dBm~20dBm
Low Limit{F2}. -30dBm~20dBm
Pass/Fail Test[F3]: On, Off

Pass Icon: PASS
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Fail Icon:

7. Press More[F6]>Trigger[F1] to toggle between a
free run (internal) trigger and an external
trigger.

Trigger: Free, Ext
Ext trigger input: 33VCMOSs  ™Men

GATE IN

8. Press More[F6]> MAX/MIN HOLD|[F2?] to toggle
the MAX/MIN hold measurements on/ off in
the power meter bar.

*The MIN/MAX measurements will be displayed in the

power bar meter in the center of the screen.

MIN HOLD MIN HOLD
measurement measurement

A Note

The return to the normal Spectrum Mode, turn the

power meter off by pressing > Power
Meter[F2]>Power Meter[F1] and toggle the power
meter off.

Data Logging Power Meter Measurements

Description

Operation
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When in Power Meter mode, the spectrum
analyzer is able to log the power meter
measurements over a user-defined time period
at user-defined intervals.

1. Press to enter the save menu.

2. Press Type[F2] and select Power Meter[F7].
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3. Data Source[F3] will automatically be set to
Power State.

4. Press PMET Record Option[F4] and set the
recording options:

Record Stop[FI]: Sets the recording time for
automatic data logging:
00 :00 :00 (continuous) or
00:00:01 ~23:59: 59
Record Step[F2]: 20msec ~ 999sec

5. Press Save To[F1] and select a destination

source:
Local Internal memory
SD Card: External micro SD card
& The micro SD card option will only be available
Note when a micro SD card is inserted into the front
panel port.

6. After a destination has been selected, recording
options appear.

7. To name the log file, press
Name[F1]. Name the selected file
using the F1~F7 keys, as shown
below or use the numeric keypad
to enter numbers.

Limitations:
*No spaces
«Only 1~9, A~Z, a~z characters allowed
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A Note

N

aa

C

-

D

)
e )

Lowercas

Return
Return
N
)

o
A A

A ———

Y
. i
)

[ Name>

. The filename appears on the bottom of the

screen as it is created.

Filename

Press to confirm setting the filename.

If the file name is not user-defined, a file name will
be automatically created in the following format:

File name: type_data source_file number.file
extension

The file number parameter is incremented each
time the same file type is created.

. To start recording power meter measurements,

press Record NowfF3].

A message “SaveFinish!!” will be displayed at the
bottom of the screen when the recording has
finished.
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Stop Recording To manually stop the recording, press Record
Stop[F2].
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Demo Kit

The demo kit is an ASK and FSK generator. The demo kit has three
pre-set frequencies, a number of baud rates and the ability to
output in normal mode, gated mode or in one of 5 selectable data
sequences.

+*Amplitude shift keying — from page 246.
*Frequency shift keying — from page 248.

Amplitude Shift Keying

Connection Connect the demo kit to the front panel USB A
port on the GSP-9330.

Connect the demo kit output to the RF input on
the GSP-9330.

GSP
USB A RF
PORT INPUT
DEMO KIT
Setup 1. Press > Demo Kit[F4]>Demo Kit[F1] and

toggle the demo kit on.

A The demo kit option will not be available if the
Note demo kit is not connected properly.

2. Press Modulation[F2] and select ASK[F1].
3. Press Frequency[F3] and select the frequency:

Frequency 315MHz, 433MHz,
868MHz
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. Press Baudrate[F5] and select the baud:

Baud 4800, 9600, 20000

. Press Output Mode[F6] and select gated, normal

mode or fixed data. The gated and normal
modes will output random data while the fixed
data option will output one of 5 pre-defined
data sequences.

Output mode Norm., Gated (100ms
period, 16ms on, 84ms
off), Fixed data.

. If fixed data was chosen for the output mode,

select the data sequence.

Data sequence for Seq1(00110101),
Fixed Data Seq2(10100101),
Seq3(00010010),
Seq4(11011100),
Seq5(10101010).

& Note

The data sequence above can be decoded in the
ASK/FSK demodulation function. Go to
Measure>Demod>ASK/FSK>View>Symbol to see
the output sequence.

Operation

The following will demonstrate how to observe
the ASK signal that was generated above.

This will assume the following settings were
set:

ASK modulation, frequency=315MHz,
Baudrate=4800, Output Mode=Normal

. Press >Center[F1] and set the center
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frequency to 315MHz.

2. Press >Span[F1] and set the span to
200kHz.

3. Press >Dem0d[F2]>ASK[F4] and toggle
ASK on.

See page 144 for setting details.

Frequency Shift Keying

Connection Connect the demo kit to the front panel USB A
port on the GSP-9330.

Connect the demo kit output to the RF input on
the GSP-9330.

GSP
USB A RF
PORT INPUT
DEMO KIT
Setup 1. Press (& )> Demo Kit[F4]>Demo Kit[F1] and

toggle the demo kit on.

A The demo kit option will not be available if the
Note demo kit is not connected properly.

2. Press Modulation[F2] and select FSK[F2].
3. Press Frequency[F3] and select the frequency:

Frequency 315MHz, 433MHz,
868MHz
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4. Press Deviation[F4] and select the frequency
deviation:

Deviation 25MHz, 50MHz
5. Press Baudrate[F5] and select the baud:
Baud 4800, 9600, 20000

6. Press Output Mode[F6] and select gated, normal
mode or fixed data. The gated and normal
modes will output random data while the fixed
data option will output one of 5 pre-defined
data sequences.

Output mode Norm., Gated (100ms
period, 16ms on, 84ms
off), Fixed data.

7. If fixed data was chosen for the output mode,
select the data sequence.

Data sequence for Seq1(00110101),
Fixed Data Seq2(10100101),
Seq3(00010010),
Seq4(11011100),
Seq5(10101010).

& The data sequences above can be decoded in the
Note ASK/FSK demodulation function. Go to
Measure>Demod>ASK/FSK>View>Symbol.

Operation The following will demonstrate how to observe
the FSK signal that was generated above.

This will assume the following settings were
set:
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FSK modulation, frequency=315MHz,
Deviation=25MHz, Baudrate=4800, Output
Mode=Norm.

1. Press >Center[F1] and set the center
frequency to 315MHz.

2. Press >Span[F1] and set the span to
200kHz.

3. Press >Dem0d[F2]>PSK[F5] and toggle
FSK on.

See page 151 for setting details.

250



GYINSTEK FILE

FILE

File Overview

The File function is used for basic file related operations including
navigation, sorting copying and deleting. The GSP-9330 has a
number of different file formats for trace data, limit lines,
amplitude correction, sequences and other panel operations. File
source and destination locations (local, USB or micro SD) can also
be chosen with the file function.

«File Type Overview — from page 252
«File Types — from page 253

+Using the File Explorer — from page 254
+Copy Files — from page 257

*Move Files — from page 257

*Delete Files — from page 258

*Rename Files— from page 259

*Save Files — from page 261

*Recall Files — from page 264

*Quick Save — from page 266
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Local The GSP-9330 has 16MB of local memory to
save data to.
USB The GSP-9330 can save to an external USB flash
memory drive.
USB Type: 1.1/2.0 (FAT32 and
NTFS formatted)
Micro SD The GSP-9330 can save to a micro SD card.
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File Types
Overview The file types are listed in order as shown in the
File menu.
State State data contains the state of the each of the
panel operations:
+Frequency «Limit Line
*Span *Sequence
*Amplitude «Trigger
*BW/AVG «Marker
*Sweep *Marker P
«Trace *Peak Search
*Display *Preset
*Measure *System
Trace Trace data contains the trace data in comma
separated values.
«Center frequency
*Span
*Resolution Bandwidth
*Video Bandwidth
«Reference Level
*Sweep Time
«Point number (trace data points)
Screen Contains the JPEG file of the display (800X600)
Limit Line The limit line data contains the following in

comma separated values:
*Point number
«Frequency value of point
+Magnitude of point
+Magnitude unit
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Correction Correction data contains the following
correction (line) data:
*Point number
+Frequency value of point
+Gain offset of point
«Unit

Sequence The sequence files contain the sequence number
and step operations for that sequence. This data
is not designed to be user editable.

Tracking The TG data contains:
Generator +TG level

*TG level offset

+TG level step

*Power sweep state and value
*Normalized reference level
*Normalized reference position
*Normalized state

Power Meter The power meter data contains:
*Date
+Time
*Power in dBm
«Start time/end time
«Step time

Using the File Explorer

Connect External To view files on a USB flash drive or micro SD
Memory card, insert the appropriate device into the front
panel port.

Selecting files 1. Press (7 )>File Explorer.

2. Select memory location:
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. The up/down arrow keys or the

LocalfFT]: Internal memory

USBIF2): Front panel USB
memory.

SD Card[F3]: Micro SD card.

scroll wheel can be used to move
up/down the file list.

. The left/right arrow keys can be @)
/rig Yy @ Cg)@

used to move to the next/previous
page of files in the file list.

& Note

The USB and micro SD card options will only be
available when a flash drive/SD card is inserted
into the front panel ports.

View Files by Type

The file explorer can be configured to only view
files of a certain type. For details on file types,
please see page 252.

. Press Type[F2] and select a file type to view:

All All file types can be viewed
State View state files only

Trace View trace files only

Screen View screen shots only
Limit Line View limit lines only
Correction View correction data only
Sequence View sequence files only

Power Meter ~ View power meter files only

After selecting a file type, only those types of
files will be listed by the file explorer.
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Sort Files Files can be sorted in ascending order by either
name or by date. By default, files are sorted by
name.

1. Press Sort By[F3] and choose the sorting type:

Name: Sort by alphabetical order

Date Sort by file creation date
Preview Image Image files can be previewed on the screen by
Files enabling the preview function.

1. Press More[F7]>Preview[F2] and toggle preview
on or off.

Example

5 9:22:09

O QuickJpgt ig 192330  2014/09/09 13:29.20
O QuickJpg2 irg 207841 2014/09/12 94136

Used: 642kB

Available 15358kB

& W hen Preview is turned on, other file types will not
Note be viewable.
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Copy Files

Description Files from local memory can be copied to
external memory such as a USB flash drive or
micro SD card and vice versa.

Connect External Insert either a USB flash drive or micro SD card

Memory into the front panel ports.

Selecting files 1. Press >Fi1e Explorer.
2. Select a file from local or external memory.
3. Press Copy to[F4].

4. Press Media [F1] and select the destination to
copy to (local, USB, SD card).

5. Press Copy Now [F2].

6. The file is copied to the destination directory.

& The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.

Move Files

Description Files from local memory can be moved to
external memory such as USB or micro SD card
and vice versa.

Connect External Insert either a USB flash drive or micro SD card

Memory into the front panel connectors.
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Selecting files 1. Press >File Explorer.
2. Select a file from local or external memory.
3. Press More[F7] > Mouve to[F1] .

4. Press Media [F1] and select the destination to
move to (local, USB, SD card).

5. Press Move Now [F2].

6. The file is moved to the destination.

A The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.

Delete Files

Description Any files in local memory or external memory
such as USB or micro SD card can be deleted.

Connect External To delete files on a USB flash drive or micro SD

Memory card, insert the appropriate device into the front

panel port.

Delete File 1. Press >File Explorer.
2. Select a file from local or external memory.
3. Press Delete[F5].
4. Press Delete Now[F1].
5. By default you will be asked to confirm any

files marked for deletion. Choose No[F1] to
cancel or Yes[F2] to confirm the deletion.
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Delete Warning 1. To disable the prompt to confirm the deletion of
a file, press Delete Warning[F2] and select an

option:

Don't Ask The user won’t be prompted
to confirm when a file is
deleted.

Ask Will prompt for the user to
confirm whether to delete the
file or not.

& The USB and micro SD card options will only be
Note

available when a flash drive/SD card is inserted
into the front panel ports.

Rename Files

Description Any files in local memory or external memory
such as USB or micro SD card can be renamed.

Connect External To rename files on a USB flash drive or micro
Memory SD card, insert the appropriate device into the
front panel ports.

Rename File 1. Press (_* )>File Explorer.

2. Select a file from local or external memory.
3. Press Rename[F6].

4. Rename the selected file using the
F1~F7 keys, as shown below or use
the numeric keypad to enter
numbers:
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Limitations:
*No spaces
*Only 1~9, A~Z, a~z characters allowed

N

aH

Y Y R
o I
AN

—
(=X
A

Lowercase)—{

Return
Return
2
)

Cancel renaming the file

Y

{Rename>

Y
. ’
A

5. The filename appears in the list as it is
renamed.

Filename

2014:03-23

6. Press to confirm the renaming of the file.

& The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.
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Save Files

Description Any function settings or configurations that
have been applied to the spectrum analyzer can
be saved using the key.

Connect External To save files on a USB flash drive or micro SD

Memory card, insert the appropriate device into the front
panel ports.

& To save power meter data (data logging) please see

Note page 242. Saving power meter data will not be

described in this chapter.

Save File 1. Press to enter the Save menu.

2. Press Type[F2] and select a file type to save. See
page 252 for details on file types:

State: State data

Trace: Trace data

Screen: Screen shots

Limit Line: Limit line data
Correction: Correction data
Sequence: Sequence files
Power meter Power meter data*

*see page 242 for details.

3. Press Data Source[F3] to select a data source for
the file type if possible:

For state data: ~ Local state data (fixed, not

selectable)
For trace data: Tracel~4
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For screen shots: Normal: Screen shot is saved
as is
Save Toner: inverts the image
file color to reduce ink when

printing.
For limit line: Limit line 1~5
For correction:  Correction data 1~5
For sequence: ~ Sequence 1~5

For power meter: Power state*
*see page 242 for details.

4. For trace data, press Format[F4] to select the
format type to save:

Trace: Save trace data only
Trace+State: Save trace and state data

5. Press Save To[F1] and select a destination

source:

Register 1~6: Internal memory registers,
these internal registers are not
part of local memory

Local: Internal memory

USB: External memory

SD Card: External micro SD card

6. After a destination has been selected, the file
can be named or saved immediately.

7. To name the selected file, press
Name[F5]. Name the selected file
using the F1~F7 keys, as shown
below or use the numeric keypad
to enter numbers.:

Limitations:
*No spaces
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«*Only 1~9, A~Z, a~z characters allowed

o
A A A

[ Name>

Cancel naming the file

8. The filename appears on the bottom of the
screen as it is created.

15 075MHz

P 30.000MHz
W 1MHz 29.850MHz weoep 348ms

FILENAME

Filename

9. Press to confirm the naming of the file.

& If the file name is not user-defined, a default
Note naming scheme will be used. See the note below
for details.

10. To save the selected file type, press Save
Now|[F7].

A message “SaveFinish!l” will be displayed at
the bottom of the screen when the save is
successful.
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A Note

If the file name is not user-defined, a file name will
be automatically created in the following format for
data files:

File name: Type_data source_XX.file extension

The image file names will be automatically created
in the following format:

File name: Quick]pgX.jpg

The X parameter is incremented each time the
same file type is created.

A Note

Recall Files

The USB and micro SD card options will only be
available when a flash drive/SD card is inserted
into the front panel ports.

*The power meter option will only be available if
the power meter option is plugged in. See the
Power Meter section on page 240 for power meter
details.

Description

Most files that have previously saved a setting

or state can be recalled using the key.
The exception to this are the data logging
settings, see page 240.

Connect External
Memory

To recall files from a USB flash drive or micro
SD card, insert the appropriate device into the
front panel ports.
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2. Press Type[F2] and select a file type to recall.
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See page 252 for details on file types:

State: State data
Trace: Trace data
Limit Line: Limit line data
Correction: Correction data
Sequence: Sequence files

3. Press Destination[F3] to select the destination for
the file type if possible:

For State data: ~ Local state data (fixed, not
selectable)

For Trace data:  Tracel~4

For Limit Lines: Limit line 1~5

For Correction:  Correction data 1~5

For Sequence: ~ Sequence 1~5

Recall File 1. Press Recall From[F1] and select a source
location:
Register 1~6: Internal memory registers,

these internal registers are not
part of local memory

Local: Internal memory
USB External USB memory
SD Card: External micro SD card

2. To Recall the selected file type, press Recall
Now[F4].

3. A message “Finish!!” will be displayed at the
bottom of the screen when the recall is
successful.

& The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.
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Quick Save

Description

The key is a hot key to save files with a
single press.

The type of file that is saved is pre-configured

with the key.

By default, the the key will save screen
shots to the local memory or to an external flash
drive (if inserted).

Supported File
Types

Screen, trace, state, limit line, correction,
sequence, power meter*.

*power meter accessory must first be installed
before it can be saved.

Connect External
Memory

To save files to a USB flash drive or micro SD
card, insert the appropriate device into the front
panel ports.

Quick Save Setup 1.

Press the key and configure the file Type,
Data Source and Format. See page 261 for

details.

Using the Quick 1.
Save key
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Press m at any time to save the selected file
type using the settings above.

A “Save Finish!!” message will be shown at the
bottom of the screen when the save has been
completed.
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& The file name will be automatically created in the
Note following format for data files:

File name: Type_data source_XX.file extension

The image file names will be automatically created
in the following format:

File name: Quick)pg_XX.jpg

The XX parameter is incremented each time the
same file type is created.

& The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.
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REMOTE CONTROL

This chapter describes basic configuration of
IEEE488.2 based remote control. For a command
list, refer to the programming manual,
downloadable from the GW Instek website,
www.gwinstek.com

Interface Configuration ...........cceuoeereiiiiieiiiiiiiinieciiieeees

Configure to USB Remote Interface ..o
Configure GPIB Interface
Configure the LAN and LXI Interface
Configure the WLAN Interface
Configure RS232C ...
RS232C Remote Control Function Check .....oooveveieevveeeiceeeeeeceeeeeevene
XTI Browser Interface and Function Check
GPIB/LLAN/USB Control Function Check
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Interface Configuration

Configure to USB Remote Interface

USB PC side Type A, host

configuration connector
GSP side Rear panel Type B, slave
connector
Speed 1.1/2.0 (full speed/high speed)
USB Class USB TMC (USB T&M class)

Panel operation 1. Connect the USB cable to the rear =
panel USB B port.

2. Press >More[F7]>RmtInte1face
Config[F1]>USB Mode and toggle the USB mode

to Device.

& It may take a few moments to switch USB modes.
Note

Configure GPIB Interface
To use GPIB, the optional GPIB port must be installed.

Configure GPIB 1. Ensure the spectrum anlayzer is off before
proceeding.

2. Connect a GPIB cable from a
GPIB controller to the GPIB port
on the spectrum analyzer.

3. Turn the spectrum analyzer on.
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4. Press >More[F7]>RmtInterface
Config[F1]>GPIB Addr[F1] and set the GPIB
address.

GPIB address 0~30

GPIB constraints *Maximum 15 devices altogether, 20m cable length, 2m
between each device
+Unique address assigned to each device
+At least 2/3 of the devices turned On
*No loop or parallel connection

Configure the LAN and LXI Interface

The GSP-9330 is a class C LXI compliant instrument. The LXI
specification allows instrumentation to be configured for remote
control or monitoring over a LAN or WLAN. The GSP-9330 also
supports HiSlip. HiSlip (High-Speed LAN Instrument Protocol) is
an advanced LAN based standard for 488.2 communications.

For details on the LXI specification, compliance classes and HiSLIP,
please see the LXI website @ http:/ /www.Ixistandard.org.

Background The LAN interface is used for remote control
over a network. The spectrum analyzer
supports DHCP connections so the instrument
can be automatically connected to an existing
network. Alternatively, network settings can
also be manually configured.

LAN IP Address Default Gateway
conflguratlon Subnet Mask DNS Server
Settings
DHCP on/off
Connection Connect an Ethernet cable from L
the network to the rear panel LAN B
port.
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Settings 1. Press >M0re[F7]>RmtInterface[F1]>
LAN[F2]>LAN Config[F1] to set the LAN
settings:

/P Address[F1]  Sets the IP address.

Subnet Mask[F2] Sets the subnet mask.

Default

Gateway[F3] Sets the default gateway.

DNS ServerfF4] Sets the DNS server address

LAN ConfigfF5] Toggles the LAN
configuration between DHCP
and manual settings.

Hint: Use dotted decimal notation when entering
/P addresses, ie., 172.16.20.8

2. Press Apply[F6] to confirm the LAN
configuration settings.

Display Icon The LXI icon turns green when connected
to a LAN and will flash if the
“Identification” setting is on, see page 280.

Set Password The password on the LXI webpage can be set
from the spectrum analyzer. The password is
shown in the system information.

By default the password is set to: IiWNpwd

1. Press >M0re[F7]>RmtInterface
Config[F1]>LAN[F2]>LXIPassword[F3] to set
the password.

2. Enter the password using the
F1~F7 keys, as shown below, or
use the numeric keypad to enter
numbers:
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Limitations:

*No spaces
«*Only 1~9, A~Z, a~z characters allowed

Y A
o D

pel
@
g
3
. ’
AN

—
o

Y
a
A

ABCDE )—ﬁ
)
)
)

[Rename>)—<

Return

Cancel password

Menu tree to enter the password

The password appears on the bottom of the
screen as it is created.

| OHz
PASSWORD

Password

Press to confirm setting the password.

Hi SLIP Port 1.
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Press >M0re[F7]>RmtInterface
Config[F1]>LAN[F2] >HiSLIPPort to see the Hi
Slip Port number.

HiSlip port 4880
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Reset LAN It may be necessary to reset the LAN
configuration settings before the LAN can be
used.

1. Press >M0re[F7]>RmtInterface
Config[F1]>LAN Reset[F3] to reset the LAN.

2. It may take a few moments before the LAN is
reset.

& Each time the LAN is reset, the default
Note password is restored.

Default password: IxiWNpwd

Configure the WLAN Interface

The WLAN settings operate using any standard 3G USB modem.
For remote locations, using a 3G modem allows you to access the
GSP-9330 web server or to control the GSP-9330 via remote control
commands.

Background To use the GSP-9330 as a server using a 3G
modem, you must first obtain a fixed IP address
from a network provider. Each provider will
assign different fixed IP addresses.

WLAN IP Address Default Gateway

configuration Subnet Mask DNS Server
Settings
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Connection

Connect the 3G USB modem to the front panel
USB A port.

The 3G status icon . will appear when the 3G
USB adapter is connected. When it is first
connected it will be grayed-out to indicate that
it is connected but not activated.

GSP

USB A
PORT

3G USB Adapter

Settings

274

. Insert the 3G USB modem into the front panel

USB A port and wait for the 3G USB . icon to
appear.

. Press >More[P 7]>RmtlInterface[F1]>

LAN[F2]>WLAN Config[F2]>Apply[F6] and wait
for the 3G USB modem to establish the WLAN
settings.

“Finish!”, is shown when the configuration is
complete.

. The network settings will be displayed in the

System menu icons.
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WLAN settings

------

Display Icon The 3G USB icon turns green when a
successful connection has been made.
Set Password The password on the LXI webpage can be set

from the spectrum analyzer. The password is
shown in the system information.

By default the password is set to: IXiWNpwd

4. Press >M0re[F7]>RmtInterface
Config[F1]>LAN[F2]>LXIPassword[F3] to set
the password.

5. Enter the password using the
F1~F7 keys, as shown below, or
use the numeric keypad to enter
numbers:

OOOO
OOOO
WOOO

Limitations:
*No spaces
*Only 1~9, A~Z, a~z characters allowed
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N

aa

Lowercas

]
= ]
%
Return [ e }
=
J

Cancel password

ABCDE )—ﬁ
)
)
)

[ ———

[Rename>)—<

Menu tree to enter the password

The password appears on the bottom of the
screen as it is created.

PASSWORD

Password

Press to confirm setting the password.

Hi SLIP Port 8.

Press >M0re[F7]>RmtInterface
Config[F1]>LAN[F2] >HiSLIPPort to see the Hi
Slip Port number.

HiSlip port 4880

Reset LAN

It may be necessary to reset the LAN
configuration settings before the LAN can be
used.

Press >More[F7]>RmtInterface
Config[F1]>LAN Reset[F3] to reset the LAN.

10. It may take a few moments before the LAN is
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& Each time the LAN is reset, the default
Note password is restored.

Default password: IxiWNpwd
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Configure RS232C

Background The RS232C interface is used for remote control
with a PC.
RS232C Baud Rate Stop bit: 1 (fixed)

Configuration Parity: none (fixed) Data bit: 8 (fixed)

settings

Connection Connect an RS232C cable from RS232
the PC to the rear panel RS232
port.

1. Press >More[F7]>RmtInterface
Config[F1]>RS232 BaudRate[F4] to set the baud

rate.

300 600 1200
2400 4800 9600
19200 38400 57600
115200

RS232C Remote Control Function Check

Functionality Invoke a terminal application such as Realterm.
check

To check the COM port No, see the Device
Manager in the PC. For WinXP; Control panel
— System — Hardware tab.

Run this query command via the terminal after
the instrument has been configured for R5232
remote control (page 278).

*idn?

This should return the Manufacturer, Model
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number, Serial number, and Firmware version
in the following format.

*GWINSTEK,GSP9330, XXXXXXXX,V3.X.X.X
Manufacturer: GWINSTEK
Model number : GSP9330
Serial number : XXXXXXXX

Firmware version : V3.X.X. X

& For further details, please see the programming
Note manual, available on the GW Instek web site @
www.gwinstek.com.
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LXI Browser Interface and Function Check

Functionality
check

Enter the IP address of the spectrum analyzer in
a web browser after the instrument has been
configured and connected to the LAN (page
270) or WLAN (page 273).

http:// XXX XXX XXX XXX

The web browser interface appears:

Welcome Page

The Welcome Page lists all the LXI and
LAN/WLAN configuration settings as well as
the instrument identification. The instrument
identification can be disabled from this page.

Instrument Welcome Page

Identification ON @ OFF
S o LXI Device Model GSPO330
Gt Image Manufacturer GWINSTEK

Serial Number EN203018

Description GWINSTEK GSP9330.018

LXI Extended Functions  LXI HiSLIP
LXI Version 14 LXI Core 2011
Firmware Revision V3.000

DNS hostname

mDNS hostname GSP9330-819 local

MAC Address 00:22:24:00:0A:BC
TCP/IP Address 172.16 22 200
TCPIP::172.16.22.200:1nst0 :INSTR

Tnstrument Address String g
TCPIP::172.16.22.200:-hislip0.4880: INSTR

& Note

EX]| The LXI icon on the GSP-9330 display wil
flash when the Identification setting is
turned on.
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View & Modify The View & Modify Configuration allows you
Configuration to modify the LAN settings from the browser.

Press the Modify Configuration button to modify
any of the configuration files.

A password must be entered to alter the
settings.

Default password: IxiWNpwd
[Note: password is case sensitive.]

G INSTEK LXT]

Welcome Page: Configuration of your spectrum analyzer
Apply | Undo Change | Factory Defauls

luipelt ). Hado Change, | Eackory, Dolauits, |
View & Modify Con
" Awomatc(DHCP)

TCP/IP Configuration Mode
SCPI Command Manual

IP Address 172.16.22.200

Get Image

Subnet Mask 1256.265.128.0
Gateway 172.16.0.254

172.16.1.248
172.16.1.252

DNS Server

DNS hostname GSP9330-018
Description GWINSTEK-GSP9330-018
HiSLIP Port 880

Password Change Password
(Enter Old Password)

(Enter New Password)

(Confirm New Password)

& If the “Factory Defaults” option is chosen, the
Note password will be reset back to the default
password

It will also be necessary to manually reset the
spectrum analyzer when a message prompts you
to do so on the web browser.
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SCPI Command The SCPI Command page allows you to enter
SCPI commands directly from the browser for
full remote control. Please see the programming
manual for details. A password must be
entered before remote commands can be used.

Default password: IxiWNpwd

[Note: password is case sensitive.]

GWINSTEK.

Welcome Page SCPT Command
Clear Window

View & Modify Configuration

SCPI Command

GetImage

*RST
“IDN?
SYST:ERR?

Enter SCPI command or query

Write | Read | Write & Read

Get Image The Get Image page allows the browser to
remotely capture a screenshot of the GSP-9330
display.

A For further details, please see the programming
Note manual, available on the GW Instek web site @
www.gwinstek.com.
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GPIB/LAN/USB Control Function Check

Functionality Please use the National Instruments
check Measurement & Automation Controller
software to confirm GPIB/LAN functionality.

See the National Instrument website,
http:/ /www.ni.com for details.

& For further details, please see the programming
Note manual, available on the GW Instek web site @
www.gwinstek.com.
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FaQ

| connected the signal but it does not appear on screen.

| want to see which optional items are installed.

The performance does not match the specification

| connected the signal but it does not appear on screen.

Run Autoset and let the GSP-9330 find the best display scale for
your target signal. Press the Autoset key, then press Autoset[F1].
For details, see page 64.

| want to see which optional items are installed.

Check the optional items in the system information window. Press
the System key — System Information[F1]. For details, see page 117.

The performance does not match the specification.

Make sure the device is powered On for at least 45 minutes, within
+20°C~+30°C. This is necessary to stabilize the unit to match the
specification.

For more information, contact your local dealer or GWInstek at
www.gwinstek.com / marketing@goodwill.com.
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APPEN DIX

Replace the Clock Battery

Background The system clock and wake-up clock keep time
using a button battery.
Battery type: CR2032, 3V, 210mAh
Connection 1. Turn off the GSP-9330 and

remove the battery cover and
battery (if connected).

2. Replace the battery with the same type and
specification.
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Glossary of Acronyms

Acronym Definition

2FSK Binary Frequency Shift Keying

3GPP 3'd Generation Partnership Project

ACPR Adjacent Channel Power Ratio

BS Base Station

CF Center Frequency

CH BW Channel Bandwidth

CH SPC Channel Space

CISPR International Special
Committee on Radio Interference

CNR Carrier to Noise Ratio

CsO Composite Second Order

CTB Composite Triple Beat

DANL Displayed Average Noise Level

Def. Default

DL Down Link

DSSS-OFDM Direct Sequence Spread Spectrum- Orthogonal
Frequency Division Multiplexing

EMC Electromagnetic Compatibility

EMI Electromagnetic Interference

EMS Electromagnetic Susceptibility

ERP-CCK Extended Rate Physical layer- Complimentary Code
Keying

ERP-DSSS Extended Rate Physical layer- Direct Sequence
Spread Spectrum

ERP-OFDM Extended Rate Physical layer- Orthogonal Frequency
Division Multiplexing

ERP-PBCC Extended Rate Physical layer- Packet Binary
Convolutional Code

ETSI European Telecommunications Standards Institute

FDD Frequency-Division Duplexing

IF Intermediate Frequency

HiSLIP High Speed LAN Instrument Protocol

LOI Local Oscillator

LPF Low Pass Filter

LXI LAN eXtensions for Instrumentation

OCBW Occupied Channel Bandwidth
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PSD
P1dB
RBW
REF
SEM
SINAD
TDD
TG
TOlI
UE
up
VBW

Power Spectral Density
One-dB compression point
Resolution Bandwidth
Reference

Spectrum Emission Mask
Signal to Noise and Distortion Ratio
Time-Division Duplexing
Tracking Generator

Third Order Intercept

User Equipment

Up Link

Video Bandwidth
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The following default settings are the factory configuration settings
for the spectrum analyzer (Function settings/ Test settings).

Frequency
Center Frequency: 1.625GHz  Start Frequency: OHz
Stop Frequency: 3.25GHz CF Step: Auto
Frequency Offset: OHz
Span
Span: 3.25GHz
Amplitude
Reference level: 0.00dBm Attenuation: Auto
Scale Div: 10 Scale: Off
Y Axis: dBm Scale Type: Log
S%%;%n;e level offset: Correction: Off
Input Z: 50Q Input Z calibration: 6.000dB
Preamp: Bypass
Autoset
Amp.Floor: Auto Span: Auto
BW/AVG
RBW: Auto VBW: Auto
VBW/RBW: N/A Average: Off
Average Power: Log Power  EMI Filter: Off
Sweep
Sweep Time: Auto Sweep: Continuous
Gated Sweep Mode: Off Gate Delay: 50ms
Gate Length: 540ms Sweep Control: Norm
Trace
Activated traces: trace 1 Trace Type: Clear and Write
Trace Math: Off Detection: Auto, Normal
Display

288

Window Setup: Spectrum
LCD Backlight: On

LCD Brightness: Hi
Display Line, -50.0dBm, Off
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Meas

All measurement functions: Off
EMC Pretest
All EMC test functions: Off

Limit Line

Limit lines: Off Pass/Fail Test: Off
Trigger

Free Run Trigger Condition: Video

Trigger Mode: Norm. Trigger Delay: 50ms
File

Type: All Sort by: Name
Quick Save

Type: Screen Data Source:Normal
Save

Type: Screen Data Source:Normal
Recall

Type: State Destination: Local State
Marker

Marker: Off Data Source:Normal
Marker»

N/A
Peak Search

Peak Track: Off Peak Excursion: 3dB

Peak Threshold: -50dBm Peak Table: Off
Mode

Mode: Spectrum
Sequence

Sequence Off
Option Control
Tracking Generator: Off Power Meter: Off

System

Language: region dependent Power On: Preset
Preset Type: Factory Preset  Alarm Output: Off
Remote Interface Config

GPIB Address: 3

LAN: DHCP

LXI Password: IxiWNpwd

HiSPIP Port:4880

RS232 BaudRate: 115200

USB Mode: Host
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Menu Tree
Amplitude
Ref Level Y Axis>
30d8 | [ dBm dBm
Attenuation
10dB Lo Scale Tpriﬁ dBmv
Auto Man Log
Scale/Div .
10 5 2 1 Correction> = dBuv
RefLvIOffset
Auto Scale 0.000dB Watts
Scale Preamp
On off Auto  Bypass Volts
Scale Pos. Return
Left Cent. Right 2/3
More || More
1/3 2/3
T\
Select ]
Correction> Correction 1 9 Point Nulrg 0 Inpu%
1 50
Correction i Frequency Input Z Cal
on Correction 2 1.9345 GHy 5 0o00s
= Edit> — Correction 3 G&;IB gg%j%
Correction 4
Save .
Correction Correction 5
Delete )
Correction Delete Point
Return
Return Return 313
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Y Axis>
dBm
dBm dBm dBmVv
dBmvV -dBm \Y
— dBuv w mvV
Watts | mw w
Volts H uw dBm
nw
pwW
% dBuv % w \
\% mw mV
mV uw uv
uv nw dBmvV
dBm pw dBuv
dBm dBm
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Frequency, Span, Autoset,

BW Avg, Sweep

Frequency

Span

Autoset

Center Freq Span
1.2345GHz 1.2345GHz Autoset
Amp. Floor
L fred Full Span -80.00dBm
) Auto Man
Span
Stop Freq Zero S
pan 3.000000MHz
1.2345GHz Auto Man
CF Step
1.00000MHz Last Span
t Man
Freq Offset
0.00Hz
BW/Avg Sweep
RBW Sweep Time
1MHz LOG Power 50.00 ms
Auto Man Auto Man
VBW
1MHz Volt Average Sweep Single
Auto Man
VBW/RBW
1.00000 Power Average Sweep Cont
Average Gated Sweep
20 Mode
On Off On Off
Average Type> | | Gate Delay
Log Power 50.0 ms
EMI Filter Gate Length
On Off 540 ms

Sweep Control

Norm. Fast
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Limit Line
Limit
( Line ) J L
Edit Limit Line> Point Num o
Select Limit> 1 9 1 Limit 1
Pass/Fail " p Frequency S
Test> [ Point by Point> = OHz Limit 2
Trace Data to Limit -
Limit Line> [ 0.00 dBm Limit 3
Mkr Data to imi
Limit Line> [7] Limit 4
Save Limit Line Limit 5
Delete Limit ;
Line Delete Point
Return Return
High Limit> i Point Num Create Limit Line
L off Limit1 | L= 1 Now
Low Limit> | | Limit 2 Mkr Data to Limit Offset
ff Point 0.000dB
Pass Criterion
All-In  Max-In Limit 3 Limit Offset
Min-In
Pass/Fail Test -
on Limit 4
Pass/Fail Mode L
Single  Cont. Limit 5
OFF
Return Return Return
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Trigger, Sequence

Trigger

Free Run Video> POSVIdEO Eﬂgg
Trigger Ext. Ed vid |
Condition> xt. Edge ideo Leve
Video Pos Neg 10.00dBm
Trigger Mode Trigger Freq
Norm. Sgl. Cont. 1.12345M Hz
Trigger Delay
50.0 ms
Action Now
Return Return
Only for when “Wait to
go” is used in the
sequence
Sequencei J Start Edit Ia Sequence 1 9 Continue
Edit> De'?’og'mg Sequence 2
Wait to Go Sequence 3
Save Sequence Do Sequencei I Sequence 4
Delete Sequence Delete Step Sequence 5
Run Mode !
Single  Cont. Stop Edit
Run Now —| Return Sto% Equur;nr:rgg
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Trace
Trace
Select Trace> J TR1>
1 Trace Math> Trace 2 Trace 1
Detection>
Clear & Write Normal = Tr;f:zezz Trace 2
Auto Man
Max Hold Power Diff
-130.0dBm TR1-TR2 Trace 3
Log Diff
Min Hold -50.00dBm Trace 4
TR1-TR2+Ref
Log Offset
View 0.00dB
TR1 + Offset
Blank OFF
More
12 — Return Return
Auto Quasi Peak
Normal Average
Peak +
Peak -
Sample

RMS Average

EMI>
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Display

: Active Win.
Window Setup> Spectrum Upper  Lower
LCD Brightness - Alternate
Hi Mid Lo Split Spectrum> Sweep
O_LnCD Backli%hf% Spectrogram
Display Line
-50.00dBm Topographic
On Off
Spectrogram
+
Spectrum
Topographic
+
Spectrum
Return Return
T\
Spectrogram Topographic : :
Marker Marker X A;();(')S( X A;j;'i
Qn Qff On Off
Y Axis Y Axis
Ref.> Ref.>
© € yyy yyy
Delta> Delta>
Restart
Return Return
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Select Markerz _,\9 Marker 1 L Delta
on off Marker 2 Move Ref
Normal Marker 3 Move Delta
Delta> = Marker 4 Movesggir:
Function> H Marker 5 MO\geﬁfg:

All Off Marker 6
Mcl);g H Return

Marker Trace>

Trace 1 Auto Freq Counter> o, "ed Counter
Auto Man =
; Resolution
orl]\/larker Table Trace 1 orl;/larker Nogg KHz
= Auto Man

Trace 2

Trace 3

Trace 4
Return 2/2 Return Return
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Peak Search, Marker »

Peak
Search

Peak Search 9 on Peak Tregf_kf e on Peak Ta%lg:f
Peak Excursion Peak Sort
Mkr>Center 10.00dB Ereq Amp
Peak Threshold
Next Peak -50.00dBm
On
Next Peak Right
Next Peak Left Peak Table>
Min Search
More Return
12 202 Return

Mkr>Center

Mkr>Start

Mkr>Stop

Mkr>CF Step

Mkr>RefLvl
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System

information S Pessage Lo Prosel User Preset
Error message> ] Prev Page Preset Type> Factory Preset

Date/Time> =M\
Pwr On/preset> }—i

Alarm Output Clear Error
On Off queue
Mc{;g - Return Return

Rmt Interface Year Hour
I; Config> | 9} Set Date> 2011 | ) 5
Upgrade Set Time> = Monfg Mmuﬁ
. Wake-Up Clock Day Second
Service> Edit> 5 52

Clock

On off

Return

202 Return Return Return
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From: System>
Language

English

fEi A o

TR

Pycckuii

HAGE

Return

From: System>Date/
Time>Wake-Up Clock Edit>

Select Clo Cki Clock 1 Monday
State

on Off Clock 2 Tuesday

Holu:; Clock 3 Wednesday

Minute Clock 4 Thursday
08

Rept. Single Clock 5 Friday
Select Date>

Monday Clock 6 Saturday

Return Clock 7 Sunday

300




GYINSTEK APPENDIX
From: System>More 1/2>
Rmt Interface Config>
GPIB Addr , IP Address
5| | LAN Config> 0,000
: Subnet Mask
LAN> = WLAN Config> 0.0.0.0
Default
LAN Reset j=— LXIPassword> Gateway
0.0.0.0
RS232 Hi SLIP Port
Baud Rate> DNS Server
115200 4880
USB Mode LAN Config
Host  Device DHCP Manual
Apply
Return Return Return
IP Address
300 | 19200 OK 0.0.0.0
Subnet Mask
600 38400 Cancel 0.0.0.0
Default
1200 57600 Gateway
0.0.0.0
2400 115200 DNS Server
4800
9600 Apply
More 1/2 || Return Return
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From: System>More 1/2> Rmt
Interface, Config>LAN>LXIPassword

ABCDE Al a
FGHIJ B b
KLMNO c c
PQRST D d
UVWXY E e
VA Lowercase {—
Return Return Return
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Option Control

Option
Control

Tracking TG
Generator> On Off 9 Exe. Norm.
Norm.
Power Meter> g%é‘;é’ﬁ,: Ref. Level
) 0.000dB
Norm.
TG LB/IOC())féZ%t Ref. Positigg

TG Lvl Step
Demo Kit> 0.000dB on Noon

Auto Man =

Power Sweep

0.000dB

On Off

Normalize>
Return Return
Power Meter 9 High Limit
On -10 dBm
Power Unit Low Limit
dBm mV -10 dBm
Frequency Pass Fail Test

3 MHz On

Sensor Mode
LowNoise Fast

Pass/Fail

Test> [

More
1/2

Return

Return
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From: Option Control>Demo Kit

l

Demo Kit
On (0]

Modulation>
ASK

L

Frequency>
315MHz

ASK

FSK

Deviation>
25kHz

Baudrate>
4800

Output Mode
Gated

Return

Modulation = FSK only

Normal

4800

25kHz

315MHz

Gated

9600

50kHz

433MHz

Seql
00110101

20000

868MHz

Seq2
10100101

Seq3
00010010

Seq4

11011100 [

Seq5
10101010
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File

File Explorer>
Local

Media>
Local

Media>
Local

Local

Type>
All

Copy Now

Move Now

usB

Sort by
Name Date

SD Card

Copy to>

Delete>

Rename>

Move to>

Return

Return
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.sta

.tra

Jpg

.cor
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From: File>Type

GSP-9330 User Manual

From: File>Delete

l

All = Sequence Delete Now No
State pmet Power Meter B?)lr?’tteA\ng?rrKgE Yes
Trace Delete All
Screen
Limit Line
Correction
More 1/2 {4 Return 2/2 Return
From: File>Rename
l
ABCDE — A a
FGHIJ B b
KLMNO C c
PQRST D d
UVWXY E e
z Lowercase |-
Return Return Return
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Save
(Mode = Power Meter)
See: Save>Save To
Save To> Record Stop Hour
Local K State 00: 00: 00 06
Type> A Record Step Minute
State | b 1s 07
Data Source> A Second
Local State | M Screen 08
PMET
Record Option>
Name>
Record Stop
Record Now Power Meter Return Return
See: File>Rename é&—
According to type:
Power Meter
L State D Local State Normal
Save Toner
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From: Save>Save To

l

Register> Register 1
Local Register 2
USB Register 3

SD Card Register 4
Register 5

Register 6

Return Return
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(Mode = Spectrum)

> See: Save>Save To

5

Savelz_ (‘)I'g; \9 State Trace
1;_%2%: Trace Trace + State
Data S_Iprgz:(::i L Screen
Fofl_npaa; - . Line Line
Name> |—M— Correction
Sequence
Save Now

—> See: File>Rename

)

L

L

)

L

Local State Trace 1 Normal Limit 1| | Correction 1| | Sequence 1
Trace 2 | | Save Toner Limit 2 | |Correction 2 | |Sequence 2

Trace 3 Limit 3 | |Correction 3 | |Sequence 3

Trace 4 Limit 4 | [Correction 4 | [Sequence 4

Limit 5 | |Correction 5 | |Sequence 5
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Recall

(Mode = Power Meter)

Recall

Recall Flr_%rg; Register> Register 1
Tg?:tz — Local Register 2
ngggﬁggg —— USB Register 3
Recall Now SD Card Register 4
Register 5
Register 6
Return Return

According to type:

L State | L Local State

.sta
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(Mode = Spectrum)
Recall F[%?; J sta State L Register> Register 1
Type> .
Tyrgce ra Trace Local Register 2
Destination> .
Trace 1 [ uUsB Register 3
Recall Now imt Line Line SD Card Register 4
m
Correction Register 5
.cor
Sequence Register 6
.seq
Return Return
Local State Trace 1 Limit 1| | Correction 1| | Sequence 1
Trace 2 Limit 2 | |Correction 2 | [Sequence 2
Trace 3 Limit 3 | |Correction 3 | [Sequence 3
Trace 4 Limit 4 | [Correction 4 | |Sequence 4
Limit5 | |Correction 5 | [Sequence 5
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Measure

See: Meas>Demod

Measure

Channel Main CHBW
Analysis> ACPR Setup> 2.000000MHz 9 CNR/CSO/CTB>
Main CH
Demod> on AC%’; HLimit Harmonic>
= 0.00dBm
Main CH NdB
2FSK ey OCBW Setup> e LLimit ;
0.00dBm Bandwidth>
) OCBW CH SPC
Phase Jitter> = on Off 2.000000MHz P1dB>
Channel ADJCH
SEM> Move Up Setup> []
Channel Def. Help
To> Move Down On Off
More Return
12 Return Return 2/
| I\ 7\ VoV
Phase Jitter 2FSK CHBW Select Adj Ch> :
on off on off 2.000000MHz 1> AdjChl
Peak Threshold
Start Offset CH SPC :
OHz on -50.00dBm 2.000000MH2 on off AdjCh2
Stop Offset Max Hold OCBW % ADJ CHBW :
OHz -130.0dBm 90.0% 2.000000MHz AdiCh3
ADJ CH Offset
Restart 2.000000MHz
ADJ CH
Limit Edit> H Limit
0.00dBm
) ADJ CH
gr?ss/Fall Tgs# L Limit
T 0.00dBm
Return Return Return Return
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From: Measure>Demod

l

From: Measure>TOlI

l

APPENDIX

From: Measure>More>

NdB Bandwidth

; Earphone Out TOI NdB BW
AM Analysis> on off on Off on Off
; Volume Reference N dB
FM Analysis> 10 Lower Upper 0.000dB
Digital Gain o
Limit
Sound> Control
0.000dB -30.00dBm
Demod Type Pass/Fail Test
ASK> AM M on i
FSK>
Return Return Return Return
From: Measure>More>CNR/CSO/CTB
Setup> Noise Marking
CNR CNR> Min  AMarker Restart
CNR
on Off CSO
CNR
CH SPC CTB> {=—
6.000 MHz
Channel
Move Down
Channel
Move Up
Return Return Return Return
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From: Measure>Demod>AM

Analysis
AM Analysis IF Bandwidth
on o 300kHz Bypass
LPF>
Setup> | Bypass 1.6MHz
Min/Max Reset Time Axis> 781kHz
) Decimation
Depth Axis> 521kHz frequency*
Limit Edit> AF Trigger> 391kHz
Pass/Fail Test Squelch Level
on ff ~130.0dBm 313kHz
Return Return
Ref. Value Ref. Value Free Run Edge Slope
0.0ns 0.0% Rising Falling
Ref. Pos Ref. Pos " Trigger Mode
5 5 Trigger Setup> Norm. Sgl. Cont.
Scale/Div Scale/Div Start Time Trigger Level
10.00ms 10 % 0.00 ns 10 %
Auto Scale Stop Time Trigger Delay
on Auto Scale 20.0 ms 0ms
Action Now
Return Return Return Return

* see page 133 for the selectable LPF filter bandwidths.
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From: Measure>Demod>FM
Analysis
FM Analysis IF Bandwidth
on o 300kHz Bypass
LPF>
Setup> Bypass 16kHz
Min/Max Reset Time Axis> 7.8kHz
I . Decimation
—t Deviation Axis> 5.2kHz frequency*
Limit Edit> AF Trigger> 3.9kHz
Pass/Fail Test
on r 3.1kHz
Return Return
Ref. Value Ref. Value Edge Slope
0.0ns 9 30Hz Free Run Rising Falling
Ref. Pos Ref. Pos " Trigger Mode
5 5 Trigger Setup> Norm. Sgl. Cont.
Scale/Div Scale/Div Start Time Trigger Level
10.00ms 10 Hz 0.00 ns 10 Hz
Auto Scale Stop Time Trigger Delay
on Auto Scale 20.0 ns 0 ms
Action Now
Return Return Return Return

* see page 139 for the selectable LPF filter bandwidths.
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From: Measure>Demod>ASK

l

ASK Analysis : : Ref. Value Ref. Value
on ot Time Axis> |—) 0 0.0%
Bit Rate : Ref.Pos Ref.Pos
100 bit/s Depth AXiS> | 0 5
IF Bandwidth Scale/Div Scale/Div
30kHz 2 20.0%
Axis> Auto Scale
Preamble/Sync>
More
12
Return Return Return Return

Preamble/Sync
On Off

Preamble Bits
16

Sync Bits
16

Sync Words
0

Return
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From: Measure>Demod>ASK>More 1/2

l

View> Decoding>
Waveform ) Symbol None None
Trigger> Waveform %encode Invert Miller
Meas Length Symbol Setup> m For}r_|nea; Manchester
Limit Edit> D_Manchester
gr?sleail T%s# Bi-Phase
Min/Max Reset
Return Return Return
RF Trigger Start Bits
Aq&?gs}: Free Run -30.00dBm 0
Trigger Ext. Edge Stop Bits
carr. 5002?_?; Condition> Pos Neg 0
RF
Carr. Power Trigger Mode Video Edge
0.00dBm Norm. Sgl.Cont] Off Pos Neg
Compare Valueq Trlggero%%lﬁg
Compare Numbe Action Now
1
Trigger Setup>
Return Return Return Return
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From: Measure>Demod>FSK

l

FSK Analysis : : Ref. Value Ref. Value
on (o Time Axis> |—) 0 0.0%
:[B(;E)T)?ti Deviation AXiS>f=— Ref'POS REf'Pog
IF Bandwidth Scale/Div Scale/Div
30kHz 2 20.0%
Axis> Auto Scale
Preamble/Sync>
More
12
Return Return Return Return

Preamble/Sync
On Off

Preamble Bits
16

Sync Bits
16

Sync Words
0

Return
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From: Measure>Demod>FSK>More 1/2

l

i Decatng
Trigger> Waveform I:()Dencode Ing Miller
Meas Lenlggg Symbol Setup> Bin Form:; Manchester
Limit Edit> D_Manchester
SSSS/Fa“ ng Bi-Phase
Min/Max Reset
Return Return Return
ﬁ/
Freq. Deyiaton Free Run o S0l e
T SoPeIg
RF
Carr. Power Trigger Mode] Video Edge
0.00dBm Norm.” Sgl.Cont| Off Pos Neg
Compare Valuey Triggero%%lﬁg
(Compare Numbe1 Action Now
Trigger Setup>
Return Return Return Return
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From: Measure>2FSK>Limit Edit

)

Freq. Deviation
200.000kHz

From: Measure>Demod>AM Analysis>Limit Edit

)

Carr.Offset
200.000kHz

AM Depth
100.0%

Carr.Offset
200.000kHz

High Limit
30.00dBm

Carr.Power
0.00dBm

Low Limit
-120.0 dBm

Return

Return

From: Measure>Demod>FM Analysis>Limit Edit

)

Freq. Deviation
200.000kHz

Carr.Offset
200.000kHz

Carr.Power
0.00dBm

Return

320



GYINSTEK APPENDIX
From: Measure>SEM
l
SEM Setup> 3GPP> Meas Type> Meas Type>
3GPP Total pwr Ref PSD Ref
on S%'\]flf 802.11b> {— Ref. Channel> | ) Ref. Channel>
on Def. Help 802.11g> Offset/Limit> Offset/Limit>
802.11n>
802.16>
User Define>
Return Return Return Return

From: Measure>SEM>3GPP>

REF. Channel

l

Chan Integ BW
3.84 MHz

Chan Span
3.96 MHz

RBW
10kHz
Auto Man

Total Pwr Ref
-74.3dBm
Auto Man

Return

From: Measure>SEM>3GPP>

Offset/Limit

l

Duplexing Mode
EDD TDD

FDD Setup>

TDD Setup>

Return
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From: Measure>SEM>3GPP>
Offset/Limit>FDD Setup

Transmission _ L
BS Mode | BS UE P>=43 None
Max Out Pwr> _ —Pe—
P>=43 39<=P<43 6<=P<=20
Additional Max
Out Pwr> 31<=P<39 P<6
None
Add. Limits
None ] P<31
Min Offset/Limit | _
Value>
Return
Offset Offset
123 45 ) 123 45 None | ~) Band XIlI
Abs Start
On Off 22 dBm Band I Band XIV
Start Freq Abs Stop
27 MHz -22dBm Band IV
Stop Freq
27MHz Band V
RBW Band X
More 1/2 (= Band XII
Return
Return 212 More 1/2 =
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Offset/Limit>FDD Setup

Transmission
UE Mode | BS ve| None | =) Band XIII
Band Il Band XIV
Band IV
Add. Limits
None [ Band V
Min Offset/Limit
Value> - Band X
Band XII
Return More 1/2 {—
Offset 9 Offset
1 2 3 45 1 2 3 45
Abs Start
-22 dBm
Start Freq Abs Stop
27 MHz -22dBm
Stop Freq Rel Start
27MHz -35dBc
Rel Stop
RBW -50dBc
More | |
1/2
Return Return
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From: Measure>SEM>3GPP>

Offset/Limit>TDD Setup Chip Rate = 3.84/7.68M
Transmission Offset Offset _
Mo%ﬁ BS UE 1 2345|123 45 P>=43
Chip Rate
3.84M  1.28M on off AbS Start 39<=p<43
7.68M
Max Out Pwr> Start Freq Abs Stop —
P>=43 2.7MHz -22dBm 31<=P<39
Min Offset/Limit Stop Freq
Value> 2.7MHz P<3l
RBW
3MHz
More
12 =
Return Return Return

From: Measure>SEM>3GPP>
Chip Rate = 1.28M Offset/Limit>TDD Setup

_ Transmission Offset Offset
p>=34 B VE| e PlL 2345|123 45
Chip Rate
26<=P<34 3.84M 1.28M On Off
7.68M
Start Freq
P<26 2.7MHz
Min Offset/Limit | Stop Freq Rel Start
Value> 2.7MHz -22dBm
RBW Rel Stop
3MHz -22dBm
More | |
1/2
Return Return Return
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. From: From:
oz iingn U Messesew esmre e
) .11g>Offse .11n>Offse
802.16>Ref. Channel Limit Limit
Chan Integ BW Modulation> ERP-OFDM/ CH BW
3.84MHz DSSS-OFDM DSSS-OFDM 20M 40M
Chan Span Min Offset/Limit Esggggg Min Offset/Limit
3.96MHz Value> ERP-CCK Value>
RBW
10kHz
PSD Ref
-74.3dBm/Hz
Return Return Return
From: From: From: Measure>SEM>
Measure>SEM> Measure>SEM> 802.11n/802.16>0ffset/Limit>
802.16>0ffset/Limit 802.11b>Offset/Limit  Min Offset/Limit
Channelization Offset Offset
ioM 20M 1 2 1 2 3 4
Min Offset/Limit Start Freq Start Freq
Value> 2.7MHz 2.7MHz
Stop Freq Stop Freq
2.7MHz 2.7MHz
RBW RBW
3MHz 3MHz
Rel Start Rel Start
-22dBc -22dBc
Rel Stop Rel Stop
-22dBc -22dBc
Return Return Return
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From: Measure>SEM>802.11g>
Offset/Limit>Min Offset/Limit

802.11g modulation=DSSS

Offset Offset
1 2 % 1 2
On Off
Start Freq
2.7TMHz
Stop Freq Rel Start
2.7MHz -22dBc
Rel Start
RBW -22dBc
More [ |
1/2
Return Return
From: Measure>SEM>802.11g>
Offset/Limit>Min Offset/Limit
802.11g modulation=OFDM
Offset Offset
1 2 3 4| 1 32
Oon Off
Start Freq
2.7MHz
Stop Freq Rel Start
2.7TMHz -22dBc
Rel Start
RBW -22dBc
More [ |
1/2
Return Return
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From: Measure>SEM>

User Define>

Meas Type> Chan Integ BW
Total Pwr Ref Total Pwr Ref 3.84MHz
Chan Span
Ref. Channel> PSD Ref 3.96MHz
RBW
Offset/Limit> 10kHz
Auto Man
Total Pwr Ref
-74.3dBm
Auto Man
Return Return
Offset Offset
123 4 5 123 45 Absolute
on off AbS Start Relative
Start Freq Abs Stop
2.7MHz -22dBm Abs AND Rel
Stop Freq Rel Start
2.7MHz 222dBc Abs OR Rel
RBW Rel Stop
10kHz -22dBc
Auto Man Couple Man
More Fail Mask> | |
1/2 Absolute
Return Return

APPENDIX
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From: Measure>More From: Measure>
From: Measure>TOl >Harmonic More>NdB Bandwidth

TOI Harmonic NdB BW

on off on off On off

Reference Fundamgntal NdB

req. 3.000dB
Lower  Upper 1.000000MHz
Limit Number of Order
0.00dBm 5
f RBW
OPnass/Fall T(e)sf% 10kHz
= Auto Man

Return Return Return

From: Measure>More>P1dB

l

P1dB Center Freq Exec. Norm
On Off % 100.000MHz % 0dB
P1dB [ | Gain Offset Location
Setup > 0.000dB Prev Post
: Average Nomr.
Normalize > {— 1 ON OFF
Start
-30.00dB
Reset
Return Return Return
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EMC Pretest
Select
EMC Band> J : L
On Off User Define 9 None Correctlon; 9k-150kHz
Amb. Noise c i
EMI Test> Reject Horizontal o orrection 150k-30MHz
: n
None High
‘ Correction
Field Sensor> None (= Vertical Edit> 30M-300MHz
On Off
Source Contact Recal[l\llti)rniei | Other 300M-1GHz
Probe > on Off factor
AC Voltage Peak Table Save
Probe > On Off Correction 30M-1GHz
Scale Type Delete R
EMS Test> Log Lin Correction 1GHz-3GHz
Return Return Return User Define>
EMI test : Band =
9k-150 kHz
or
150k-30MHz
User %1?%: None None Average None
Amb. Noise
Reject Cor.factor EN55022A Quasi-peak EN55022 A
None  High
Correction
None EN55022B Both EN55022B
On Off
Recall limit
None FCC A FCC A
On Off
Peak Table
on Off FCCB FCC B
Scale Type
Log Lin
Return Return Return Return Return
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EMC Band>
On Off User Define None None
Correction
EMI Test> None 3m 30M-300MHz EN55022A
On Off
Recall limit
Field Sensor> None 10m 300M-1GHz EN55022B
On Off
Source Contact Other
Probe> factor 30M-1GHz FCCA
AC Voltage Peak Table )
Probe> on off User Define> FCCB
EMS Test>
Return Return Return Return
EMC
on oft | [ 150k-30MHz None Average
EMI Test> EN55022A Quasi-peak
Field Sensor> Pretest EN55022B Both
S Contact
ouree Debug FCCA
Recall limit
AC \é,?gggi — None FCCB
On Off
EMS Test>
Return Return Return
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EMC Band>
Oon Off User Define
EMI Test> PCB tracePin> 30M-300MHz
Field Sensor> 1/0 Cable Pin> 300M-1GHz
Source Contact )
Probe> User Define>
AC Voltage
Probe>
EMS Test>
Return Return
PCB 1/0
Correction
None None None e None
On Off
Recall limit
None 20cm trace 2m trace EN55022B
On Off
15cm trace 1.5m trace FCCB
10cm trace 1m trace
on Peak Tag_fe} 6¢cm trace 0.5m trace
4cm trace
Return Return Return Return
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EMC EMS Source
On Off On Off
EMI Test> Source Strength

3Vim  1V/m

Field Sensor>

80MHz-300MHz

SRC Freq Start
150.000kHz

SRC Freq Stop
30.000000MHz
None Man

Run Stop

Run Stop
Source Contact 300MHz-1GHz
Probe> Run Stop
AC Voltage 80MHz-1GHz
Probe> Run Stop

EMS Test> User Define > |—

Return
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GSP-9330 Specifications

The specifications apply when the GSP is powered on for 45
minutes* to warm-up to a temperature of 20°C to 30°C, unless

specified otherwise.

* 45 minutes typical, 90 minutes maximum.

Frequency
Frequency
Range 9 kHz to 3.25 GHz
Resolution 1 Hz
Frequency Reference
Accuracy +(period since last adjustment X aging rate) +
stability over temperature + supply voltage
stability
Aging Rate 1 ppm max. 1 year after last
adjustment
Frequency +0.025 ppm 0to 50 °C
Stability over
Temperature
Supply Voltage ~ +0.02 ppm
Stability
Frequency Readout Accuracy
Start, Stop, +(marker frequency indication X frequency

Center, Marker

reference accuracy + 10% x RBW + frequency
resolution’)

Trace points

Max 601 points, min 6 points

Marker Frequency Counter

Resolution 1 Hz, 10 Hz, 100 Hz, 1 kHz

Accuracy +(marker frequency RBW/Span >=0.02 ;
indication X frequency Mkr level to DNL>30
reference accuracy + dB
counter resolution)

Frequency Span

Range 0 Hz (zero span), 100 Hz
to 3.25 GHz

Resolution 1 Hz

Accuracy + frequency resolution' ~ RBW: Auto;
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Phase Noise

Offset from Fc =1 GHz; RBW =1

Carrier kHz, VBW =10 Hz;
Average > 40

10 kHz <-88 dBc/Hz Typical

100 kHz <-95 dBc/Hz Typical

1 MHz <-113 dBc/Hz Typical

Resolution Bandwidth (RBW) Filter

Filter Bandwidth

1 Hzto1 MHzin 1-3-10
sequence

-3dB bandwidth

200 Hz, 9 kHz, 120 kHz,
TMHz

-6dB bandwidth

Accuracy

+ 8%, RBW = 1MHz

Nominal?

+ 5%, RBW < TMHz

Nominal

Shape Factor

Video Bandwidth (VBW) Filter

<4.5:1

Nominal ; Normal
Bandwidth ratio: -
60dB:-3dB

Filter Bandwidth

1Hzto1 MHzin 1-3-10
sequence

-3dB bandwidth

[1] Frequency Resolution = Span/(Trace points - 1)
[2] Typical specifications in this datasheet mean that the performance can be
exhibited in 80% of the units with a 95% confidence level over the temperature
range 20 to 30 °C. They are not covered by the product warranty.

[3] Nominal values indicate expected performance. They are not covered by the

product warra

nty.

Amplitude
Amplitude Range
Measurement 100 kHz to 1 MHz Displayed Average
Range Noise Level (DANL)
to 18 dBm
1 MHz to 10 MHz DANL to 21 dBm
10 MHz to 3.25 GHz DANL to 30 dBm
Attenuator

Input Attenuator

Range

Maximum Safe Input Level

0to 50 dB, in 1 dB step

Auto or manual
setup

334

Average Total <+33dBm Input attenuator
Power >10dB
DC Voltage £50V
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1 dB Gain Compression

Total Power at 1st >0 dBm

TypicakFc >50 MHz;

Mixer preamp. off
Total Power at the >-22 dBm TypicakFc >50 MHz;
Preamp preamp. on

mixer power level (dBm)=input power (dBm)-
attenuation (dB)

Displayed Average Noise Level (DANL)*

Preamp off

0 dB attenuation; RF Input is terminated with a
50Q load. RBW 10 Hz; VBW 10 Hz; span 500 Hz;
reference level = -60dBm,; trace average > 40

9 kHz to 100 kHz

<-93 dBm

100 kHz to 1 <-90 dBm - 3 x (f/100

MHz kHz) dB

1 MHz to 2.7 <-122 dBm Nominal

GHz

2.7GHzt03.25 <-116dBm

GHz

Preamp on 0 dB attenuation; RF Input is terminated with a
50Q load ; RBW 10 Hz; VBW 10Hz; span 500 Hz;
reference level = -60dBm; trace average > 40

100 kHz to 1 <-108 dBm - 3 x (f/100

MHz kHz) dB

1 MHz to 10 MHz <-142 dBm Nominal

10 MHz t03.25 <-142dBm + 3 x (f/1

GHz GHz) dB

[4] DANL spec excludes spurious response.
Level Display Range

Scales Log, Linear

Units dBm, dBmV, dBuV, V, W

Marker Level 0.01dB Log scale

Readout
0.01 % of reference level  Linear scale

Level Display Trace, Topographic, Single / split

Modes Spectrogram Windows

Number of Traces 4

Detector

Positive-peak, negative-
peak, sample, normal,
RMS(not Video), Quasi-
Peak, Average

Can be setup for each
trace separately

Trace Functions

Clear & Write, Max/Min
Hold, View, Blank, Average
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Absolute Amplitude Accuracy

Absolute Point

Center=160 MHz ; RBW 10 kHz; VBW 1 kHz;
span 100 kHz; log scale; 1 dB/div; peak
detector; 23°C+1°C; Signal at Reference Level

Preamp off +0.3dB Ref level 0 dBm;
10 dB RF attenuation
Preamp on +0.4 dB Ref level -30 dBm;

Frequency Response

0 dB RF attenuation

Preamp off

Attenuation: 10 dB; Reference: 160 MHz; 20 to
30°C

100 kHz to 2.0 +0.5dB

GHz

2GHz to 3.25 +0.7dB

GHz

Preamp on Attenuation: 0 dB; Reference: 160 MHz; 20 to

30°C

1 MHzto2GHz +0.6dB

2 GHzt0 3.25 +0.8 dB

GHz

Attenuation Switching Uncertainty

RBW Filter Switching Uncertainty

Attenuator setting 0 to 50 dB in 1 dB step

Uncertainty

+0.25 dB reference: 160 MHz,
10dB attenuation

Level Measurement Uncertainty

1 Hzto1 MHz

+0.25dB reference : 10 kHz
RBW

336

Overall Amplitude + 1.5 dB 20 to 30°C; frequency > 1 MHz;

Accuracy

Signal input 0 to -50 dBm;
Reference level 0to -50 dBm;
Input attenuation 10 dB;

RBW 1 kHz; VBW 1 kHz; after cal;
Preamp Off

+0.5dB Typical
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Spurious Response

Second Harmonic Preamp off; signal input -30dBm; 0
Intercept dB attenuation

+35dBm  Typical 10 MHz < fc < 775 MHz

+60 dBm  Typical 775 MHz < fc < 1.625 GHz

Third-order Preamp off; signal input -30dBm; 0
Intercept dB attenuation

>1dBm 300 MHz to 3.25 GHz

Input Related <-60dBc Inputsignal level -30 dBm, Att.

Spurious Mode, Att=0dB; 20-30°C
Residual <-90 dBm  Input terminated; 0 dB attenuation;
Response Preamp off
(inherent)
Sweep
Sweep Time
Range 310 us to 1000 s Span >0 Hz
50 us to 1000 s Span =0 Hz; Min
Resolution = 10 us
Sweep Mode Continuous; Single
Trigger Source Free run; Video; External
Trigger Slope Positive or negative edge

RF Preamplifier

Frequency Range 1 MHzto 3.25 GHz

Gain 18 dB Nominal

(installed as
standard)

Front Panel Input/Output

RF Input
Connector Type  N-type female
Impedance 50 ohm Nominal
VSWR <1.6:1 300 kHz to 3.25 GHz; Input

attenuator > 10 dB
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Connector Type

SMB male

Voltage/Current

DC +7V [/ 500 mA max

protection
USB Host
Connector Type A plug
Protocol Version 2.0 Supports
Full/High/Low speed
MicroSD Socket
Protocol SD 1.1

Supported Cards

Rear Panel Input/Output

microSD, microSDHC

Reference Output

Connector Type  BNC female
Output Frequency 10 MHz Nominal
Output 3.3V CMOS
Amplitude
Output 50 ohm
Impedance
Reference Input
Connector Type  BNC female
Input Reference 10 MHz
Frequency

Input Amplitude

-5 dBm to +10 dBm

Frequency Lock

Within + 5 ppm of the

Range input reference frequency
Alarm Output
Connector Type  BNC female Open-collector
Trigger Input/ Gated Sweep Input
Connector Type  BNC female
Input Amplitude 3.3V CMOS
Switch Auto selection by function
LAN TCP/IP Interface
Connector Type  RJ-45
Base 10Base-T; 100Base-Tx; Auto-MDIX
USB Device
Connector Type B plug For remote control only;
supports USB TMC
Protocol Version 2.0 Supports Full/High/Low

338
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With short-circuit

Up to 32GB capacity
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IF Output

Connector Type  SMA female

Impedance 50 ohm Nominal

IF Frequency 886 MHz Nominal

Output level -25 dBm 10 dB attenuation; RF

Earphone Output

input: 0 dBm @ 1 GHz

Connector Type
Video Output

3.5mm stereo jack, wired for mono operation

Connector Type

RS232 Interface

DVI-I (integrated analog and digital) , Single
Link. Compatible with VGA or HDMI standard
through adapter

Connector Type
GPIB Interface (Optional)

D-sub 9-pin female Tx,Rx,RTS,CTS

Connector Type
AC Power Input

IEEE-488 bus connector

Power Source

Battery Pack (Optional)

AC 100V to 240V, 50/ 60 Hz
Auto range selection

Battery pack 6 cells, Li-lon With UN38.3
rechargeable, 352P Certification
Voltage DC10.8V
Capacity 5200 mAh / 56Wh
General

Internal Data 16 MB nominal

storage

Power <82 W

Consumption

Warm-up Time

< 45 minutes

Temperature Range +5 °Cto +45 °C Operating
-20°Cto +70°C Storage
Weight 4.5 kg (9.9 Ib) Inc. all options

(Basic+TG+GPIB+Battery)

Dimensions

210x350x 100 (mm) Approximately

8.3 x 13.8x3.9 (in)
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Tracking Generator® (Optional)

Frequency Range 100 kHz to 3.25 GHz

Output Power -50 dBm to 0 dBm in 0.5 dB steps

Absolute Accuracy +0.5dB @160 MHz, -10 dBm,
Source attenuation 10 dB,
20 to 30°C

Output Flatness Referenced to 160 MHz, -10 dBm

100 kHz to 2 GHz +1.5dB

2GHzto3.25GHz +2dB

Output Level +0.8dB Referenced to -10 dBm

Switching

Uncertainty

Harmonics <-30dBc Typical, output level =-10
dBm

Reverse Power +30 dBm max.

Connector type N-type female

Impedance 50 ohm Nominal

Output VSWR < 1.6:1 300 kHz to 3.25 GHz,
source attenuation > 12
dB

[5] The minimum RBW filter is 10kHz when the TG output is ON.
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Declaration of Conformity

We

GOOD WILL INSTRUMENT CO., LTD.
No. 7-1, Jhongsing Rd, Tucheng Dist., New Taipei City 236, Taiwan

GOOD WILL INSTRUMENT (SUZHOU) CO., LTD.

No. 69 Lushan Road, Suzhou New District Jiangsu, China.

declare that the below mentioned product

Type of Product: Spectrum Analyzer

Model Number: GSP-9330

is herewith confirmed to comply with the requirements set out in the
Council Directive on the Approximation of the Laws of the Member States
relating to the Low Voltage Directive (2006/95/EC) and Electromagnetic
Compatibility (2004/108/EC).

For the evaluation regarding the Electromagnetic Compatibility and Low
Voltage Directive, the following standards were applied:

© EMC

EN 61326-1 : Electrical equipment for measurement, control and
EN 61326-2-1: laboratory use —- EMC requirements (2006)
EN 61326-2-2:

Conducted and Radiated Emissions Electrostatic Discharge

EN 55011: 2009+A1: 2010 EN 61000-4-2: 2009
Current Harmonic Radiated Immunity

EN 61000-3-2: 2006+ A1: 2009+ A2: 2009 EN 61000-4-3: 2006+A1: 2008+A2 :2010
Voltage Fluctuation Electrical Fast Transients

EN 61000-3-3: 2008 EN 61000-4-4: 2012

Surge Immunity
EN 61000-4-5: 2006

Conducted Susceptibility
EN 61000-4-6: 2009

Power Frequency Magnetic Field
EN 61000-4-8: 2010

Voltage Dips/ Interrupts
EN 61000-4-11: 2004

Low Voltage Equipment Directive 2006/95/EC

Safety Requirements EN 61010-1: 2010 (Third Edition)
EN 61010-2-030: 2010 (First Edition)
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